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1 The Kaleido System 

The Miranda Kaleido Multi-Image Display System combines multiple inputs (audio, video and 
data) into a single signal that can be displayed on a large screen, high-resolution monitor, 
replicating the functionality of a traditional monitor wall. Unlike the traditional monitor wall, 
however, the Kaleido output can be reconfigured and restructured with infinite flexibility. Software 
within the Kaleido unit itself, and supporting software (Kaleido Layout Editor) in a remote 
computer, communicating through a TCP/IP interface, provides this Kaleido versatility. 

1.1 Kaleido Hardware 

There are currently three members in the Kaleido family: 

Kaleido K2  Kaleido-K2 is Miranda’s most sophisticated and comprehensive 
multi-image display system. 

It is a 4RU system and can have up to 32 video inputs (SD-SDI, 
HD-SDI, VGA, Composite, Y/C and Component), 48 audio inputs 
(Analog and AES/EBU), 66 GPI Inputs and 36 GPI Outputs. 

Kaleido Alto & Quad Kaleido-Alto and Kaleido-Quad are the newest members of the 
Kaleido family. 

They are 1RU systems with 10 (Alto) or 4 (Quad) video inputs 
(HD-SDI, SD-SDI or Composite), 10 (Alto) or 4 (Quad) audio 
inputs (Analog or AES/EBU), 20 GPI Inputs and 10 GPI Outputs. 

Kaleido and Kaleido Classic, Miranda’s first and second-generation systems, are not supported in 
this version of software, due to hardware limitations. 

1.2 Kaleido Software  

There are two software components associated with the Kaleido system: 

• Kaleido  software is installed in the Kaleido unit, and performs the analysis of all the incoming 
signals and displays a comprehensive representation of the monitor wall. 

• Kaleido Layout Editor (KEdit)  software runs on a remote computer connected to the 
Kaleido through the Ethernet. It creates the on-screen layout formats used by the Kaleido and 
is used to configure the Kaleido system. It can function in on-line or off-line modes. While on-
line, it can manipulate the monitor wall display in real time. While off-line, it can create layouts 
for future use. KEdit shows a schematic representation of the monitor wall display on its 
screen.  

1.2.1 KEdit feature exclusions for Kaleido Alto & Q uad 

Kaleido Alto and Kaleido Quad do not support all the features available in the KEdit software 
package. A summary of these limitations is available here. 



1.3 Installation and Connection 

Please see the Installation Guide for detailed instructions on installing the Kaleido software and 
setting up the necessary network connections for its operation. 



2 Kaleido System Concepts 

Kaleido replaces the traditional physical display devices in a monitor wall, such as video monitors, 
audio meters and tally lamps, with graphical representations. Understanding the Kaleido will be 
simpler if a number of key concepts are explained. 

2.1 Component 

A COMPONENT is a graphical element appearing on the Kaleido display. Components include 
video screens, audio meters, tallies, under monitor displays (UMDs), streaming viewers, clocks, 
etc. 

2.2 Monitor 

A MONITOR is a group of components. A monitor includes a single video component, and may 
contain many other components of different types.  

The Monitor is analogous to the common home TV set: it has a screen, speakers, possibly the 
option to display the closed captioning (CC), and some on-screen text to identify the current 
channel. 

 

2.3 Layout 

A LAYOUT is an arrangement of monitors and components on the Kaleido display. Layouts can be 
saved and recalled. 

2.4 Channel 

A CHANNEL is a group of elements, each described by its type (e.g. video, audio, text, tally, etc.) 
and by a description of where it can be found on the Kaleido’s input ports. A Channel can only 
include a single video source, but it may include multiple instances of other source type. For 
instance, it may have four audio sources, two tally sources, three status monitors, etc.  

Continuing with the TV set example, a Kaleido Channel is conceptually the same as the 
broadcast or cable channel (which includes video, audio, closed captioning text, program 



information, etc) captured by the TV set. Assigning a channel to a Kaleido monitor is equivalent to 
switching a TV set to a numbered channel. 

 

2.5 Link Order 

To distinguish between multiple instances of the same data type, each element in a channel and 
each component of a monitor is assigned a LINK ORDER. If there are, for example, three audio 
signals in a channel, they will each have a different link order, usually 1, 2 and 3. If the monitor 
has three audio meters, they will each have a different link order, also usually 1, 2 and 3. When 
this channel is assigned to this monitor, each display element shows the source in the channel 
with the matching type and link order. In this case, the audio source with link order 1 will be 
assigned to the audio meter with link order 1, etc. If there are more sources than meters, then the 
extra sources will not be shown. If there are more meters than sources, then the extra meters will 
be inactive 

 



2.6 Alarm Monitors 

ALARMS are used to report the status of a source in the Kaleido system. 

Kaleido can detect certain critical events such as the loss of signal at an input, incorrect levels, 
pulses at a GPI input, etc. An alarm can be defined to monitor a signal for specific critical events, 
and to trigger a response if errors are detected. An ALARM MONITOR combines multiple alarms, 
and allows the user to program more specific responses to the presence of errors through the use 
of Actions. 

An Alarm can identify and respond to four different states, whose typical meaning is: 

• Disabled:  the status of the signal cannot be determined. 

• Normal:  there is currently no problem with the signal. 

• Warning  there is currently no critical problem with the signal. 

• Error:  there is currently a problem with the signal. 

An Alarm Monitor reports highest-priority error flagged by its individual alarms. This means that 
as soon as one alarm reports a status other than Normal, the Alarm Monitor will reflect it. Here is 
the status list in order of precedence: 

• Error 

• Warning 

• Disabled 

• Normal 

2.7 Triggers and Actions 

A TRIGGER is defined as something that starts an operation. In Kaleido the Trigger will start an 
Action. A Trigger can be a mouse click, a timer end-of-count, an Alarm Monitor status change, etc 

An ACTION is defined as a sequence of one or more tasks. A task refers to something to execute, 
such as the loading of a layout, the starting of a count down timer, etc. Triggering the Action 
results in the execution of the series of tasks in the predetermined order. 

2.8 Quality Control Monitor 

A QUALITY CONTROL MONITOR is a Monitor configured to receive any available video source while it 
is still displayed in its assigned Monitor. The typical use of the Quality Control Monitor is to have a 
bigger view of a specified source. Quick and easy selection of the source using simple mouse 
clicks on the Kaleido screen is an important aspect of the functionality of a Quality Control 
Monitor. 



3 On-Screen Components in Kaleido 

3.1 Introduction to Components 

A COMPONENT is a graphical element appearing on the Kaleido display. Components include 
video screens, audio meters, tallies, under monitor displays (UMDs), streaming viewers, clocks, 
etc. Each component is the on-screen manifestation of a data stream. Each Component must be 
defined from several points of view: 

Input  – the source of the data must be identified. Sources are defined in terms of physical inputs 
on the Kaleido chassis. However, a more flexible definition of the input, and control of the source, 
is provided through the use of Router control, whereby the data appearing at the designated 
Kaleido input may be sourced from a router whose cross points are controlled through the 
Kaleido. Certain types of data, e.g. closed caption text, UMD text, MPEG data stream analysis 
data, etc. may be sourced from third-party devices that are connected to Kaleido through its 
Ethernet port. In these cases, the IP address of the data source is required. 

Appearance  – the appearance of the component within the Kaleido display can be configured. 
Controllable features may include size, color, audio meter scales, presentation of alarm 
information (e.g. color, flashing or steady, etc.), transparency, etc. 

Response  – some components may be controlled by mouse actions on the Kaleido output 
screen. The relationship between stimulus and response must be defined. 

KEdit provides the tools to create and configure Components. 

The following sections provide complete details on creating and configuring each of the 
component types available in Kaleido. 

3.2 Monitor 

3.2.1 Creation:  

Use the Monitor Browser to add a Monitor to the current Layout.  

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard. 

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the monitor onto the layout. 



3.2.2 Configuration: 

The attributes of a Monitor are adjustable using the Configuration Panel in KEdit. To access the 
panel for a Monitor: 

1. Click on the Monitor to select it. Its boundary will appear in white, and control points will 
appear at the corners and the center of each side, showing it is selected. 

NOTE: at this point the Monitor may be positioned (click and drag) and scaled (click and drag 
a control point) within the Layout. 

2. Open the Configuration Panel for the Monitor by pushing F5, or from the Configuration Panel 
item in the View menu, or by right-clicking on the Monitor and selecting “Configuration Panel” 
in the contextual menu. 

The Configuration Panel’s appearance and functionality is the same in both online and offline 
operating modes – only the contents of the Channel pull-down box change, as noted below. 



Assignment Tab  

Assign Channel 

The current Channel assignment is shown. 

To change the assignment, select a Channel from 
the pulldown list, which shows all channels available, 
and then click Apply at the bottom of the panel: 

Offline – shows the Channels available on the 
computer running KEdit 

Online – shows the Channels available on the 
Kaleido-K2. 

(Type/Link Order/Assignment) 

A listing of all the signals contained in the channel 
identified in the Assign Channel text box. You cannot 
change these here. They are set at the individual 
component configuration panels. 

Save Channel 

Click the Save As... button to save a copy of the 
current assignment as a new Channel. You will be 
prompted to enter a name for the new Channel. 

Size/Position tab 

This tab shows: 

• the size (Horizontal, Vertical and Diagonal) of 
this monitor 

• the position in the layout (Horizontal and Vertical) 
of the top left corner of this monitor. 

The data boxes allow new size and position 
information to be entered, allowing monitors to be 
very precisely scaled and positioned in the layout. 
Click in a box and type new data – the other boxes 
are recalculated immediately. 

The values can be expressed in a variety of units: 

• Cm 

• Inches 

• Pixels 

• % (of the layout size)  

selectable from the pulldown list beside the data box. 
Note that the units available are a result of selections 

 

 



made in the New Layout Format panel when the 
layout was created, or in changes made to those 
selections in the Layout Properties Panel, accessible 
from File – Layout Properties. 

The size of the Monitor in the layout will not change 
until the Apply button is clicked.  

Hint:  to change a Monitor’s size while retaining its 
aspect ratio, change the diagonal measurement. The 
Horizontal and Vertical dimensions will retain their 
proportions as their size changes. 

 

 

 

 

 

 

 

 

 

3.2.3 Locking and Unlocking a Monitor 

The contents of a Monitor (i.e. the number, position and configuration of the components inside it) 
can only be accessed when the Monitor is UNLOCKED. 

• To UNLOCK a Monitor, use one of these methods: 

• right-click on it and select Unlock Monitor from the contextual menu. 

• ALT-click on the Monitor (this also selects the component within the Monitor which was 
clicked) 

• An UNLOCKED Monitor is identified by a YELLOW BORDER and YELLOW RESIZING 
HANDLES (disabled) in its corners. 



When the contents of the Monitor have been configured, LOCK the monitor: 

• To LOCK a Monitor, you can either: 

• Right-click on any component inside the Monitor, and select Lock Monitor from the 
contextual menu, or 

• Click in the layout outside the Monitor 

• A LOCKED Monitor is identified by a WHITE border 

If you change the assignment of signals to components while editing the contents of an unlocked 
monitor, the definition of the channel assigned to the Monitor will be changed. When you lock the 
Monitor, you will either: 

• Automatically save the changes and redefine the Channel to match the new assignments, or 

• Be prompted to either save the changes and redefine the channel, or save the changed 
assignments as a new channel, using this dialog: 

 

You determine which of these options will occur using the System Preferences  dialog accessed 
from the File-Preferences menu. Note that if you check the “Automatically save the channel 
without prompting” box, then any future changes to this channel will be saved without a prompt, 
but changing other channels will still invoke the “save changes” dialog. Checking the box does 
not override the choice you made in the Preferences dialog. 

3.2.4 Operation 

3.2.4.1 Assign Channel 

This operation will assign a Channel to a Monitor. Note that if the Channel to assign is already 
used in the layout, then the Monitor that is currently assigned to the Channel will be unassigned, 
and its video will be shown in the new Monitor. 

Using the Mouse 

Right-click on the Monitor’s Video screen on the Kaleido display. Choose Assign Channel, and 
select the desired Channel from the list of all available Channels by clicking on it. 

Using Kaleido-RCP 

Push the Select button on the Kaleido-RCP. Each Monitor in the Layout will show an ID number, 
and its current Channel assignment (either a Channel name or “No Channel”). A yellow box 
surrounds the ID of the Monitor currently being pointed to. Use the arrow keys to move the 
pointer box to the Monitor of interest. Then push Input. The pointer box turns red and a scrollable 



window opens on-screen listing all the defined Channels stored in Kaleido. Scroll up or down to 
find the desired Channel, then push Enter to assign the channel to that monitor 

Alternatively, press INPUT, select the Channel you want, and press Enter. Then, navigate 
through the Monitors using the arrow keys and press enter to assign that Channel to the selected 
Monitor. 

When finished, press Esc to remove the Monitor IDs and Channel names from the screen. 

Using a Keyboard 

Push the Tab key on the keyboard. Each Monitor in the Layout will show an ID number, and its 
current Channel assignment (either a Channel name or “No Channel”). A yellow box surrounds 
the ID of the Monitor currently being pointed to. Use the arrow keys to move the pointer box to the 
Monitor of interest. Then push A. The pointer box turns red and a scrollable window opens on-
screen listing all the defined Channels stored in Kaleido. Scroll up or down to find the desired 
Channel, then push Enter to assign the Channel to that Monitor 

Alternatively, press A, select the Channel you want, and press Enter. Then, navigate through the 
Monitors using the arrow keys and press enter to assign that Channel to the selected Monitor. 

When finished, press Esc to remove the Monitor IDs and Channel names from the screen. 

3.2.4.2 Full Screen mode 

Using the Mouse 

You can display a Monitor in Full Screen mode using the mouse only if the Monitor’s Video 
Screen has been configured with Full Screen as one of its Actions (by default Full Screen Action 
is configured on double-click). In that case, proceed as follows:  

• Left-single-click or left-double-click (whichever was configured for the Full Screen Action) on 
the Monitor’s Video Screen in the Kaleido display. 

You can return from Full Screen mode to the previous Layout using the mouse only if you have 
programmed the Video Screen in the Full Screen Layout with Previous Layout as one of its 
Actions. In that case, proceed as follows: 

• Left-single-click or left-double-click (whichever was configured for the Previous Layout Action) 
on the Video Screen in the Kaleido Full Screen display. 

Using Kaleido-RCP 

Push the Select button on the Kaleido-RCP. Each Monitor in the Layout will show an ID number, 
and its current Channel assignment (either a Channel name or “No Channel”). A yellow box 
surrounds the ID of the Monitor currently being pointed to, which is the current selection.  

• Use the arrow keys to move the pointer box and change the current selection. 

• Push the Full Screen button; the current selection will appear in Full Screen mode 

• Push the Full Screen button again to exit Full Screen mode and return to Normal Mode 



Using a Keyboard 

Push the Tab button on the keyboard. Each Monitor in the Layout will show an ID number, and its 
current Channel assignment (either a Channel name or “No Channel”). A yellow box surrounds 
the ID of the Monitor currently being pointed to, which is the current selection.  

• Use the arrow keys to move the pointer box and change the current selection. 

• Push the F key; the current selection will appear in Full Screen mode 

• Push the F key again to exit Full Screen mode and return to Normal Mode 

3.2.4.3 Quality control mode 

Use the mouse to enter or leave the Quality Control mode by double-clicking on Video Screens 
which have been configured for Quality Control (QC) functionality. These Video Screens are 
identified by the presence of markers in the four corners of the screen (┌, ┐, └ and ┘), which are 
gray for a non-selected QC Monitor, and white for a selected QC monitor. 

Double-click on…  Result 

• Non-Selected QC Monitor: The double-clicked QC Monitor is selected. 

Any previously-selected QC Monitor is deselected  

• Selected QC Monitor: The double-clicked QC Monitor is deselected. 

Normal operation mode is restored. 

Once a Monitor configured for Quality Control has been selected by a double click, then single-
clicking on any other Monitor in the Layout that has been configured in the Router Reference 
Table will send its video to the Quality Control Monitor. 

Note that:  

• The normal single-click action function of these other Monitors has been pre-empted. The 
double-click action function remains available. 

• A non-selected Quality Control Monitor acts like any other Monitor. It displays the signal for 
which it was configured, and its signal can be routed to the selected Quality Control Monitor 
by a single click. 

3.2.4.4 Unlatch Error Status of Monitor 

Using the Mouse 

Right-click on the Video Screen of a Monitor in the Kaleido display using the mouse, and select 
Unlatch Monitor Status. The error detection of all components in that Monitor with error latching 
capability (Video Screens, UMDs, Text Labels and Status Indicators) will be unlatched. 



Using Kaleido-RCP 

Push the Select button on the Kaleido-RCP. Each Monitor in the Layout will show an ID number, 
and its current Channel assignment (either a Channel name or “No Channel”). A yellow box 
surrounds the ID of the Monitor currently being pointed to, which is the current selection.  

• Use the arrow keys to move the pointer box and change the current selection. 

• Push the DEL button; the error detection of all components in that Monitor with error latching 
capability (Video Screens, UMDs, Text Labels and Status Indicators) will be unlatched. 

Using a Keyboard 

Push the Tab button on the keyboard. Each Monitor in the Layout will show an ID number, and its 
current Channel assignment (either a channel name or “No Channel”). A yellow box surrounds 
the ID of the Monitor currently being pointed to, which is the current selection.  

• Use the arrow keys to move the pointer box and change the current selection. 

• Push the Delete key; the error detection of all components in that Monitor with error latching 
capability (Video Screens, UMDs, Text Labels and Status Indicators) will be unlatched. 

3.3 Video Screen 

3.3.1 Creation: 

A Video Screen must be created as part of a Monitor. Use the Monitor Browser to add a Monitor 
to the current Layout. 

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard. 

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the layout. 

All Monitors contain one, and only one, Video Screen. You cannot add a second Video Screen, or 
delete the one included in the Monitor. 

3.3.2 Configuration: 

The attributes of a Video Screen are adjustable using the Configuration Panel in KEdit. To access 
the panel for a Video Screen: 

1. Select the Video Screen using one of these methods: 



• Unlock the Monitor in which the Video Screen is located, by right-clicking and selecting 
Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified by a 
YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then click on 
the video screen to select it  

• ALT-click on the video screen. The monitor will unlock, and the screen will be selected. 

NOTE: at this point the Video Screen may be positioned (click within the screen and drag) 
and scaled (click and drag a control point) within the Monitor. It will retain its aspect ratio 
when scaled, and cannot be moved outside the Monitor boundary. 

2. Open the Configuration Panel for the Video Screen by pushing F5, or from the Configuration 
Panel item in the View menu. 

The Configuration Panel’s appearance will vary depending on the KEdit operating mode. 

• Offline operation:  KEdit is operating in a stand-alone mode, and is configuring a layout 
located on its local computer. Some information about the video inputs is not available, and 
certain configuration controls are not active. These items are grayed out on the configuration 
panel in the offline mode. 

• Online operation:  KEdit is connected online to a Kaleido-K2, and is configuring the Kaleido-
K2’s current layout. All configuration controls are active.  

In the following section, all possible versions of the configuration panels are shown, and all 
parameter setting are discussed. 

3.3.2.1 Offline Panels:  

The offline Video Screen Configuration Panel has six tabs, each of which allows configuration of 
a specific class of parameters. Note that certain items in the Assignment tab are grayed out, as 
they can only be used while online. These items are not described in this section. 



Assignment Tab 

Assign Video Input: 

Input Number:  Enter the number of the Kaleido video 
input that is to appear on this video screen [enter a 
number between 1 and 32]. 

Input Format:  

Kaleido detects and reports the format of the selected 
input in online mode only. In offline mode, the Input 
Format box reports that no video is assigned 

Loss of Video:   

Select the check box to display black on this video 
screen when the Signal Loss alarm is detected for 
the video stream. Leave the checkbox unchecked to 
display the video stream as found. 

 



Border Tab 

Border Color:  

A border around the periphery of the Video Screen is 
used to show Alarms associated with this Video 
Screen component. For each of the four possible 
Alarm states, select the color and width of the border. 
For the Warning and Error states, border flashing can 
be turned on or off by clicking the box. 

• The Color Fill icon shows the color currently 
selected for the border. Click on the down-arrow 
beside the Color Fill icon to open a color 
selection window and choose a different color. 

• The border width pull-down shows the current 
width of the border for each error condition. Click 
on the pull-down to select a different value (range 
between 1 and 5) 

Assign Alarm Monitor:  

Select an Alarm Monitor to be assigned to this Video 
Screen component from the pull-down list of available 
Alarms. The status of the Alarm will be shown by the 
border. 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Video Screen 
when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

Error Latching:  

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status is indicated by the corners of the 
border, while the top, bottom and sides continue to 
show the current status. 

 



Video Window Frame:  

The appearance of the Video Screen at the Kaleido 
output can be enhanced by adding a frame which 
creates the appearance of depth. This frame does 
not appear in the KEdit rendition of the Layout. Select 
the format of the frame around the Video Screen: 

• None - no frame is shown. 

• Lowered Bevel - shows a frame with a beveled 
profile as a graphic effect at the Kaleido-K2 
output. 

Channel:  

The channel assignment for this Video Screen will be 
shown and the Alarm Link Order box will be active. 
The alarm link order can be changed by entering a 
new value in the box.  



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Video 
Screen is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is double-clicked using the mouse 
attached to the Kaleido-K2. 

Use this Monitor as target Quality Monitor: 

Ticking this box assigns this Monitor as a Quality 
Control Monitor at the Kaleido-K2 output. It will 
usually be a large Monitor that can be used on the 
Kaleido-K2 screen to quickly access a larger image 
of video from any other on-screen Monitor  

Note that when a Monitor is assigned for Quality 
Control, the use of the double click to trigger an 
Action is disabled, since the double click is used to 
assign the Monitor for Quality Control. 

 



CC/Subtitling Tab 

Text Overlay 

None:  disables this feature 

Close Captioning / Subtitling:  turns on an on-screen 
presentation of Closed Caption or Subtitling 
information. This may duplicate the information seen 
on a CC Text component, but it is formatted to 
conform to the on-screen presentation that would be 
seen by a viewer looking at a monitor with standard 
CC decoding. 

VBI/ANC Detection: in an On-line layout, the 
Calibration button is enabled. Click it to open the 
VBI/ANC Detection Calibration panel. Use it to select 
the Character set that will be used by the parser to 
decode the subtitling.  

Transparency 

Use the slider to select the transparency of the text. 

 

 



Aspect Ratio Tab 

Automatic Aspect Ratio 

(Not available in the off-line panel) 

Monitor Aspect Ratio 

Click the appropriate radio button to set the aspect 
ratio for this video screen. If you select Custom, you 
must enter values in the two data boxes: Width on 
the left, Height on the right. 

Decoder User Option 

(Not available in the off-line panel) 

 

 



Markers and Scan Tab 

Aspect Ratio Marker: 

Display Markers:  select the checkbox to display the 
aspect ratio markers on the Kaleido display 

Use the radio buttons to select 4:3, 16:9 or Custom 
markers. If you select Custom, you must enter values 
in the two data boxes: Width on the left, Height on the 
right.  

Set the marker line color and background (area 
outside the marked zone) color using the two 
pulldowns 

Transparency: 

Set the transparency of the background zone using 
the slider. 

Scan Option 

Select Over Scan or Under Scan for this video 
screen. 

Click the Cropping (Alto Only) button to open a dialog 
box allowing you to crop this video component if the 
layout is intended to be exported to Kaleido Alto or 
Kaleido Quad.  

NOTE: The cropping effect will not be displayed if 
the layout is sent to a Kaleido-K2. 

 

 

 

3.3.2.2 Online Panels – Analog Video (Kaleido-K2 only) 



Assignment Tab 

Assign Video Input: 

Input Number:  Enter the number of the Kaleido video 
input that is to appear on this Video Screen [enter a 
number between 1 and 32] 

Input Format:  

Kaleido detects and reports the format of the selected 
input. 

NOTE: In the case of Analog Video, Kaleido cannot 
automatically distinguish between versions within 
certain families, so the user must specify which of the 
system versions it will process using a dialog that is 
accessed through the Advanced… button 

• NTSC, select between: 

• NTSC M (3.58) 

• NTSC J (4.43) 

• PAL, select between: 

• PAL BGDHI 

• PAL N 

Loss of Video:   

Select the check box to display black on this video 
screen when the Signal Loss alarm is detected for 
the video stream. Leave the checkbox unchecked to 
display the video stream as found. 

Router Control:  

Router Input:  If a router has been assigned to the 
selected video input (see Control of an External 
Router by Kaleido-K2), then this data entry box will 
be active. Enter the number of the router input that 
will be routed to this Kaleido-K2 input. [enter a 
number in the range from 1 to the highest input 
available on the router] 

Video Detection Calibration:  

Click on the Calibration button to set detection 
parameters for the three configurable types of error 
detected by Kaleido: 

 

 

 



• Luma too high 

• Black detection 

• Freeze detection 

Kaleido also detects loss of video, but there are no 
configurable detection parameters. 

VBI Detection Calibration:  

Click on the Calibration button to set detection 
parameters for the two signals whose presence in the 
VBI is monitored by Kaleido: 

• CC text presence 

• VChip presence 



Border Tab 

Border Color:  

A border around the periphery of the Video Screen is 
used to show Alarms associated with the screen’s 
video. For each of the four possible Alarm states, 
select the color and width of the border. For the 
Warning and Error states, border flashing can be 
turned on or off by clicking the box. 

• The Color Fill icon shows the color currently 
selected for the border. Click on the down-arrow 
beside the Color Fill icon to open a color 
selection window and choose a different color. 

• The border width pull-down shows the current 
width of the border for each error condition. Click 
on the pull-down to select a different value (range 
between 1 and 5 pixels) 

Assign Alarm Monitor:  

Select an Alarm Monitor to be assigned to this Video 
Screen component from the pull-down list of available 
Alarms. The status of the Alarm Monitor will be 
shown by the border. 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Video Screen 
when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

Error Latching:  

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier.  

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status is indicated by the corners of the 
border, while the top, bottom and sides continue to 
show the current status. 

 



Video Window Frame:  

The appearance of the Video Screen at the Kaleido-
K2 output can be enhanced by adding a frame, which 
creates the appearance of depth. This frame does 
not appear in the KEdit rendition of the layout. Select 
the format of the frame around the Video Screen: 

• None - no frame is shown 

• Lowered Bevel - shows a border with a beveled 
profile as a graphic effect at the Kaleido-K2 
output. 

Channel:  

The Channel assignment for this Video Screen will be 
shown and the Alarm Link Order box will be active. 
The alarm link order can be changed by entering a 
new value in the box. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Video 
Screen is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is double-clicked using the mouse 
attached to the Kaleido-K2. 

Use this Monitor as target Quality Monitor: 

Ticking this box assigns this Monitor as a Quality 
Control Monitor at the Kaleido-K2 output. It will 
usually be a large Monitor that can be used on the 
Kaleido-K2 screen to quickly access a larger image 
of video from any other on-screen Monitor  

Note that when a Monitor is assigned for Quality 
Control, the use of the double click to trigger an 
Action is disabled, since the double click is used to 
assign the Monitor for Quality Control. 

 



CC/Subtitling Tab 

Text Overlay 

None:  disables this feature 

Close Captioning / Subtitling:  turns on an on-screen 
presentation of Closed Caption or Subtitling 
information. This may duplicate the information seen 
on a CC Text component, but it is formatted to 
conform to the on-screen presentation that would be 
seen by a viewer looking at a monitor with standard 
CC decoding. 

VBI/ANC Detection: Click the Calibration button to 
open the VBI/ANC Detection Calibration panel. Use it 
to select the Character set that will be used by the 
parser to decode the subtitling..  

Transparency 

Use the slider to select the transparency of the text. 

 

 



Aspect Ratio Tab 

Some signal formats carry information about the 
aspect ratio of their video signal. Kaleido allows the 
user to choose to use this information to modify how 
the signal is displayed on the Kaleido output. The 
available resources for aspect ratio detection using 
this source type are: 

• WSS – Wide Screen Signaling per ITU-R 
BT.1119-2 (NOTE:  PAL only) 

• Follow Input Resolution – as detected by the 
Kaleido input card. 

Automatic Aspect Ratio 

Sets up a prioritized list to be used for automatic 
aspect ratio detection. Kaleido will look for aspect 
ratio definitions in the data stream in this order, and 
use the first data it encounters. 

The window shows the current list. 

• If the window is empty, automatic aspect ratio is 
disabled, and the default aspect ratio is used. 

Click on the pulldown to see a list of the methods 
applicable to the current input card that are not 
already shown in the window. Click on one to select it 

Click ADD to add the selected method to the window. 

Click on a method in the window to select it, and use 
the MOVE UP and MOVE DOWN buttons to change 
its position within the list. 

Click on a method in the window to select it and click 
REMOVE to delete it from the list. 

Default Aspect Ratio 

Use the radio buttons to select the default aspect 
ratio of the video screen. This aspect ratio will be 
used unless overridden by automatic aspect ratio 
when enabled. Options: 4:3, 16:9 or Custom. If 
Custom is selected, enter the H and V proportions in 
the data boxes. 

Decoder User Option: N/A  

Decoder Format Conversion:  N/A 

 

 



Markers and Scan Tab 

Aspect Ratio Marker: 

Display Markers:  select the checkbox to display the 
aspect ratio markers on the Kaleido display 

Use the radio buttons to select 4:3, 16:9 or Custom 
markers. If you select Custom, you must enter values 
in the two data boxes: Width on the left, Height on the 
right.  

Set the marker line color and background (area 
outside the marked zone) color using the two 
pulldowns 

Transparency: 

Set the transparency of the background zone using 
the slider. 

Scan Option 

Select Over Scan or Under Scan for this video 
screen. 

Clicking the Cropping (Alto Only) button opens a 
dialog box allowing you specify cropping for this 
video component that will take effect only if the layout 
is displayed on a Kaleido Alto or Kaleido Quad. The 
effect can only be seen at the Alto/Quad output.  

NOTE: The cropping effect will not be displayed 
on the Kaleido-K2 showing this online layout. The 
panel is available here only because you may 
choose to export this layout to a Kaleido- 
Alto/Quad, and there the cropping will be applied. 

.  

 

 



Calibration Tab 

Calibration:  

Set some picture parameters for the selected input to 
the Kaleido: 

• Brightness [range 0-100, default 50] 

• Color [range 0-100, default 50] 

• Contrast [range 0-100, default 50] 

• Hue [range 0-100, default 50] 

• Sharpness [range 0-7, default 4] 

so that its appearance on the Monitor Wall output is 
optimized. 

Slider controls are provided for each parameter to 
establish a custom set-up. The default button selects 
the factory settings. 

DeInterlacer:  

Select the built-in deinterlacer’s mode of operation for 
this input, in order to optimize the Monitor Wall output 
appearance: 

• Adaptive (better for some types of moving picture 
content) 

• Temporal (better for some types of moving 
picture content) 

• Spatial (better in Editing mode when the content 
is often still-frame) 

Select one of the three using the buttons. 

Note: the deinterlacer is engaged only when the 
resolution of the video displayed on the Layout is 
greater or equal to its native resolution 

Output Dynamic Range:  

The definition of a digital video signal places Video 
Black at 16 and Video White at 236 within the 
available range of 0 to 255. The Kaleido’s monitor 
wall output is a VGA signal, with black at 0 and white 
at 255. 

 



• Select Video to use the digital video signal values 
at the Kaleido’s monitor wall output 

• Select Graphic to expand the signal to place 
Video Black at 0 and Video White at 255 at the 
output, thereby expanding its dynamic range to 
match the graphic elements within the monitor 
wall display. 



3.3.2.3 Online Panels – Digital Video (Kaleido-K2 only) 

Assignment Tab 

Assign Video Input: 

Input Number:  Enter the number of the Kaleido 
video input that is to appear on this Video Screen 
[enter a number between 1 and 32]. 

Input Format:  

Kaleido detects and reports the format of the 
selected input. 

Loss of Video:   

Select the check box to display black on this video 
screen when the Signal Loss alarm is detected for 
the video stream. Leave the checkbox unchecked 
to display the video stream as found. 

Router Control:  

Router Input:  If a router has been assigned to the 
selected video input (see Control of an External 
Router by Kaleido-K2), then this data entry box will 
be active. Enter the number of the router input that 
will be routed to this Kaleido-K2 input. [enter a 
number in the range from 1 to the highest input 
available on the router]. 

Video Detection Calibration:  

Click on the Calibration button to set detection 
parameters for the three configurable types of error 
detected by Kaleido: 

• Luma too high 

• Black detection 

• Freeze detection 

Kaleido also detects loss of video, but there are no 
configurable detection parameters. 

VBI Detection Calibration:  

Click on the Calibration button to set detection 
parameters for the two signals whose presence in 
the VBI is monitored by Kaleido: 

 



• CC text presence 

• VChip presence 



Border Tab 

Border Color:  

A border around the periphery of the Video Screen 
is used to show Alarms associated with the 
screen’s video. For each of the four possible Alarm 
states, select the color and width of the border. For 
the Warning and Error states, border flashing can 
be turned on or off by clicking the box. 

• The Color Fill icon shows the color currently 
selected for the border. Click on the down-
arrow beside the Color Fill icon to open a color 
selection window and choose a different color. 

• The border width pull-down shows the current 
width of the border for each error condition. 
Click on the pull-down to select a different 
value (range between 1 and 5 pixels) 

Assign Alarm Monitor:  

Select an Alarm Monitor to be assigned to this 
Video Screen component from the pull-down list of 
available Alarms. The status of the Alarm will be 
shown by the border.  

New:   open the Alarm Monitor panel to create a 
new alarm, which will be assigned to this Video 
Screen when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the 
alarm selected in the pull-down list. Grayed-out if 
“none” is selected. 

Error Latching:  

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status is indicated by the corners of the 
border, while the top, bottom and sides continue to 
show the current status. 

 



Video Window Frame:  

The appearance of the Video Screen at the 
Kaleido-K2 output can be enhanced by adding a 
frame, which creates the appearance of depth. This 
frame does not appear in the KEdit rendition of the 
Layout. Select the format of the frame around the 
Video Screen: 

• None - no frame is shown 

• Lowered Bevel - shows a frame with a beveled 
profile as a graphic effect at the Kaleido-K2 
output. 

Channel:  

The Channel assignment for this Video Screen will 
be shown and the Alarm Link Order box will be 
active. The alarm link order can be changed by 
entering a new value in the box. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is double-clicked using the mouse 
attached to the Kaleido-K2. 

Use this Monitor as target Quality Monitor: 

Ticking this box assigns this Monitor as a Quality 
Control Monitor at the Kaleido-K2 output. It will 
usually be a large Monitor that can be used on the 
Kaleido-K2 screen to quickly access a larger image 
of video from any other on-screen Monitor  

Note that when a Monitor is assigned for Quality 
Control, the use of the double click to trigger an 
Action is disabled, since the double click is used to 
assign the Monitor for Quality Control. 

 

 



CC/Subtitling Tab 

Text Overlay 

None:  disables this feature 

Close Captioning / Subtitling:  turns on an on-
screen presentation of Closed Caption or Subtitling 
information. This may duplicate the information 
seen on a CC Text component, but it is formatted 
to conform to the on-screen presentation that would 
be seen by a viewer looking at a monitor with 
standard CC decoding. 

VBI/ANC Detection:  Click the Calibration button to 
open the VBI/ANC Detection Calibration panel. Use 
it to select the Character set that will be used by 
the parser to decode the subtitling.  

Transparency 

Use the slider to select the transparency of the text. 

 

 



Aspect Ratio Tab 

Some signal formats carry information about the 
aspect ratio of their video signal. Kaleido allows the 
user to choose to use this information to modify 
how the signal is displayed on the Kaleido output. 
The available resources for aspect ratio detection 
using this source type are: 

• WSS – Wide Screen Signaling per ITU-R 
BT.1119-2 (NOTE:  625 operation only) 

• AFD (videoIndex) -  Active Format Descriptor 
within the Video Index of an SD signal as 
defined in SMPTE RP 186 

• Follow Input Resolution – as detected by the 
Kaleido input card. 

Automatic Aspect Ratio 

Sets up a prioritized list to be used for automatic 
aspect ratio detection. Kaleido will look for aspect 
ratio definitions in the data stream in this order, and 
use the first data it encounters. 

The window shows the current list. 

• If the window is empty, automatic aspect ratio 
is disabled, and the default aspect ratio is 
used. 

Click on the pulldown to see a list of the methods 
applicable to the current input card that are not 
already shown in the window. Click on one to select 
it 

Click ADD to add the selected method to the 
window. 

Click on a method in the window to select it, and 
use the MOVE UP and MOVE DOWN buttons to 
change its position within the list. 

Click on a method in the window to select it and 
click REMOVE to delete it from the list. 

Monitor Aspect Ratio 

Use the radio buttons to select the aspect ratio of 
the video screen. This aspect ratio will be used 
unless overridden by automatic aspect ratio when 
enabled. Options: 4:3, 16:9 or Custom. If Custom is 
selected, enter the H and V proportions in the data 

 



boxes. 

Note that Custom is not permitted when AFD is 
included in the Automatic Aspect Ratio list; you 
must select either 4:3 or 16:9 (a pop-up warning 
will appear if Custom is selected in this case) 

Decoder User Option (AFD only) 

Use the radio buttons to select between these 
options in situations where the video image aspect 
ratio does not match the screen aspect ratio: 

• Letterbox – show the entire image on the 
screen, filling the unoccupied screen area with 
black. 

• Center Cut-Out – show the center portion of 
the image at full height 

 



Safe Area Markers Tab 

Aspect Ratio Marker: 

Display Markers:  select the checkbox to display 
the aspect ratio markers on the Kaleido display 

Use the radio buttons to select 4:3, 16:9 or Custom 
markers. If you select Custom, you must enter 
values in the two data boxes: Width on the left, 
Height on the right.  

Set the marker line color and background (area 
outside the marked zone) color using the two 
pulldowns 

Transparency: 

Set the transparency of the background zone using 
the slider. 

Scan Option 

Select Over Scan or Under Scan for this video 
screen. 

Click the Cropping (Alto Only) button to open a 
dialog box allowing you to crop this video 
component if the layout is resident on a Kaleido 
Alto or Kaleido Quad. The effect can only be seen 
at the Alto/Quad output. 

NOTE: The cropping effect will not be 
displayed if the online layout is resident on a 
Kaleido-K2. 

NOTE:  Although a Kaleido Alto/Quad cannot 
be accessed online, it is possible to export the 
current layout (online on a Kaleido-K2) to an 
Alto/Quad, so this feature remains active in the 
online panels. 

 

 



Calibration Tab 

Calibration:  

Set some picture parameters for the selected input 
to the Kaleido: 

• Brightness [range 0-100, default 50] 

• Color [range 0-100, default 50] 

• Contrast [range 0-100, default 50] 

• Hue [range 0-100, default 50] 

• Sharpness [range 0-7, default 4] 

so that its appearance on the Monitor Wall output is 
optimized. 

Slider controls are provided for each parameter to 
establish a custom set-up. The default button 
selects the factory settings. 

DeInterlacer:  

Select the built-in deinterlacer’s mode of operation 
for this input, in order to optimize the Monitor Wall 
output appearance: 

• Adaptive (better for some types of moving 
picture content) 

• Temporal (better for some types of moving 
picture content) 

• Spatial (better in Editing mode when the 
content is often still-frame) 

Select one of the three using the buttons. 

Note: the deinterlacer is engaged only when the 
resolution of the video displayed on the Layout is 
greater or equal to its native resolution 

Output Dynamic Range:  

The definition of a digital video signal places Video 
Black at 16 and Video White at 236 within the 
available range of 0 to 255. The Kaleido’s monitor 
wall output is a VGA signal, with black at 0 and 
white at 255. 

 



• Select Video to use the digital video signal 
values at the Kaleido’s monitor wall output. 

• Select Graphic to expand the signal to place 
Video Black at 0 and Video White at 255 at the 
output, thereby expanding its dynamic range to 
match the graphic elements within the Monitor 
wall display. 



3.3.2.4 Online Panels – HD/SD Video (Kaleido-K2 only) 

Assignment Tab 

Assign Video Input: 

Input Number:  Enter the number of the Kaleido 
video input that is to appear on this Video Screen 
[enter a number between 1 and 32]. 

Input Format: 

Kaleido detects and reports the format of the 
selected input. 

Force detection of 480p format: When this box is 
checked, 480p60 will be detected instead of 
1080i60. 

Loss of Video:   

Select the check box to display black on this video 
screen when the Signal Loss alarm is detected for 
the video stream. Leave the checkbox unchecked 
to display the video stream as found. 

Router Control:  

Router Input:  If a router has been assigned to the 
selected video input (see Control of an External 
Router by Kaleido-K2), then this data entry box will 
be active. Enter the number of the router input that 
will be routed to this Kaleido-K2 input. [enter a 
number in the range from 1 to the highest input 
available on the router]. 

 

 



Border Tab 

Border Color: 

A border around the periphery of the Video Screen 
is used to show Alarms associated with the 
screen’s video. For each of the four possible Alarm 
states, select the color and width of the border. For 
the Warning and Error states, border flashing can 
be turned on or off by clicking the box. 

• The Color Fill icon shows the color currently 
selected for the border. Click on the down-
arrow beside the Color Fill icon to open a color 
selection window and choose a different color. 

• The border width pull-down shows the current 
width of the border for each error condition. 
Click on the pull-down to select a different 
value (range between 1 and 5) 

Assign Alarm Monitor: 

Select an Alarm Monitor to be assigned to this 
Video Screen component from the pull-down list of 
available Alarms. The status of the Alarm will be 
shown by the border. 

New:   open the Alarm Monitor panel to create a 
new alarm, which will be assigned to this Video 
Screen when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the 
alarm selected in the pull-down list. Grayed-out if 
“none” is selected. 

Error Latching: 

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier.  

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status is indicated by the corners of the 
border, while the top, bottom and sides continue to 
show the current status. 

 



Video Window Frame:  

The appearance of the Video Screen at the 
Kaleido-K2 output can be enhanced by adding a 
frame, which creates the appearance of depth. This 
frame does not appear in the KEdit rendition of the 
Layout. Select the format of the frame around the 
screen: 

• None - no frame is shown 

• Lowered Bevel - shows a frame with a beveled 
profile as a graphic effect at the Kaleido-K2 
output. 

Channel:  

The Channel assignment for this Video Screen will 
be shown and the Alarm Link Order box will be 
active. The alarm link order can be changed by 
entering a new value in the box. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is double-clicked using the mouse 
attached to the Kaleido-K2. 

Use this Monitor as target Quality Monitor: 

Ticking this box assigns this Monitor as a Quality 
Control Monitor at the Kaleido-K2 output. It will 
usually be a large Monitor that can be used on the 
Kaleido-K2 screen to quickly access a larger image 
of video from any other on-screen Monitor  

Note that when a Monitor is assigned for Quality 
Control, the use of the double click to trigger an 
Action is disabled, since the double click is used for 
Quality Control assignment. 

 
 



CC/Subtitling Tab 

Text Overlay 

None:  disables this feature 

Close Captioning / Subtitling:  turns on an on-
screen presentation of Closed Caption or Subtitling 
information. This may duplicate the information 
seen on a CC Text component, but it is formatted 
to conform to the on-screen presentation that would 
be seen by a viewer looking at a monitor with 
standard CC decoding. 

• For SD inputs, the NTSC Captioning per EIA-
608-A is decoded 

• For HD inputs, the NTSC Captioning per EIA-
608-A that is encoded within the DTC data 
stream is decoded. 

VBI/ANC Detection: Click the Calibration button to 
open the VBI/ANC Detection Calibration panel. Use 
it to select the Character set that will be used by 
the parser to decode the subtitling. 

Transparency 

Use the slider to select the transparency of the text. 

 

 

 



Aspect Ratio Tab 

Some signal formats carry information about the 
aspect ratio of their video signal. Kaleido allows the 
user to choose to use this information to modify 
how the signal is displayed on the Kaleido output. 
The available resources for aspect ratio detection 
using this source type are: 

• WSS – Wide Screen Signaling per ITU-R 
BT.1119-2  (NOTE: 625-line signals only) 

• AFD (VideoIndex) – Active Format Descriptor 
within the Video Index of an SD signal as 
defined in SMPTE RP 186 

• AFD (HD ANC) – Active Format Descriptor 
within the ANC data of an HD signal 

• Follow Input Resolution – as detected by the 
Kaleido input card. 

Automatic Aspect Ratio 

Sets up a prioritized list to be used for automatic 
aspect ratio detection. Kaleido will look for aspect 
ratio definitions in the data stream in this order, and 
use the first data it encounters. 

The window shows the current list. 

• If the window is empty, automatic aspect ratio 
is disabled, and the default aspect ratio is 
used. 

Click on the pulldown to see a list of the methods 
applicable to the current input card that are not 
already shown in the window. Click on one to select 
it. 

• Note that both AFD (VideoIndex) and AFD (HD 
ANC) appear in the list. This function will only 
be active if the selected AFD type matches the 
input connected to the card (either SD or HD) 

Click ADD to add the selected method to the 
window. 

Click on a method in the window to select it, and 
use the MOVE UP and MOVE DOWN buttons to 
change its position within the list. 

Click on a method in the window to select it and 
click REMOVE to delete it from the list. 

 



Monitor Aspect Ratio 

Use the radio buttons to select the aspect ratio of 
the video screen. This aspect ratio will be used 
unless overridden by automatic aspect ratio when 
enabled. Options: 4:3, 16:9 or Custom. If Custom is 
selected, enter the H and V proportions in the data 
boxes. 

Note that Custom is not permitted when AFD is 
included in the Automatic Aspect Ratio list; you 
must select either 4:3 or 16:9 (a pop-up warning 
will appear if Custom is selected in this case) 

Decoder User Option (AFD only) 

Use the radio buttons to select between these 
options in situations where the video image aspect 
ratio does not match the screen aspect ratio: 

• Letterbox – show the entire image on the 
screen, filling the unoccupied screen area with 
black. 

• Center Cut-Out – show the center portion of 
the image at full height 

 



Safe Area Markers Tab 

Aspect Ratio Marker: 

Display Markers:  select the checkbox to display 
the aspect ratio markers on the Kaleido display 

Use the radio buttons to select 4:3, 16:9 or Custom 
markers. If you select Custom, you must enter 
values in the two data boxes: Width on the left, 
Height on the right.  

Set the line color and background color using the 
two pulldowns 

Transparency: 

Set the transparency of the markers using the 
slider. 

Scan Option 

Select Over Scan or Under Scan for this video 
screen. 

Click the Cropping (Alto Only) button to open a 
dialog box allowing you to crop this video 
component if the online layout is resident on a 
Kaleido Alto or Kaleido Quad.  

NOTE: The cropping effect will not be 
displayed if the online layout is resident on a 
Kaleido-K2. 

NOTE:  Although a Kaleido Alto/Quad cannot 
be accessed online, it is possible to export the 
current layout (online on a Kaleido-K2) to an 
Alto/Quad, so this feature remains active in the 
online panels. 

 

 



Calibration Tab 

Calibration: 

Set some picture parameters for the selected input 
to the Kaleido: 

• Brightness [range 0-100, default 50] 

• Color [range 0-100, default 50] 

• Contrast [range 0-100, default 50] 

• Hue [range 0-100, default 50] 

• Sharpness [range 0-7, default 4] 

so that its appearance on the Monitor Wall output is 
optimized. 

Slider controls are provided for each parameter to 
establish a custom set-up. The default button 
selects the factory settings. 

Output Dynamic Range:  

The definition of a digital video signal places Video 
Black at 16 and Video White at 236 within the 
available range of 0 to 255. The Kaleido’s monitor 
wall output is a VGA signal, with black at 0 and 
white at 255. 

• Select Video to use the digital video signal 
values at the Kaleido’s monitor wall output 

Select Graphic to expand the signal to place Video 
Black at 0 and Video White at 255 at the output, 
thereby expanding its dynamic range to match the 
graphic elements within the monitor wall display. 

 

3.3.2.5 Online Panels – VGA Video (Kaleido-K2 only) 



Assignment Tab 

Assign Video Input: 

Input Number:  Enter the number of the Kaleido 
video input that is to appear on this Video Screen 
[enter a number between1 and 32]. 

Input Format: 

Kaleido detects and reports the format of the 
selected input. 

Loss of Video:   

Select the check box to display black on this video 
screen when the Signal Loss alarm is detected for 
the video stream. Leave the checkbox unchecked 
to display the video stream as found. 

Router Control:  

Router Input:  If a router has been assigned to the 
selected video input (see Control of an External 
Router by Kaleido-K2), then this data entry box will 
be active. Enter the number of the router input that 
will be routed to this Kaleido-K2 input. [enter a 
number in the range from 1 to the highest input 
available on the router] 

Note:  some of the features available in online 
mode for other video formats are not supported for 
VGA video. These features are grayed out in this 
panel. 

 



Border Tab 

Border Color:  

A border around the periphery of the Video Screen 
is used to show Alarms associated with the 
screen’s video. For each of the four possible Alarm 
states, select the color and width of the border. For 
the Warning and Error states, border flashing can 
be turned on or off by clicking the box. 

• The Color Fill icon shows the color currently 
selected for the border. Click on the down-
arrow beside the Color Fill icon to open a color 
selection window and choose a different color. 

• The border width pull-down shows the current 
width of the border for each error condition. 
Click on the pull-down to select a different 
value (range between 1 and 5 pixels) 

Assign Alarm Monitor: 

Select an Alarm Monitor to be assigned to this 
Video Screen component from the pull-down list of 
available Alarms. The status of the Alarm will be 
shown by the border. 

New:   open the Alarm Monitor panel to create a 
new alarm, which will be assigned to this Video 
Screen when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the 
alarm selected in the pull-down list. Grayed-out if 
“none” is selected. 

Error Latching: 

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status is indicated by the corners of the 
border, while the top, bottom and sides continue to 
show the current status. 

 



Video Window Frame: 

The appearance of the Video Screen at the 
Kaleido-K2 output can be enhanced by adding a 
frame, which creates the appearance of depth. This 
frame does not appear in the KEdit rendition of the 
Layout. Select the format of the frame around the 
screen: 

• None - no frame is shown. 

• Lowered Bevel - shows a frame with a beveled 
profile as a graphic effect at the Kaleido-K2 
output. 

Channel: 

The Channel assignment for this Video Screen will 
be shown and the Alarm Link Order box will be 
active. The alarm link order can be changed by 
entering a new value in the box. 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
Video Screen is double-clicked using the mouse 
attached to the Kaleido-K2. 

Use this Monitor as target Quality Monitor: 

Ticking this box assigns this Monitor as a Quality 
Control Monitor at the Kaleido-K2 output. It will 
usually be a large Monitor that can be used on the 
Kaleido screen to quickly access a larger image of 
video from any other on-screen Monitor  

Note that when a Monitor is assigned for Quality 
Control, the use of the double click to trigger an 
Action is disabled, since the double click is used for 
Quality Control assignment. 

 
 



CC/Subtitling Tab 

Close Captioning is not available for VGA video 
sources. 

 

 

 



Aspect Ratio Tab 

Some signal formats carry information about the 
aspect ratio of their video signal. Kaleido allows the 
user to choose to use this information to modify 
how the signal is displayed on the Kaleido output. 
The available resources for aspect ratio detection 
using this source type are: 

• Follow Input Resolution – as detected by the 
Kaleido input card. 

Automatic Aspect Ratio 

Sets up a prioritized list to be used for automatic 
aspect ratio detection. Kaleido will look for aspect 
ratio definitions in the data stream in this order, and 
use the first data it encounters. 

The window shows the current list. 

• If the window is empty, automatic aspect ratio 
is disabled, and the default aspect ratio is 
used. 

Click on the pulldown to see a list of the methods 
applicable to the current input card that are not 
already shown in the window. Click on one to select 
it 

Click ADD to add the selected method to the 
window. 

Click on a method in the window to select it, and 
use the MOVE UP and MOVE DOWN buttons to 
change its position within the list. 

Click on a method in the window to select it and 
click REMOVE to delete it from the list. 

Monitor Aspect Ratio 

Use the radio buttons to select the aspect ratio of 
the video screen. This aspect ratio will be used 
unless overridden by automatic aspect ratio when 
enabled. Options: 4:3, 16:9 or Custom. If Custom is 
selected, enter the H and V proportions in the data 
boxes. 

Note that Custom is not permitted when AFD is 
included in the Automatic Aspect Ratio list; you 
must select either 4:3 or 16:9 (a pop-up warning 
will appear if Custom is selected in this case) 

Decoder User Option (N/A) 

 



 

Safe Area Markers Tab 

Aspect Ratio Marker: 

Display Markers:  select the checkbox to display 
the aspect ratio markers on the Kaleido display 

Use the radio buttons to select 4:3, 16:9 or Custom 
markers. If you select Custom, you must enter 
values in the two data boxes: Width on the left, 
Height on the right.  

Set the marker line color and background (area 
outside the marked zone) color using the two 
pulldowns 

Transparency: 

Set the transparency of the background zone using 
the slider. 

Scan Option 

Select Over Scan or Under Scan for this video 
screen. 

Click the Cropping (Alto Only) button to open a 
dialog box allowing you to crop this video 
component if the layout is resident on a Kaleido 
Alto or Kaleido Quad. The effect can only be seen 
at the Alto/Quad output.  

NOTE: The cropping effect will not be 
displayed if the online layout is resident on a 
Kaleido-K2. 

NOTE:  Although a Kaleido Alto/Quad cannot 
be accessed online, it is possible to export the 
current layout (online on a Kaleido-K2) to an 
Alto/Quad, so this feature remains active in the 
online panels. 

 

 



Calibration Tab 

Video Resolution: 

The VGA input card automatically detects the 
resolution of the incoming VGA signal, and the 
detected value is reported in this box. 

Calibration: 

Set some picture parameters for the selected VGA  
input to the Kaleido, in order to optimize its 
appearance on the Kaleido output. 

Use the radio buttons at the top of the box to select 
between: 

Default: factory default values are used. The sliders 
are inactive, and the data box shows the default 
value. 

Custom:  The slider controls are active; adjust the 
parameters to get the desired result. Data values 
can be typed directly into the data box. 

These parameters are available on the main panel: 

• Brightness [range 0-100, default 50] 

• Color [range 0-100, default 50] 

• Contrast [range 0-100, default 50] 

• Hue [range 0-100, default 50] 

• Sharpness [range 0-7, default 4] 

Additional adjustments are available on the VGA 
Adjustment panel, opened by clicking on the Gains 
and Offsets… button. 

• HPhase (range –10 to +10, default 0) 

• VPhase (range –10 to +10, default 0) 

• RGain (range 0-100, default 50) 

• GGain (range 0-100, default 50) 

• BGain (range 0-100, default 50) 

• ROffset (range 0-100, default 50) 

 

 

 

 

 

 



• GOffset (range 0-100, default 50) 

• BOffset (range 0-100, default 50) 

Click Close to exit the VGA Adjustment panel and 
return to the Video VGA Calibration panel. 

Click Apply to apply the selected values to the VGA 
Video screen. 

 

3.3.3 Operation 

3.3.3.1 Fire an Action 

Left-click on the Video Screen in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Video Screen in the Action pane of 
its Configuration Panel 

• Double-click fires the double-click Action configured for this Video Screen in the Action pane 
of its Configuration Panel UNLESS IT HAS BEEN CONFIGURED AS A QUALITY CONTROL MONITOR. In 
that case, double-click is reserved to assign the Video Screen as the active Quality Control 
Monitor. 

3.3.3.2 Aspect Ratio 

Using Kaleido-RCP 

Push the Select button on the Kaleido-RCP. Each Monitor in the Layout will show an ID number, 
and its current Channel assignment (either a Channel name or “No Channel”). A yellow box 
surrounds the ID of the monitor currently being pointed to, which is the current selection. 

• Use the arrow keys to move the pointer box and change the current selection. Push Enter to 
select this Monitor for adjustment. A dotted box will appear around the Monitor. 

• If you want to change the aspect ratio of the Video Screens in multiple Monitors, use the 
arrow keys to move to each Monitor you want to change, and push the Enter button. All 
Monitors added to the selection group will show a dotted box. You can remove a Monitor from 
the group by pointing to it and pushing Enter again. 



• Push the Aspect Ratio button. The Video Screens in all the selected Monitors will change 
from their current aspect ratio (4:3 or 16:9) to the other option. 

The group of Monitors selected for adjustment is saved in memory. Pushing the Select key 
multiple times brings up the following displays: 

First push Displays ID numbers and Channel assignments on all Monitors, and the 
pointer. 

Second push Highlights the group of Monitors last selected for adjustment with dotted 
boxes. 

Third push Highlights all adjustable Monitors with dotted boxes. 

Fourth push Revert to the state of the first push (displays ID numbers and Channel 
assignments on all Monitors, and the pointer) 

Using a Keyboard 

Push the Tab key on the keyboard. Each Monitor in the Layout will show an ID number, and its 
current Channel assignment (either a Channel name or “No Channel”). A yellow box surrounds 
the ID of the Monitor currently being pointed to, which is the current selection. 

• Use the arrow keys to move the pointer box and change the current selection. Push Enter to 
select this Monitor for adjustment. A dotted box will appear around the Monitor. 

• If you want to change the aspect ratio of the Video Screens in multiple Monitors, use the 
arrow keys to move to each Monitor you want to change, and push the Enter button. All 
Monitors added to the selection group will show a dotted box. You can remove a Monitor from 
the group by pointing to it and pushing Enter again. 

• Push the R key. The Video Screens in all the selected Monitors will change from their current 
aspect ratio (4:3 or 16:9) to the other option. 

The group of Monitors selected for adjustment is saved in memory. Pushing the Tab key multiple 
times brings up the following displays: 

First push Displays ID numbers and Channel assignments on all Monitors, and the 
pointer. 

Second push Highlights the group of Monitors last selected for adjustment with dotted 
boxes. 

Third push Highlights all adjustable Monitors with dotted boxes. 

Fourth push Revert to the state of the first push (displays ID numbers and channel 
assignments on all Monitors, and the pointer). 



3.3.3.3 Unlatch Error Status of Video Screen Border 

Right-click on the Video Screen in the Kaleido display using the 
mouse, and select Unlatch Border Status. The Video Screen’s 
error detection will be unlatched.  

Note that if you select Unlatch Monitor Status, the error detection 
of all components in that Monitor with error latching capability 
(Video Screens, UMDs, Text Labels and Status Indicators) will be 
unlatched. 

 

 

3.3.3.4 Router Input Selection 

You can directly change the router input selection for a Video Screen component from the 
Kaleido output display, using the Kaleido’s mouse. 

To do so, right click over a Video Screen component. If that component’s selected input is 
sourced from a Router (as defined in the Router Reference Table), then a pull-down list of 
available Router inputs is accessible, as shown in the following diagram. The current selection 
will be indicated by a check mark. Select a new input and the Video Screen component will 
immediately display that input. The virtual router hierarchy will switch audio and other elements of 
the Monitor at the same time. 

The inputs may be identified by name as shown in the figure, if those names were defined using 
the iRouter Manager. See the iRouter Manager manual for details. 

 

 



3.3.3.5 Select Subtitling Pages 

You can directly select the subtitling pages that will be displayed on a Video Screen component 
from the Kaleido output display, using the Kaleido’s mouse. 

To do so, right click over a Video Screen component. Select Subtitling pages… from the pop-up 
menu, and enter the appropriate page number in the dialog that appears (the dialog will open with 
the current page number displayed). 

 

Note that this menu item will be only be available if you have selected “Teletext Standard” for this 
system in the VBI/ANC Data Standard Selection box available via View-Setting-VBI/ANC 
Standard in KEdit 

 

3.3.3.6 Control Aspect Ratio Markers 

You can turn Aspect Ratio markers on and off, and select the aspect ratio of those markers, from 
the Kaleido output display using the Kaleido’s mouse. 

To do so, right click over a Video Screen component. Select A/R Marker from the pop-up menu, 
and then click your desired option in the list that appears.  

 



The bottom item toggles between On and Off depending on the current state of the markers. The 
current selection is indicated by a tick mark. 

If you select Custom, the Custom Aspect Ratio Marker dialog opens, allowing you to create 
markers with any aspect ratio. Click OK to apply the custom markers. 

3.4 Audio Meter 

3.4.1 Creation:  

Use the Monitor Browser to add a Monitor containing one or more Audio Meters to the current 
Layout.  

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu 

• Push F6 on the keyboard  

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add an Audio Meter to an existing Monitor in the Layout: 

• Unlock the Monitor in which the Audio Meter is located, by right-clicking and selecting Unlock 
Monitor from the contextual menu. The Monitor’s border will turn yellow, indicating it may be 
edited. You may also ALT-click anywhere in the Monitor, which will unlock the Monitor and 
select the item you clicked. 

• Select the Audio Meter tool in the KEdit toolbar. Use the pull down arrow to change the 
current default meter selection if necessary. 

• Click inside the Monitor, and drag to place an Audio Meter of the desired size. 

Note that if the new Audio Meter extends beyond the Monitor boundary, then it will not be part of 
the Monitor. 

Or add an Audio Meter that is not part of a Monitor to the Layout: 

• Select the Audio Meter tool in the KEdit toolbar. Use the pull down arrow to change the 
current default meter selection if necessary. 

• Click at the appropriate place in the Layout, and drag to place an Audio Meter of the desired 
size 

Or copy an existing Audio Meter, inside or outside a Monitor: 

• Select the Audio Meter to be copied. 



• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new meter. 

- OR - 

• While holding CTRL, click on the Audio Meter to be copied, and drag to a new location. The 
original Audio Meter will remain, and a copy will appear at the new location. 

Note that if the new Audio Meter extends beyond the Monitor boundary, then it will not be part of 
the Monitor. 

3.4.2 Configuration: 

The attributes of an Audio Meter are adjustable using its Configuration Panel in KEdit. To access 
the panel for an Audio Meter within a Monitor: 

1. Select the Audio Meter using one of these methods: 

• Unlock the Monitor in which the Audio Meter is located, by right-clicking and selecting 
Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified by a 
YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then click on 
the Audio Meter to select it  

• ALT-click on the Audio Meter. The monitor will unlock, and the Meter will be selected.  

NOTE: at this point the Audio Meter may be positioned (click on the Audio Meter and drag) 
and scaled (click and drag a control point) within the Monitor. It cannot be moved outside the 
Monitor boundary. 

2. Open the Configuration Panel for the Audio Meter by pushing F5, or from the Configuration 
Panel item in the View menu 

To access the panel for an Audio Meter that is not part of a Monitor: 

1. Click on the Audio Meter. Control points will appear at the corners and the center of the long 
side, showing it is selected.  

NOTE: at this point the Audio Meter may be positioned (click on the Audio Meter and drag) 
and scaled (click and drag a control point) within the Layout.  

2. Open the Configuration Panel for the Audio Meter by pushing F5, or from the Configuration 
Panel item in the View menu 



3.4.2.1 Offline Panels 

Assignment Tab 

 

Assign Audio Input 

Click the button that identifies the audio source: either audio from a streaming video source, 
embedded audio or an audio card. The upper portion of the tab varies with the selection, as 
shown in the figure. 

Source Data Box Details 

Streaming IP Address Specify the IP address of the streaming audio source. 

• If the source is an Allegro1 encoder, the IP address is that of 
the encoder itself 

• If the source is a Densité probe, the IP address is that of the 
Miranda Application Server that is controlling the Densité 
frame. 

 Feed ID Identify which of several possible feeds is to be displayed 

• If the source is an Allegro1 encoder, give the ID of the feed as 
defined in the Allegro (typically C1, C2, etc.). 

• If the source is a Densité probe, give the LongID of the 
Densité frame and card plus _A 

 Usage Monitoring: streaming video from the Allegro1 encoder includes 
audio, which can be played on the Kaleido’s audio output 
(monitored), and whose level can displayed on an audio meter 
(metered). For Kaleido, the ability to monitor implies the ability to 
meter, so for an Allegro1 streaming source, select Monitoring. 



Metering:  A Densité probe will send only the level of the audio it is 
measuring, and not the audio data itself. Therefore, select 
metering if the streaming source is a Densité probe. 

Embedded Video input Enter the number of the Kaleido video input in which the 
embedded audio is found. [enter a number between 1 and 32]. 

Embedded audio can be extracted only from SD or HD feeds. 

 Group Identify which audio group is to be metered [enter a number 
between 1 and 4] 

 AES/Stereo Identify the AES/Stereo group [1 or 2] 

Audio Card AES/Stereo Enter the number of the Kaleido audio input [enter a number 
between 1 and 48] 

In all cases, define whether the Audio Meter will display stereo, left-only or right-only information. 

Audio Detection Calibration is only available in online mode. 

Channel: 

If this Audio Meter is inside a Monitor, the Channel assignment will be shown and the Audio Link 
Order box will be active. 

Enter a new value in the box to change the audio link order. 



Appearance Tab 

Meter Option:  

• Size:   Select Small, Medium or Large to set the 
displayed meter width. 

• Orientation:   Select horizontal or vertical 
orientation for the Audio Meter. 

• Gradient :  Show the tick marks and label them 
with values on the Audio Meter. 

Use the text color pull-down to select a color for 
the label text. 

• Ballistics:   Select VU meter or peak meter. 
(for audio card and embedded input, both may 
be selected). 

• Scale:   Select the meter scale from the pull-
down list (if the selected scale is not available it 
will appear on a red background). 

Each Audio Meter has three display zones. Click on 
the Advanced button to modify the Audio scale. Set 
the color of each zone, and the crossover levels 
between zones.  

 

After adjusting the settings, click one of the three 
buttons at the bottom of the panel: 

• Save - redefine the existing scale with the new 
settings. 

• Save As…- save these settings as a new 
scale, which will be named in the Save As 
dialog. 

• Cancel - exit the dialog and leave the values 
unchanged. 

Transparency:  

 

 



Use the slider to select a transparency for the 
Audio Meter. The transparency is only seen when 
the Audio Meter is overlaid on a Video Screen. The 
selected value is shown as a percentage beneath 
the slider. Possible values are 0, 15, 30, 45, 55, 70, 
85 and 100%. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, 
select the Action which will be executed when this 
Audio Meter is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action which will be executed when this 
Audio Meter is double-clicked using the mouse 
attached to the Kaleido-K2. 

 

Phase Tab 

Display Phase Meter:  

Click in the check-box to turn the Phase Meter on 
or off. 

Selecting On modifies the on-screen Audio Meter 
to include a phase meter between the left and right 
channel displays. 

Zones Configuration 

The phase meter has two zones whose color can 
be set independently using the pull down color 
selection menus. 

The sensitivity of the phase meter can be chosen 
using the slider. The sensitivity scale is 
representative of a vector-display phase meter 
where +8/8 represents in-phase and -8/8 
represents out-of-phase. Use the slider to select a 
value that reflects a sensitivity appropriate to the 
situation. This will determine the crossover point 
between the two zones. 

 



Note: The audio phase meter indicates a signal out 
of phase when the center bar between the audio 
level meters is predominantly filled. The bar should 
normally oscillate within the “Normal operation 
zone” indicated in the graphic on the right. 

 

3.4.2.2 Online Panels (Kaleido-K2 only) 

Assignment Tab 

 

Assign Audio Input 

Click the button that identifies the audio source: either audio from a streaming video source, 
embedded audio or an audio card. The upper portion of the tab varies with the selection, as 
shown in the figure. 

Source Data Box Details 

Streaming IP Address Specify the IP address of the streaming audio source. 



• If the source is an Allegro1 encoder, the IP address is that of 
the encoder itself 

• If the source is a Densité probe, the IP address is that of the 
Miranda Application Server that is controlling the Densité 
frame.  

 Feed ID Identify which of several possible feeds is to be displayed 

• If the source is an Allegro1 encoder, give the ID of the feed as 
defined in the Allegro (typically C1, C2, etc.). 

• If the source is a Densité probe, give the LongID of the 
Densité frame and card plus _A 

 Usage Monitoring: streaming video from the Allegro1 encoder includes 
audio, which can be played on the Kaleido’s audio output 
(monitored), and whose level can displayed on an audio meter 
(metered). For Kaleido, the ability to monitor implies the ability to 
meter, so for an Allegro1 streaming source, select Monitoring. 

Metering: A Densité probe will send only the level of the audio it is 
measuring, and not the audio data itself. Therefore, select 
metering if the streaming source is a Densité probe. 

Embedded Video input Enter the number of the Kaleido video input in which the 
embedded audio is found. [enter a number between 1 and 32]. 

Embedded audio can be extracted only from SD or HD feeds. 

 Group Identify which audio group is to be metered [enter a number 
between 1 and 4] 

 AES/Stereo Identify the AES/Stereo group [1 or 2] 

Audio Card AES/Stereo Enter the number of the Kaleido audio input [enter a number 
between 1 and 48] 

In all cases, define whether the meter will display stereo, left-only or right-only information. 
 



Allocate VU/Phase Meters: 

Clicking the Allocate button opens a window where 
the inputs to the VU and phase meters can be 
selected. 

Due to a hardware limitation, you can monitor only 
2 AES VU or Phase inputs for each video input 
card. Here you have to select which AES you want 
to monitor. Doing this will not change the 
assignment of your Audio Meter, but will just enable 
the phase extraction. 

If the phase you have selected (here it is video 16, 
Group 1, AES 1) is not the same as those you are 
monitoring, you won’t see anything on your phase 
meter. In the example, you must select Group 2, 
AES 1 for either Phase Meter A or B, before you 
will be able to use the phase mater. 

This restriction only applies when decoding 
embedded audio from MWI-SDI and MWI-HD 
modules. There is no such limitation when feeding 
an audio phase meter from the MWI-SA and MWI-
AES audio input modules. 

 

 

Audio Detection Calibration:  

Click on the Calibration button to open the Audio Detection Calibration box. See Alarms and 
Alarm Monitors for a full description of these panels. Note that streaming sources are not 
supported for this function. 

Channel:  

If this Audio Meter is inside a Monitor, the Channel assignment will be shown and the Audio Link 
Order box will be active. 

Enter a new value in the box to change the audio link order. 



Appearance Tab 

Meter Option: 

• Size:   Select Small, Medium or Large to set the 
displayed Audio Meter width. 

• Orientation:   Select horizontal or vertical 
orientation for the Audio Meter. 

• Gradient :  Show the tick marks and label them 
with values on the Audio Meter. 

Use the text color pull-down to select a color for 
the label text  

• Ballistics:   Select VU meter or peak meter. (for 
audio card and embedded input, both may be 
selected). 

• Scale:   Select the meter scale from the pull-
down list (if the selected scale is not available it 
will appear on a red background). 

Each Audio Meter has three display zones. Click on 
the Advanced button to modify the Audio scale. Set 
the color of each zone, and the crossover levels 
between zones. 

 

After adjusting the settings, click one of the three 
buttons at the bottom of the panel: 

• Save - redefine the existing scale with the new 
settings. 

• Save As…- save these settings as a new scale, 
which will be named in the Save As dialog. 

• Cancel - exit the dialog and leave the values 
unchanged. 

Peak Configuration  (audio card only): 

 

 



Set the rise time for Peak meters to reach their 
peak value. Choose between 10 ms and 
instantaneous.  

NOTE: Once the user sets the Rise Time of one 
input it will change all other audio card inputs. 

Transparency: 

Use the slider to select a transparency for the audio 
meter. The transparency is only seen when the 
audio meter is overlaid on a video screen. The 
selected value is shown as a percentage beneath 
the slider. Possible values are 0, 15, 30, 45, 55, 70, 
85 and 100% 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, 
select the Action which will be executed when this 
Audio Meter is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action which will be executed when this 
Audio Meter is double-clicked using the mouse 
attached to the Kaleido-K2. 

 



Phase Tab 

Display Phase Meter: 

Click in the check-box to turn the Phase Meter on 
or off. 

Selecting On modifies the on-screen Audio Meter to 
include a phase meter between the left and right 
channel displays. 

Zones Configuration 

The phase meter has two zones whose color can 
be set independently using the pull down color 
selection menus. 

The sensitivity of the phase meter can be chosen 
using the slider. The sensitivity scale is 
representative of a vector-display phase meter 
where +1 represents in-phase and -1 represents 
out-of-phase. Use the slider to select a value that 
reflects a sensitivity appropriate to the situation. 
This will determine the crossover point between the 
two zones. 

 

Note: The audio phase meter indicates a signal out 
of phase when the center bar between the audio 
level meters is predominantly filled. The bar should 
normally oscillate within the “Normal operation 
zone” indicated in the graphic on the right. 

 



Calibration Tab 

This tab provides access to audio level calibration 
for the Kaleido’s audio inputs. 

• The audio level for an input can be adjusted 
from any meter assigned to that input 

If the panel opens and displays only a  warning 
message, one of the following situations applies: 

• You must assign a valid audio input  

Return to the Assignment tab, and enter the 
number of a valid input in the “Assign Audio 
Input” section 

• Calibration Not Available for Streaming. 

You have selected a Streaming input in the 
Assignment tab. Operational level adjustment is 
not available for Streaming inputs. 

Setting 

Click the radio buttons to select one of the available 
options: 

Custom Setting:  use this panel to adjust the audio 
operation level FOR THIS INPUT ONLY 

Master Setting:  use this panel to adjust the audio 
operation level for ALL AUDIO INPUTS of the same 
type (analog or digital) that have “Master Setting” 
selected in their control panel.  

• A warning will appear in the panel below the 
adjustment controls when this option is 
selected, to remind the user that this 
adjustment affects other inputs, not just the one 
monitored by this meter. 

• Meters that have “Custom Setting” selected in 
their control panel are not affected when the 
Master Setting is adjusted 

The next section of the panel will be titled according 
to the type of audio signal (digital or analog) being 
monitored by this meter, and the contents will vary 
accordingly. 

Digital Audio Operation Level Adjustment 

 

 

 



3.4.3 Operation 

3.4.3.1 Action 

Left-click on the Audio Meter in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Audio Meter in the Action pane of 
its Configuration Panel 

• Double-click fires the double-click Action configured for this Audio Meter in the Action pane of 
its Configuration Panel 

If the Action fired is the Audio Monitoring Output Action, then the signal being displayed by this 
Audio Meter will be routed to the Kaleido’s audio monitor. 

3.4.3.2 Select a Monitor for Audio Monitoring 

Using Kaleido-RCP 

Push the Select button on the Kaleido-RCP. Each Monitor in the Layout will show an ID number, 
and its current Channel assignment (either a Channel name or “No Channel”). A yellow box 
surrounds the ID of the Monitor currently being pointed to, which is the current selection.  

• Use the arrow keys to move the pointer box and change the current selection.  

• Push the Audio Mon button. The audio from the Audio Meter with link order 1 in this Monitor 
will be heard on the Kaleido’s audio monitor. 

• Pushing Audio Mon again will cycle the audio monitoring source through the other Audio 
Meters within the Monitor, in link-order sequence, ending in Mute. 

Use the Arrow buttons to adjust the audio monitoring: 

• Up and Down: Adjust the audio volume.  

Note: if the audio originates in a .WAV file, its volume must be 
adjusted using the Kaleido’s Windows volume control, as the signal 
is not processed through the Kaleido’s hardware. You must connect 
a keyboard and mouse to the Kaleido to do this. 

Display the Windows task bar on the Kaleido screen (CTRL+ESC 
or Windows Logo key) and click the Volume icon on the taskbar. 
Adjust the Volume Control in the window until the appropriate 
volume is heard on the audio monitor, then close the window. 



 

• Left: Switch between Mute the audio monitoring and revert to Normal. 

• Right: Switch between Attenuate the volume by 20 dB and revert to 
Normal. 

Using a Keyboard 

Push the Tab key on the keyboard. Each Monitor in the Layout will show an ID number, and its 
current Channel assignment (either a Channel name or “No Channel”). A yellow box surrounds 
the ID of the Monitor currently being pointed to, which is the current selection. 

• Use the arrow keys to move the pointer box and change the current selection. 

• Push the W key. The audio from the Audio Meter with link order 1 in this Monitor will be heard 
on the Kaleido’s audio monitor. 

• Pushing W again will cycle the audio monitoring source through the other Audio Meters within 
the Monitor, in link-order sequence, ending in Mute. 

Use the Arrow keys to adjust the audio monitoring: 

• Up and Down: Adjust the audio volume.  

Note: if the audio originates in a .WAV file, its volume must be 
adjusted using the Kaleido’s Windows volume control, as the signal 
is not processed through the Kaleido’s hardware.  

Display the Windows task bar on the Kaleido screen (CTRL+ESC 
or Windows Logo key) and click the Volume icon on the taskbar. 
Adjust the Volume Control in the window until the appropriate 
volume is heard on the audio monitor, then close the window. 



 

• Left: Switch between Mute the audio monitoring and revert to Normal. 

• Right: Switch between Attenuate the volume by 20 dB and revert to 
Normal. 

3.5 Under Monitor Display (UMD) 

3.5.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more UMDs to the current Layout.  

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard  

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a UMD to an existing Monitor in the Layout: 

• Unlock the Monitor in which the UMD is located, by right-clicking and selecting Unlock 
Monitor from the contextual menu. The Monitor’s border will turn yellow, indicating it may be 
edited. You may also ALT-click anywhere in the Monitor, which will unlock the Monitor and 
select the item you clicked. 

• Select a vertical or horizontal UMD tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a UMD of the desired size. 



Note that if the new UMD extends beyond the Monitor boundary, then it will not be part of the 
Monitor. 

Or add a UMD that is not part of a Monitor to the Layout: 

• Select a vertical or horizontal UMD tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a UMD of the desired size. 

Or copy an existing UMD, inside or outside a Monitor: 

• Select the UMD to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new UMD. 

- OR - 

• While holding CTRL, click on the UMD to be copied, and drag to a new location. The original 
UMD will remain, and a copy will appear at the new location. 

Note that if the new UMD extends beyond the Monitor boundary, then it will not be part of the 
Monitor. 

3.5.2 Configuration: 

The attributes of a UMD are adjustable using its Configuration Panel in KEdit. To access the 
panel for a UMD within a Monitor: 

1. Select the UMD using one of these methods: 

• Unlock the Monitor in which the UMD is located, by right-clicking and selecting Unlock 
Monitor from the contextual menu (an UNLOCKED Monitor is identified by a YELLOW 
BORDER and YELLOW RESIZING HANDLES  in its corners), and then click on the UMD 
to select it  

• ALT-click on the UMD. The monitor will unlock, and the UMD will be selected. 

NOTE: at this point the UMD may be positioned (click on the UMD and drag) and scaled 
(click and drag a control point) within the Monitor. It cannot be moved outside the Monitor 
boundary. 

2. Open the Configuration Panel for the UMD by pushing F5, or from the Configuration Panel 
item in the View menu 

Three tabs are available to set different parameters for the UMD. 



3.5.2.1 Offline Panels 

Assignment Tab 

UMD Static Text: 

Click the selection button to select Static Text.  

The text typed into the Text window will appear in 
the on-screen window of both the Monitor Wall 
output and the KEdit representation [enter any 
alphanumeric characters]. 

UMD Dynamic Text: 

Click the selection button to select Dynamic Text. 
The source for the text could be the Gateway, or a 
third-party service. 

Gateway:  Type Gateway in the ServiceID text box. 
Use the Gateway command setKDynamicText to 
send the text to this UMD.   

Third-party service:   See TSL, Andromeda, 
Encoda and Kalypso for an explanation of the 
services to use to get dynamic inputs for this 
Component. 

• In the “ServiceID” field, type the alias or the 
Long ID of the service to be used  

• In the “Text Address” field, enter the address to 
associate with this Component. Valid values 
vary depending on the service used: 

• TSL: value range 1 to 127. 

• Andromeda : value range 1 to 256. 

• Encoda : value range 1 to 255 

• Kalypso : the range of values depends on 
the value entered in the “Level” field: 

• Level = 0, 1, 2, 3: range is 1-48 

• Level = 4: range  is 1-127  

In the “Level” field, enter the level to associate 
with this Component. Valid values vary 
depending on the service used: 

• TSL: value can be any of 0, 1 or 2. 

• Andromeda : value range 0 to 14. 

 



• Encoda : not used 

• Kalypso: Enter the number of the option 
you wish to use for text display (value from 1 
to 4) 

• Level 0 to 3 implies that the "Text 
Address" represents a Kalypso device 
output. In that case the "Text Address" 
must range between 1 and 48.  

• 0: the label represents the initial 
background feed 

• 1: the label represents the initial and 
the previous background feed 

• 2: the label represents the previous 
background feed 

• 3: the label represents the source id 
of the current background feed 

• Level 4 implies that the "Text Address" 
represents a Kalypso device Source ID. 
In that case the "Text Address" must 
range between 1 and 128. 

• 4: the label represents the source id 
of the current background feed 

The KEdit window will show the ID, Address and 
Level of the source text. The Monitor Wall output of 
the Kaleido will show the text originating at that 
source. 

Transparency: 

Use the slider to select a transparency for the 
UMD. The transparency is only seen when the 
UMD is overlaid on a Video Screen. The selected 
value is shown as a percentage beneath the slider. 
Possible values are 0, 15, 30, 45, 55, 70, 85 and 
100% 

Channel: If this UMD is within a Monitor, the 
name of the assigned Channel will be shown, and 
the Link order box will be active. Enter the link 
order of the UMD data within the channel that this 
UMD will display 



Alarm Tab 

Display Options: 

For each of the four possible Alarm states, select 
the color of the UMD background and the color of 
the text, and whether the Transparency feature is 
enabled. You can also specify if the background will 
flash for Error and Warning states. 

Select a background color from the list in the pull-
down box. 

  

Click on the down-arrow beside the Text Color icon 
to open a color selection window to choose a 
different font color. 

Assign Alarm Monitor: 

Select an Alarm Monitor to be assigned to this 
UMD from the pull-down list of available Alarms. 

New:   open the Alarm Monitor panel to create a 
new alarm, which will be assigned to this UMD 
when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the 
alarm selected in the pull-down list. Grayed-out if 
“none” is selected. 

Error Latching: 

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box.  

The latched status will be indicated by the end 
segments of the UMD, while the central portion will 
continue to show the current status. 

Channel: 

If this UMD is inside a Monitor, the Channel 
assignment will be shown and the Alarm Link Order 

 



box will be active. Change the link order of the 
UMD by typing a new value in the box. 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, 
select the Action that will be executed when this 
UMD is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
UMD is double-clicked using the mouse attached to 
the Kaleido-K2. 

 

3.5.2.2 Online Panels (Kaleido-K2 only) 



Assignment Tab 

UMD Static Text: 

Click the selection button to select Static Text.  

The text typed into the Text window will appear in 
the on-screen window of both the Monitor Wall 
output and the KEdit representation [enter any 
alphanumeric characters]. 

UMD Dynamic Text: 

Click the selection button to select Dynamic Text. 
The source for the text could be the Gateway, or a 
third-party service. 

Gateway:  Type Gateway in the ServiceID text box. 
Use the Gateway command setKDynamicText to 
send the text to this UMD.   

Third-party service:   See TSL, Andromeda, 
Encoda and Kalypso for an explanation of the 
services to use to get dynamic inputs for this 
Component. 

• In the “ServiceID” field, type the alias or the 
Long ID of the service to be used 

• In the “Text Address” field, enter the address to 
associate with this Component. Valid values 
vary depending on the service used: 

• TSL: value range 1 to 127. 

• Andromeda : value range 1 to 256. 

• Encoda : value range 1 to 255 

• Kalypso : the range of values depends on 
the value entered in the “Level” field: 

• Level = 0, 1, 2, 3: range is 1-48 

• Level = 4: range  is 1-127  

• In the “Level” field, enter the level to associate 
with this Component. Valid values vary 
depending on the service used: 

• TSL: value can be any of 0, 1 or 2. 

• Andromeda : value range 0 to 14. 

 



• Encoda : not used 

• Kalypso: Enter the number of the option 
you wish to use for text display (value from 
1 to 4) 

• Level 0 to 3 implies that the "Text 
Address" represents a Kalypso device 
output. In that case the "Text Address" 
must range between 1 and 48.  

• 0: the label represents the initial 
background feed 

• 1: the label represents the initial and 
the previous background feed 

• 2: the label represents the previous 
background feed 

• 3: the label represents the current 
background feed 

• Level 4 implies that the "Text Address" 
represents a Kalypso device Source ID. 
In that case the "Text Address" must 
range between 1 and 128. 

• 4: the label represents the source id 
of the current background feed 

The KEdit window will show the ID, Address and 
Level of the source text. The Monitor Wall output of 
the Kaleido will show the text originating at that 
source. 

Transparency: 

Use the slider to select a transparency for the 
UMD. The transparency is only seen when the 
UMD is overlaid on a Video Screen. The selected 
value is shown as a percentage beneath the slider. 
Possible values are 0, 15, 30, 45, 55, 70, 85 and 
100%. 

Channel: 

If this UMD is within a Monitor, the name of the 
assigned Channel will be shown, and the Link order 
box will be active. Enter the link order of the UMD 
data within the Channel that this UMD will display. 



Alarm Tab 

Display Options: 

For each of the four possible Alarm states, select 
the color of the UMD background and the color of 
the text, and whether the Transparency feature is 
enabled. You can also specify if the background 
will flash for Error and Warning states. 

Select a background color from the list in the pull-
down box. 

Click on the down-arrow beside the Text Color icon 
to open a color selection window to choose a 
different font color. 

Assign Alarm Monitor: 

Select an Alarm Monitor to be assigned to this 
UMD from the pull-down list of available Alarms. 

New:   open the Alarm Monitor panel to create a 
new alarm, which will be assigned to this UMD 
when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the 
alarm selected in the pull-down list. Grayed-out if 
“none” is selected. 

Error Latching: 

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status will be indicated by the end 
segments of the UMD, while the central portion will 
continue to show the current status. 

Channel: 

If this UMD is inside a Monitor, the Channel 
assignment will be shown and the Alarm Link Order 
box will be active. Change the link order of the 
UMD by typing a new value in the box. 

 



Action Tab 

Assign Actions: 

Action on single click:  from the pull-down box, 
select the Action that will be executed when this 
UMD is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
UMD is double-clicked using the mouse attached to 
the Kaleido-K2. 

 

3.5.3 Operation 

3.5.3.1 Fire an Action 

Left-click on the UMD in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this UMD in the Action pane of its 
Configuration Panel 

• Double-click fires the double-click Action configured for this UMD in the Action pane of its 
Configuration Panel 

3.5.3.2 Unlatch Error Status 

Right-click on the UMD in the Kaleido display using the mouse, and select Unlatch Status. The 
UMD’s error detection will be unlatched 

 

3.5.3.3 Define the text to be displayed 

Right-click on the UMD in the Kaleido display, and select Edit Text from the pop-up menu. 



 

In the Edit Text dialog that appears, use the radio buttons to select the source of text that will 
appear in this UMD: 

Static Text: 

The text typed into the Text window will appear in the on-screen UMD of both the Monitor Wall 
output and the on-line KEdit representation [enter any alphanumeric characters]. 

Dynamic Text: 

Click the selection button to select Dynamic Text. The source for the text could be the Gateway, 
or a third-party service. 

Gateway:  Type Gateway in the “Dynamic Text” text box. Use the Gateway command 
setKDynamicText to send the text to this UMD.   

Third-party service:   See TSL, Andromeda, Encoda and Kalypso for an explanation of the 
services to use to get dynamic inputs for this Component. 

• In the “Dynamic Text” field, type the alias or the Long ID of the service used. 

• In the “Text Address” field, enter the address to associate with this Component. Valid values 
vary depending on the service used: 

• TSL: value range 1 to 127. 

• Andromeda : value range 1 to 256. 

• Encoda : value range 1 to 255 

• Kalypso : the range of values depends on the value entered in the “Level” field: 

• Level = 0, 1, 2, 3: range is 1-48 

• Level = 4: range  is 1-127  

• In the “Level” field, enter the level to associate with this Component. Valid values vary 
depending on the service used: 

• TSL: value can be any of 0, 1 or 2. 

• Andromeda : value range 0 to 14. 

• Encoda : not used 



• Kalypso: Enter the number of the option you wish to use for text display (value from 1 to 
4) 

• Level 0 to 3 implies that the "Text Address" represents a Kalypso device output. In that 
case the "Text Address" must range between 1 and 48.  

• 0: the label represents the initial background feed 

• 1: the label represents the initial and the previous background feed 

• 2: the label represents the previous background feed 

• 3: the label represents the current background feed 

• Level 4 implies that the "Text Address" represents a Kalypso device Source ID. In that 
case the "Text Address" must range between 1 and 128. 

• 4: the label represents the source id of the current background feed 

The Monitor Wall output of the Kaleido will show the text originating at that source. The on-line 
KEdit window will show the ID, Address and Level of the source text. 

 

3.6 Text Label 

3.6.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more Text Labels to the current 
Layout.  

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu 

• Push F6 on the keyboard  

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a Text Label to an existing Monitor in the Layout: 

• Unlock the Monitor in which the Text Label will be located, by right-clicking and selecting 
Unlock Monitor from the contextual menu. The Monitor’s border will turn yellow, indicating it 
may be edited. You may also ALT-click anywhere in the Monitor, which will unlock the 
Monitor and select the item you clicked. 

• Select the Text Label tool in the KEdit toolbar. 



• Click inside the Monitor, and drag to place a Text Label of the desired size. 

Note that if the new Text Label extends beyond the Monitor boundary, then it will not be part of 
the Monitor. 

Or add a Text Label that is not part of a Monitor to the Layout: 

• Select the Text Label tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Text Label of the desired 
size. 

Or copy an existing Text Label, inside or outside a Monitor: 

• Select the Text Label to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new Text Label. 

- OR - 

• While holding CTRL, click on the Text Label to be copied, and drag to a new location. The 
original Text Label will remain, and a copy will appear at the new location. 

Note that if the new Text Label extends beyond the Monitor boundary, then it will not be part of 
the Monitor. 

3.6.2 Configuration: 

The attributes of a Text Label are adjustable using its Configuration Panel in KEdit. To access the 
panel for a Text Label within a Monitor: 

1. Select the Text Label using one of these methods: 

• Unlock the Monitor in which the Text Label is located, by right-clicking and selecting 
Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified by a 
YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then click on 
the Text Label to select it  

• ALT-click on the Text Label. The monitor will unlock, and the Text Label will be selected. 

NOTE: at this point the Text Label may be positioned (click on the Text Label and drag) and 
scaled (click and drag a control point) within the Monitor. It cannot be moved outside the 
Monitor boundary 

2. Open the Configuration Panel for the Text Label by pushing F5, or from the Configuration 
Panel item in the View menu 

Four tabs are available to set different parameters for the Text Label.  



3.6.2.1 Offline Panels 

Assignment Tab 

Label Static Text: 

Click the selection button to select Static Text. The 
text typed into the Text window will appear in the on-
screen window of both the Monitor Wall output and 
the KEdit representation [enter any alphanumeric 
characters]. 

Label Dynamic Text: 

Click the selection button to select Dynamic Text. The 
source for the text could be the Gateway, or a third-
party service. 

Gateway:  Type Gateway in the ServiceID text box. 
Use the Gateway command setKDynamicText to 
send the text to this Text Label.   

Third-party service:   See TSL, Andromeda, Encoda 
and Kalypso for an explanation of the services to use 
to get dynamic inputs for this Component. 

• In the “ServiceID” field, type the alias or the Long 
ID of the service used. 

• In the “Text Address” field, enter the address to 
associate with this Component. Valid values vary 
depending on the service used: 

• TSL: value range 1 to 127. 

• Andromeda : value range 1 to 256. 

• Encoda : value range 1 to 255 

• Kalypso : the range of values depends on the 
value entered in the “Level” field: 

• Level = 0, 1, 2, 3: range is 1-48 

• Level = 4: range  is 1-127  

• In the “Level” field, enter the level to associate 
with this Component. Valid values vary 
depending on the service used: 

• TSL: value can be any of 0, 1 or 2. 

• Andromeda : value range 0 to 14. 

• Encoda : not used 

 



• Kalypso: Enter the number of the option you 
wish to use for text display (value from 1 to 4) 

• Level 0 to 3 implies that the "Text Address" 
represents a Kalypso device output. In that 
case the "Text Address" must range 
between 1 and 48.  

• 0: the label represents the initial 
background feed 

• 1: the label represents the initial and the 
previous background feed 

• 2: the label represents the previous 
background feed 

• 3: the label represents the current 
background feed 

• Level 4 implies that the "Text Address" 
represents a Kalypso device Source ID. In 
that case the "Text Address" must range 
between 1 and 128. 

• 4: the label represents the source id of 
the current background feed 

The KEdit window will show the ID, Address and 
Level of the source text. The Monitor Wall output of 
the Kaleido will show the text originating at that 
source. 

MultiData Text: 

Click the selection button to select MultiData text. 
From the pulldown list, select a MultiData source. 

• See MultiData Browser for a description of MultiData 
sources and their application in Kaleido.  

Click New to open a blank MultiData Configuration 
panel to create a new MultiData source.  

Click Edit to open the MultiData Configuration panel 
for the source selected in the pulldown list, in order to 
modify it or examine its contents. 

Transparency: 

Set the degree of transparency of the Text Label as 
displayed on the Monitor Wall output (Kaleido K2 
only). The transparency is only seen when the Text 



Label is overlaid on a Video Screen. The selected 
value is shown as a percentage beneath the slider. 
Possible values are 0, 15, 30, 45, 55, 70, 85 and 
100%. 

Border: 

Select the format of the border around the screen: 

• None - no border is shown. 

• Lowered Bevel - shows a border with a beveled 
profile. 

 



Alarm Tab 

Display Options: 

For each of the four possible Alarm states, select the 
color of the text, the color of the background, and 
whether the Transparency feature is enabled. You 
can also specify if the background will flash for Error 
and Warning states. 

Click on the down-arrow beside the Color Fill icon to 
open a color selection window to choose a different 
color. 

Click on the down-arrow beside the Text Color icon to 
open a color selection window to choose a different 
font color. 

Error Latching: 

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The Latched status will be indicated by a colored 
outline surrounding the Text Label, while the 
background and text will continue to show the current 
status. 

Assign Alarm Monitor: 

Select an Alarm Monitor to be assigned to this Text 
Label from the pull-down list of available Alarms. 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Text Label when 
the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

Channel: 

If this text label is within a Monitor, the name of the 
assigned Channel will be shown, and the Alarm Link 

 



order box will be active. Enter the link order of the 
Alarm associated with the Text Label data within the 
Channel that this Text Label will display. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Text Label 
is single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Text Label 
is double-clicked using the mouse attached to the 
Kaleido-K2. 

 



Alignment Tab 

Text Formatting  
 
Use the radio buttons to select the text formatting 
option: 
 
Wrap text:  The text is wrapped within the text label, 
but if the text is too large to fit within the label, the text 
will be replaced by “. . .” (three dots) 
 
Shrink to fit:  The text will be reduced in size to fit 
within the text label. 

Text alignment 

Use the radio buttons to select whether the text will 
be left-aligned, centered, or right-aligned within the 
text label. 

 

 

3.6.2.2 Online Panels  (Kaleido-K2 only) 



Assignment Tab 

Label Static Text: 

Click the selection button to select Static Text. The 
text typed into the Text window will appear in the on-
screen window of both the Monitor Wall output and 
the KEdit representation [enter any alphanumeric 
characters]. 

Label Dynamic Text: 

Click the selection button to select Dynamic Text. 
The source for the text could be the Gateway, or a 
third-party service. 

Gateway:  Type Gateway in the ServiceID text box. 
Use the Gateway command setKDynamicText to 
send the text to this Text Label.   

Third-party service:   See TSL, Andromeda, Encoda 
and Kalypso for an explanation of the services to use 
to get dynamic inputs for this Component. 

• In the “ServiceID” field, type the alias or the Long 
ID of the service used. 

• In the “Text Address” field, enter the address to 
associate with this Component. Valid values vary 
depending on the service used: 

• TSL: value range 1 to 127. 

• Andromeda : value range 1 to 256. 

• Encoda : value range 1 to 255 

• Kalypso : the range of values depends on the 
value entered in the “Level” field: 

• Level = 0, 1, 2, 3: range is 1-48 

• Level = 4: range  is 1-127  

• In the “Level” field, enter the level to associate 
with this Component. Valid values vary 
depending on the service used: 

• TSL: value can be any of 0, 1 or 2. 

• Andromeda : value range 0 to 14. 

• Encoda : not used 

 

 



• Kalypso: Enter the number of the option you 
wish to use for text display (value from 1 to 4) 

• Level 0 to 3 implies that the "Text Address" 
represents a Kalypso device output. In that 
case the "Text Address" must range 
between 1 and 48.  

• 0: the label represents the initial 
background feed 

• 1: the label represents the initial and 
the previous background feed 

• 2: the label represents the previous 
background feed 

• 3: the label represents the current 
background feed 

• Level 4 implies that the "Text Address" 
represents a Kalypso device Source ID. In 
that case the "Text Address" must range 
between 1 and 128. 

• 4: the label represents the source id of 
the current background feed 

The KEdit window will show the ID, Address and 
Level of the source text. The Monitor Wall output of 
the Kaleido will show the text originating at that 
source. 

MultiData Text: 

Click the selection button to select MultiData text. 
From the pulldown list, select a MultiData source. 

• See MultiData Browser for a description of MultiData 
sources and their application in Kaleido.  

Click New to open a blank MultiData Configuration 
panel to create a new MultiData source.  

Click Edit to open the MultiData Configuration panel 
for the source selected in the pulldown list, in order to 
modify it or examine its contents. 

Transparency: 

Set the degree of transparency of the Text Label as 
displayed on the Monitor Wall output. The 
transparency is only seen when the Text Label is 



overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Border: 

Select the format of the border around the screen: 

• None - no border is shown. 

• Lowered Bevel - shows a border with a beveled 
profile. 

Channel: 

If this Text Label is within a Monitor, the name of the 
assigned Channel will be shown, and the Link order 
box will be active. Enter the link order of the Text 
data within the Channel that this Text Label will 
display. 



Alarm Tab 

Display Options: 

For each of the four possible Alarm states, select the 
color of the text, the color of the background, and 
whether the Transparency feature is enabled. You 
can also specify if the background will flash for Error 
and Warning states. 

Click on the down-arrow beside the Color Fill icon to 
open a color selection window to choose a different 
color. 

Click on the down-arrow beside the Text Color icon to 
open a color selection window to choose a different 
font color. 

Error Latching: 

Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The Latched status will be indicated by a colored 
outline surrounding the Text Label, while the 
background and text will continue to show the current 
status. 

Assign Alarm Monitor: 

Select an Alarm Monitor to be assigned to this Text 
Label from the pull-down list of available Alarms. 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Text Label when 
the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

Channel: 

If this Text Label is within a Monitor, the name of the 
assigned Channel will be shown, and the Alarm Link 

 



order box will be active. Enter the link order of the 
Alarm associated with the Text Label data within the 
Channel that this Text Label will display. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Text Label 
is single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this Text 
Label is double-clicked using the mouse attached to 
the Kaleido-K2. 

 



Alignment Tab 

Text Formatting  
 
Use the radio buttons to select the text formatting 
option: 
 
Wrap text:  The text is wrapped within the text label, 
but if the text is too large to fit within the label, the 
text will be replaced by “. . .” (three dots) 
 
Shrink to fit:  The text will be reduced in size to fit 
within the text label. 

Text alignment 

Use the radio buttons to select whether the text will 
be left-aligned, centered, or right-aligned within the 
text label. 

 

 

3.6.3 Operation 

3.6.3.1 Fire an Action 

Left-click on the Text Label in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Text Label in the Action pane of its 
Configuration Panel. 

• Double-click fires the double-click Action configured for this Text Label in the Action pane of 
its Configuration Panel. 

3.6.3.2 Unlatch Error Status 

Right-click on the Text Label in the Kaleido display using the mouse, and select Unlatch Status. 
The Text Label’s error detection will be unlatched 

 

3.6.3.3 Define the text to be displayed 

Right-click on the Text Label in the Kaleido display, and select Edit Text from the pop-up menu. 



 

In the Edit Text dialog that appears, use the radio buttons to select the source of text that will 
appear in this Text Label: 

Static Text: 

The text typed into the Text window will appear in the on-screen Text Label of both the Monitor 
Wall output and the on-line KEdit representation [enter any alphanumeric characters]. 

Dynamic Text: 

Click the selection button to select Dynamic Text. The source for the text could be the Gateway, 
or a third-party service. 

Gateway:  Type Gateway in the “Dynamic Text" text box. Use the Gateway command 
setKDynamicText to send the text to this UMD.   

Third-party service:   See TSL, Andromeda, Encoda and Kalypso for an explanation of the 
services to use to get dynamic inputs for this Component. 

• In the “Dynamic Text” field, type the alias or the Long ID of the service used. 

• In the “Text Address” field, enter the address to associate with this Component. Valid values 
vary depending on the service used: 

• TSL: value range 1 to 127. 

• Andromeda : value range 1 to 256. 

• Encoda : value range 1 to 255 

• Kalypso : the range of values depends on the value entered in the “Level” field: 

• Level = 0, 1, 2, 3: range is 1-48 

• Level = 4: range  is 1-127  

• In the “Level” field, enter the level to associate with this Component. Valid values vary 
depending on the service used: 

• TSL: value can be any of 0, 1 or 2. 

• Andromeda : value range 0 to 14. 



• Encoda : not used 

• Kalypso: Enter the number of the option you wish to use for text display (value from 1 to 
4) 

• Level 0 to 3 implies that the "Text Address" represents a Kalypso device output. In that 
case the "Text Address" must range between 1 and 48.  

• 0: the label represents the initial background feed 

• 1: the label represents the initial and the previous background feed 

• 2: the label represents the previous background feed 

• 3: the label represents the current background feed 

• Level 4 implies that the "Text Address" represents a Kalypso device Source ID. In that 
case the "Text Address" must range between 1 and 128. 

• 4: the label represents the source id of the current background feed 

The Monitor Wall output of the Kaleido will show the text originating at that source. The on-line 
KEdit window will show the ID, Address and Level of the source. 

MultiData Text: 

Click the selection button to select MultiData text. Enter the name of a MultiData source in the 
data box.. 

• See MultiData Browser for a description of MultiData sources and their application in Kaleido.  

3.7 Tally 

3.7.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more Tallies to the current Layout. 

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard. 

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a Tally to an existing Monitor in the Layout: 



• Unlock the Monitor in which the Tally is located, by right-clicking and selecting Unlock Monitor 
from the contextual menu. The Monitor’s border will turn yellow, indicating it may be edited. 
You may also ALT-click anywhere in the Monitor, which will unlock the Monitor and select the 
item you clicked. 

• Select the Tally tool in the KEdit toolbar. Use the pull down arrow to change the current 
default Tally selection if necessary. 

• Click inside the Monitor, and drag to place a Tally of the desired size. 

Note that if the new Tally extends beyond the Monitor boundary, then it will not be part of the 
Monitor. 

Or add a Tally that is not part of a Monitor to the Layout: 

• Select the Tally tool in the KEdit toolbar. Use the pull down arrow to change the current 
default Tally selection if necessary. 

• Click at the appropriate place in the Layout, and drag to place a Tally of the desired size. 

Or copy an existing Tally, inside or outside a Monitor: 

• Select the Tally to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new Tally. 

- OR - 

• While holding CTRL, click on the Tally to be copied, and drag to a new location. The original 
Tally will remain, and a copy will appear at the new location. 

Note that if the new Tally extends beyond the Monitor boundary, then it will not be part of the 
Monitor. 

3.7.2 Configuration: 

The attributes of a Tally are adjustable using its Configuration Panel in KEdit. To access the 
panel for a Tally within a Monitor: 

1. Select the Tally using one of these methods: 

• Unlock the Monitor in which the Tally is located, by right-clicking and selecting Unlock 
Monitor from the contextual menu (an UNLOCKED Monitor is identified by a YELLOW 
BORDER and YELLOW RESIZING HANDLES  in its corners), and then click on the Tally 
to select it  

• ALT-click on the Tally. The monitor will unlock, and the Tally will be selected. 

NOTE: at this point the Tally may be positioned (click on the Tally and drag) and scaled (click 
and drag a control point) within the Monitor. It cannot be moved outside the Monitor 
boundary. 

2. Open the Configuration Panel for the Tally by pushing F5, or from the Configuration Panel 
item in the View menu 



Two tabs are available to set different parameters for the Tally. 



3.7.2.1 Offline Panels 

Assignment Tab 

Tally State Colors: 

Click the Select… button beside each of the four 
states to select the Tally colors that will represent that 
state. A Tally Colors selection box will appear, 
offering eleven options (bright and dark versions of 
five colors, plus invisible. You can also specify if the 
Tally will flash for all states. 

Tally Assignment: 

The pull-down list includes all available options. 
These are:  

• All of the available GPI inputs  

• All of the defined Alarms 

• None (i.e. unassigned) 

To configure a dynamic Tally from TSL, Andromeda, 
Kalypso or other services, you must create an Alarm 
Monitor and assign the Alarm Monitor to the Tally. 
See the section Alarms and Alarm Monitors. 

You can open the Alarm Monitor panel directly from 
this panel to create or edit alarms: 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Tally when the 
Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

The shape of the icon in the tally color window 
reflects the type of tally being configured (Left Tally in 
the example here), as the same Configuration Panel 
opens for all four types (top, bottom, left and right). 

Transparency: 

Use the slider to select a transparency for the Tally. 
The transparency is only seen when the Tally is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Channel: 

 

 



If this Tally is within a Monitor, the name of the 
assigned Channel will be shown, and the Link order 
box will be active. Enter the link order of the Tally 
data within the Channel that this Tally will display. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Tally is 
single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Tally is 
double-clicked using the mouse attached to the 
Kaleido-K2. 

 

3.7.2.2 Online Panels  (Kaleido-K2 only) 



Assignment Tab 

Tally State Colors:  

Click the Select… button beside each of the four 
states to select the Tally colors that will represent that 
state. A Tally Colors selection box will appear, 
offering eleven options (bright and dark versions of 
five colors, plus invisible. You can also specify if the 
Tally will flash for all states. 

Tally Assignment:  

The pull-down list includes all available options. 
These are:  

• All of the available GPI inputs  

• All of the defined alarms 

• None (i.e. unassigned) 

To configure a dynamic Tally from TSL, Andromeda, 
Kalypso or other services, you must create an Alarm 
Monitor and assign the Alarm Monitor to the Tally. 
See the section Alarms and Alarm Monitors. 

You can open the Alarm Monitor panel directly from 
this panel to create or edit alarms: 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Tally when the 
Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

The shape of the icon in the tally color window 
reflects the type of Tally being configured (Left Tally 
in the example here), as the same configuration 
panel opens for all four types (top, bottom, left and 
right). 

Transparency: 

Use the slider to select a transparency for the Tally. 
The transparency is only seen when the Tally is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Channel: 

 

 

 

 

 

 

 



If this Tally is within a Monitor, the name of the 
assigned Channel will be shown, and the Link order 
box will be active. Enter the link order of the Tally 
data within the Channel that this Tally will display. 

 

Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Tally is 
single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this Tally 
is double-clicked using the mouse attached to the 
Kaleido-K2. 

 

3.7.3 Operation 

3.7.3.1 Fire an Action 

Left-click on the Tally in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Tally in the Action pane of its 
Configuration Panel 



• Double-click fires the double-click Action configured for this Tally in the Action pane of its 
Configuration Panel 

3.8 Analog Clock 

3.8.1 Creation 

An Analog Clock cannot be included in a Monitor. 

To add an Analog Clock to a Layout: 

• Select the Clock tool in the KEdit toolbar. 

• Use the pull down arrow to change the current default Clock selection to Analog Clock if 
necessary (the available options are: analog clock, digital clock, and timer). 

• Click at the appropriate place in the Layout, and drag to place an Analog Clock of the desired 
size. 

3.8.2 Configuration: 

The attributes of an Analog Clock are adjustable using its Configuration Panel in KEdit. To access 
the panel for an Analog Clock: 

1. Click on the Analog Clock. Control points will appear at the corners and sides, showing it is 
selected. 

NOTE: at this point the Analog Clock may be positioned (click on the Analog Clock and drag) 
and scaled (click and drag a control point) within the Layout. 

2. Open the Configuration Panel for the Analog Clock by pushing F5, or from the Configuration 
Panel item in the View menu. 



3.8.2.1 Offline Panels 

Configuration Tab 

Select Clock Reference: 

Internal selects the Kaleido’s internal processor 
Clock, which can be set through the Windows Time 
and Date control panel. The local time zone can be 
selected in the pull-down list. 

External selects the time code input of the Kaleido. 

The LTC Calibration button is not active in the offline 
mode of operation. 

Select Time Offset: 

Set up an on-screen Clock that is offset from the time 
reference selected above by a specified amount in 
either direction. 

 



Appearance Tab 

Change the clock color setting: 

Background:  select the background color on the 
Clock face. Click the arrow beside the icon to open a 
color selection window to choose a different color. 

Scale:  select the color of the hours/minutes scale 
around the circumference of the Clock and the 
associated numerals. Click the arrow beside the icon 
to open a color selection window to choose a different 
color. 

Min/Hr Hands:  select the color of the minute and 
hour hands on the Clock face. 

Sec Hand:  select the color of the second hand on the 
Clock face. 

Transparency: 

Use the slider to select a transparency for the Clock. 
The transparency is only seen when the Clock is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Border:  

Select whether the Clock displayed on the Kaleido 
monitor wall output will have no border, or a lowered 
bevel border: 

• None - no border is shown. 

• Lowered Bevel - shows a border with a beveled 
profile. 

 

 

 

 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
double-clicked using the mouse attached to the 
Kaleido-K2. 

 

3.8.2.2 Online Panels  (Kaleido-K2 only) 



Configuration Tab 

Select Clock Reference: 

Internal selects the Kaleido’s internal processor 
Clock, which can be set through the Windows Time 
and Date control panel. The local time zone can be 
selected in the pull-down list. 

External selects the time code input of the Kaleido. 

LTC Calibration: 

Click the LTC Calibration button to open the LTC 
Delay Compensation control panel. This panel allows 
you to apply a correction to the time code to 
compensate for the delay it encounters while passing 
through the Kaleido system, so that the displayed 
LTC matches the incoming LTC. 

The default delay is 5 frames.  

The Custom Delay could range between 0 and 15 
frames 

To set the appropriate value, display the incoming 
LTC on a time code reader, and visually compare it to 
the LTC displayed at the Kaleido output. 

Note: this offset has an impact on the accuracy of a 
Timer trigger action 

Select Time Offset: 

Set up an on-screen Clock that is offset from the time 
reference selected above by a specified amount in 
either direction. 

 

 



Appearance Tab 

Change the Clock color setting: 

Background:  select the background color on the 
Clock face. Click the arrow beside the icon to open a 
color selection window to choose a different color. 

Scale:  select the color of the hours/minutes scale 
around the circumference of the Clock and the 
associated numerals. Click the arrow beside the icon 
to open a color selection window to choose a different 
color. 

Min/Hr Hands:  select the color of the minute and 
hour hands on the Clock face. 

Sec Hand:  select the color of the second hand on the 
Clock face. 

Transparency: 

Use the slider to select a transparency for the Clock. 
The transparency is only seen when the Clock is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Border: 

Select whether the Clock displayed on the Kaleido 
monitor wall output will have no border, or a lowered 
bevel border: 

Select the format of the border around the screen: 

• None - no border is shown. 

• Lowered Bevel - shows a border with a beveled 
profile. 

 

 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
double-clicked using the mouse attached to the 
Kaleido-K2. 

 

3.8.3 Operation 

3.8.3.1 Fire an Action 

Left-click on the Analog Clock in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Analog Clock in the Action pane of 
its Configuration Panel 

• Double-click fires the double-click Action configured for this Analog Clock in the Action pane 
of its Configuration Panel 

3.9 Digital Clock 

3.9.1 Creation 

A Digital Clock cannot be included in a Monitor. 

To add a Digital Clock to a Layout: 

• Select the Clock tool in the KEdit toolbar. 

• Use the pull down arrow to change the current default Clock selection to Digital Clock if 
necessary (the available options are: analog clock, digital clock, and timer). 



• Click at the appropriate place in the Layout, and drag to place a Clock of the desired size. 

3.9.2 Configuration: 

The attributes of a Digital Clock are adjustable using its Configuration Panel in KEdit. To access 
the panel for a Digital Clock: 

1. Click on the Digital Clock. Control points will appear at the corners and sides, showing it is 
selected.  

NOTE: at this point the Digital Clock may be positioned (click on the Digital Clock and drag) 
and scaled (click and drag a control point) within the Layout. 

2. Open the Configuration Panel for the Digital Clock by pushing F5, or from the Configuration 
Panel item in the View menu 



3.9.2.1 Offline Panels 

Configuration Tab 

Select Clock Reference: 

Internal selects the Kaleido’s internal processor 
Clock, which can be set through the Windows Time 
and Date control panel. The local time zone can be 
selected in the pull-down list. 

External selects the time code input of the Kaleido. 

The LTC Calibration button is not active in the offline 
mode of operation. 

Select Time Offset: 

Set up an on-screen Clock that is offset from the time 
reference selected above by a specified amount in 
either direction. 

 

 



Appearance Tab 

Change the clock color setting: 

Background:  select the background color on the 
Clock face. Click the arrow beside the icon to open a 
color selection window to choose a different color. 

Digits:  select the color of the digits displayed by the 
Clock. Click the arrow beside the icon to open a color 
selection window to choose a different color. 

Clock display: 

Use the radio buttons to select the digital clock 
display format: 

• 12 hour with AM/PM indicator 

• 24 hour. 

Transparency: 

Use the slider to select a transparency for the Clock. 
The transparency is only seen when the clock is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Border: 

Select whether the Clock displayed on the Kaleido 
monitor wall output will have no border, or a lowered 
bevel border. 

Note:  the display font for this digital clock can be 
changed using the font selector pulldown in the KEdit 
toolbar. The font size is automatically scaled to fit the 
component, so the size pulldown is disabled. 

 

 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
double-clicked using the mouse attached to the 
Kaleido-K2. 

 

3.9.2.2 Online Panels  (Kaleido-K2 only) 



Configuration Tab 

Select Clock Reference: 

Internal selects the Kaleido’s internal processor clock, 
which can be set through the Windows Time and 
Date control panel. The local time zone can be 
selected in the pull-down list. 

External selects the time code input of the Kaleido. 

LTC Calibration: 

Click the LTC Calibration button to open the LTC 
Delay Compensation control panel. This panel allows 
you to apply a correction to the time code to 
compensate for the delay it encounters while passing 
through the Kaleido system, so that the displayed 
LTC matches the incoming LTC. 

The default delay is 5 frames.  

The Custom Delay could range between 0 and 15 
frames 

To set the appropriate value, display the incoming 
LTC on a time code reader, and visually compare it to 
the LTC displayed at the Kaleido output. 

Note: this offset has an impact on the accuracy of a 
Timer trigger action 

Select Time Offset: 

Set up an on-screen clock that is offset from the time 
reference selected above by a specified amount in 
either direction. 

 

 



Appearance Tab 

Change the Clock color setting: 

Background:  select the background color on the 
Clock face. Click the arrow beside the icon to open a 
color selection window to choose a different color. 

Digits:  select the color of the digits displayed by the 
Clock. Click the arrow beside the icon to open a color 
selection window to choose a different color. 

Clock display: 

Use the radio buttons to select the digital clock 
display format: 

• 12 hour with AM/PM indicator 

• 24 hour. 

Transparency: 

Use the slider to select a transparency for the Clock. 
The transparency is only seen when the Clock is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

Border: 

Select whether the Clock displayed on the Kaleido 
monitor wall output will have no border, or a lowered 
bevel border. 

Note:  the display font for this digital clock can be 
changed using the font selector pulldown in the KEdit 
toolbar. The font size is automatically scaled to fit the 
component, so the size pulldown is disabled. 

 

 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
single-clicked using the mouse attached to the 
Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Clock is 
double-clicked using the mouse attached to the 
Kaleido-K2. 

 

3.9.3 Operation (Digital clock) 

3.9.3.1 Fire an Action 

Left-click on the Digital Clock in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Digital Clock in the Action pane of 
its Configuration Panel 

• Double-click fires the double-click Action configured for this Digital Clock in the Action pane of 
its Configuration Panel 

3.10 Count Down Timer 

3.10.1 Creation 

A Count Down Timer cannot be included in a Monitor. 

To add a Count Down Timer to a Layout: 

• Select the Clock tool in the KEdit toolbar. 

• Use the pull down arrow to change the current default Clock selection to Count Down Timer if 
necessary (the available options are: Analog Clock, Digital Clock, and Count Down Timer). 



• Click at the appropriate place in the Layout, and drag to place a Count Down Timer of the 
desired size 

3.10.2 Configuration: 

The attributes of a Count Down Timer are adjustable using its Configuration Panel in KEdit. To 
access the panel for a Count Down Timer: 

1. Click on the Count Down Timer. Control points will appear at the corners and sides, showing 
it is selected.  

NOTE: at this point the Count Down Timer may be positioned (click on the Count Down Timer 
and drag) and scaled (click and drag a control point) within the Layout. 

2. Open the Configuration Panel for the Count Down Timer by pushing F5, or from the 
Configuration Panel item in the View menu. 



3.10.2.1 Offline Panels 

Configuration Tab 

Set Timer Name: 

From the pulldown list, select one of the available 
Timers as the source of data for this Count Down 
Timer.  

• Click New to open the Timer Configuration panel 
to configure a new Timer. 

• You may modify the selected Timer’s 
configuration by clicking Edit to access its 
Configuration panel 

Note that the Timer Configuration panel is also 
accessible from the Timer Browser via the View 
menu. 

The selected Timer can be operated using Gateway 
commands for precision timing applications. 

 

 



Appearance Tab 

Change the Timer Color Setting 

The color patch below the Background icon shows 
the current background color. 

• Click on the arrow beside the Background icon to 
open a color selection palette to select a new 
color for the background. Click on the new color 
to select it and close the palette. 

The color patch below the Digit icon shows the 
current color of the timer’s numbers. 

• Click on the arrow beside the Digit icon to open a 
color selection palette to select a new color for 
the numbers. Click on the new color to select it 
and close the palette. 

Lick the Apply button at the bottom of the control 
panel to apply these selections to the timer. 

Transparency: 

Use the slider to select a transparency for the Count 
Down Timer. The transparency is only seen when the 
Count Down Timer is overlaid on a Video Screen. 
The selected value is shown as a percentage 
beneath the slider. Possible values are 0, 15, 30, 45, 
55, 70, 85 and 100%. 

Note:  the display font for this Count Down Timer can 
be changed using the font selector pulldown in the 
KEdit toolbar. The font size is automatically scaled to 
fit the component, so the size pulldown is disabled. 

 

 

 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Count 
Down Timer is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Count 
Down Timer is double-clicked using the mouse 
attached to the Kaleido-K2. 

 

 

3.10.2.2 Online Panels  (Kaleido-K2 only) 



Configuration Tab 

Set Timer Name: 

From the pulldown list, select one of the available 
Timers as the source of data for this Count Down 
Timer.  

• You may modify the selected Timer’s 
configuration by clicking Edit 

Click New to open the Timer Configuration panel to 
configure a new Timer. Note that the Timer 
Configuration panel is also accessible from the Timer 
Browser via the View menu. 

The selected Timer can be operated using Gateway 
commands for precision timing applications. 

 



Appearance Tab 

Change the Timer Color Setting 

The color patch below the Background icon shows 
the current background color. 

• Click on the arrow beside the Background icon to 
open a color selection palette to select a new 
color for the background. Click on the new color 
to select it and close the palette. 

The color patch below the Digit icon shows the 
current color of the timer’s numbers. 

• Click on the arrow beside the Digit icon to open a 
color selection palette to select a new color for 
the numbers. Click on the new color to select it 
and close the palette. 

Lick the Apply button at the bottom of the control 
panel to apply these selections to the timer. 

Transparency: 

Use the slider to select a transparency for the Count 
Down Timer. The transparency is only seen when the 
Count Down Timer is overlaid on a Video Screen. 
The selected value is shown as a percentage 
beneath the slider. Possible values are 0, 15, 30, 45, 
55, 70, 85 and 100%. 

Note:  the display font for this Count Down Timer can 
be changed using the font selector pulldown in the 
KEdit toolbar. The font size is automatically scaled to 
fit the component, so the size pulldown is disabled. 

 

 

 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Count 
Down Timer is single-clicked using the mouse 
attached to the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Count 
Down Timer is double-clicked using the mouse 
attached to the Kaleido-K2. 

 

 

3.10.3 Operation 

3.10.3.1 Operation via the Gateway 

Count Down Timers display the data originating from a Timer. A Timer should be operated using 
Gateway commands if precision timing is required. These commands can originate from an 
automation system. See the discussion under Timer Browser for a detailed description. 

3.10.3.2 Fire an Action 

Left-click on the Count Down Timer in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Count Down Timer in the Action 
pane of its Configuration Panel. 

• Double-click fires the double-click Action configured for this Count Down Timer in the Action 
pane of its Configuration Panel  

3.10.3.3 Time Set and Start 

If the Count Down Timer has been configured with the Timer Set and Start Action as its single-
click or double-click Action, then left-clicking or left-double-clicking as appropriate will start the 
Count Down Timer with the preset value and count direction for which it was configured. 



3.10.3.4 Timer Pause 

If the Count Down Timer has been configured with the Timer Pause Action as its single-click or 
double-click Action, then left-clicking or left-double-clicking as appropriate will pause the Timer. 

3.11 Video Time Code 

3.11.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more Video Time Code viewers to 
the current Layout. 

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard  

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a Video Time Code viewer to an existing Monitor in the Layout: 

• Unlock the Monitor in which the Video Time Code viewer will be located, by right-clicking and 
selecting Unlock Monitor from the contextual menu.. The Monitor’s border will turn yellow, 
indicating it may be edited. You may also ALT-click anywhere in the Monitor, which will 
unlock the Monitor and select the item you clicked. 

• Select the Video Time Code tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a Video Time Code viewer of the desired size. 

Note that if the new Video Time Code viewer extends beyond the Monitor boundary, then it will 
not be part of the Monitor. 

Or add a Video Time Code viewer that is not part of a Monitor to the Layout: 

• Select the Video Time Code tool in the KEdit toolbar. 

• Click at the appropriate place in the layout, and drag to place a Video Time Code viewer of 
the desired size. 

Or copy an existing Video Time Code viewer, inside or outside a Monitor: 

• Select the Video Time Code viewer to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new Video Time Code 
viewer. 



- OR - 

• While holding CTRL, click on the Video Time Code viewer to be copied, and drag to a new 
location. The original Video Time Code viewer will remain, and a copy will appear at the new 
location. 

Note that if the new Video time Code viewer extends beyond the Monitor boundary, then it will not 
be part of the Monitor. 

3.11.2 Configuration: 

The attributes of a Video Time Code viewer are adjustable using its Configuration Panel in KEdit. 
To access the panel for a Video Time Code viewer within a Monitor: 

1. Select the Video Time Code viewer using one of these methods: 

• Unlock the Monitor in which the Video Time Code viewer is located, by right-clicking and 
selecting Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified 
by a YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then 
click on the Video Time Code viewer to select it  

• ALT-click on the Video Time Code viewer. The monitor will unlock, and the viewer will be 
selected. 

NOTE: at this point the Video Time Code viewer may be positioned (click on the Video Time 
Code viewer and drag) and scaled (click and drag a control point) within the Monitor. It cannot 
be moved outside the Monitor boundary. 

2. Open the Configuration Panel for the Video Time Code viewer by pushing F5, or from the 
Configuration Panel item in the View menu. 



3.11.2.1 Offline Panels 

Assignment Tab 

Assign the video source: 

Enter the number of the Kaleido video input that is 
carrying the embedded time code [enter a number 
between 1 and 32]. 

Channel: If this time code is within a Monitor, the 
name of the assigned Channel will be shown, and the 
Link order box will be active. Enter the link order of 
the time code data within the Channel that this Video 
Time Code will display. 

 



Appearance Tab 

Change the display settings:  

Background:  select the background color on the 
Time Code Viewer display. Click the arrow beside the 
icon to open a color selection window to choose a 
different color. 

Digits:  select the color of the digits displayed by the 
Time Code Viewer. Click the arrow beside the icon to 
open a color selection window to choose a different 
color. 

Transparency:  

Use the slider to select a transparency for the Time 
Code Viewer. The transparency is only seen when 
the Time Code Viewer is overlaid on a Video Screen. 
The selected value is shown as a percentage 
beneath the slider. Possible values are 0, 15, 30, 45, 
55, 70, 85 and 100%. 

Border:  

Select whether the Time Code Viewer displayed on 
the Kaleido monitor wall output will have no border, or 
a lowered bevel border: 

• None - no border is shown. 

• Lowered Bevel - shows a border with a beveled 
profile. 

 



Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Time Code 
Viewer is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Time Code 
Viewer is double-clicked using the mouse attached to 
the Kaleido-K2. 

 

3.11.2.2 Online Panels  (Kaleido-K2 only) 



Assignment Tab 

Assign the video source: 

Enter the number of the Kaleido video input that is 
carrying the embedded time code [enter a number 
between 1 and 32]. 

Channel: 

If this time code is within a Monitor, the name of the 
assigned channel will be shown, and the Link order 
box will be active. Enter the link order of the time 
code data within the Channel that this Video Time 
Code will display. 

 

Appearance Tab 

Change the display settings: 

Background:  select the background color on the 
Video Time Code display. Click the arrow beside the 
icon to open a color selection window to choose a 
different color. 

Digits:  select the color of the digits displayed by the 
Video Time Code. Click the arrow beside the icon to 
open a color selection window to choose a different 
color. 

Transparency: 

Use the slider to select a transparency for the Video 
Time Code. The transparency is only seen when the 
Video Time Code is overlaid on a Video Screen. The 
selected value is shown as a percentage beneath the 
slider. Possible values are 0, 15, 30, 45, 55, 70, 85 
and 100%. 

Border: 

Select whether the Video Time Code displayed on the  



Kaleido monitor wall output will have no border, or a 
lowered bevel border: 

• None - no border is shown. 

• Lowered Bevel - shows a border with a beveled 
profile. 

Action Tab 

Assign Actions 

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Video Time 
Code is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Video Time 
Code is double-clicked using the mouse attached to 
the Kaleido-K2. 

 

3.11.3 Operation 

3.11.3.1 Fire an Action 

Left-click on the Video Time Code viewer in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Video Time Code viewer in the 
Action pane of its Configuration Panel. 

• Double-click fires the double-click Action configured for this Video Time Code viewer in the 
Action pane of its Configuration Panel. 

3.12 Status Indicator 

3.12.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more Status Indicators to the current 
Layout. 



1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard. 

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a Status Indicator to an existing Monitor in the Layout: 

• Unlock the Monitor by right-clicking it and selecting Unlock Monitor from the contextual menu. 
The Monitor’s border will turn yellow, indicating it may be edited. You may also ALT-click 
anywhere in the Monitor, which will unlock the Monitor and select the item you clicked. 

• Select the Status Indicator tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a Status Indicator of the desired size. 

Note that if the new Status Indicator extends beyond the Monitor boundary, then it will not be part 
of the Monitor. 

Or add a Status Indicator that is not part of a Monitor to the Layout: 

• Select the Status Indicator tool in the KEdit toolbar. 

• Click at the appropriate place in the layout, and drag to place a Status Indicator of the desired 
size 

Or copy an existing Status Indicator, inside or outside a Monitor: 

• Select the Status Indicator to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new Status Indicator. 

- OR - 

• While holding CTRL, click on the Status Indicator to be copied, and drag to a new location. 
The original Status Indicator will remain, and a copy will appear at the new location. 

Note that if the new Status Indicator extends beyond the Monitor boundary, then it will not be part 
of the Monitor. 

3.12.2 Configuration: 

The attributes of a Status Indicator are adjustable using its configuration panel in KEdit. To 
access the panel for a Status Indicator within a Monitor: 

1. Select the Status Indicator using one of these methods: 



• Unlock the Monitor in which the Status Indicator is located, by right-clicking and selecting 
Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified by a 
YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then click on 
the Status Indicator to select it  

• ALT-click on the Status Indicator. The monitor will unlock, and the Status Indicator will be 
selected. 

NOTE: at this point the Status Indicator may be positioned (click on the Status Indicator and 
drag) and scaled (click and drag a control point) within the Monitor. The Status Indicator will 
maintain its proportions when scaled. It cannot be moved outside the Monitor boundary. 

2. Open the configuration panel for the Status Indicator by pushing F5, or from the Configuration 
Panel item in the View menu. 



3.12.2.1 Offline Panels 

Alarm Tab 

Icon Selection: 

Four different icons can be selected for each status 
indicator, corresponding to Disable, Normal, Warning 
and Error conditions. The current selection is shown. 
Clicking on the Select… box opens a selection screen 
where a variety of possible icons are shown. Click on 
an appropriate icon to select it; the selection screen 
closes automatically.  

The Status Indicator can be made to flash under Error 
and Warning conditions. Click on the Flashing 
checkbox to turn flashing mode on or off. 

Assign Alarm Monitor: 

Select one of the available Alarms from the pull-down 
list to assign it to this Status Indicator. 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Status Indicator 
when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

Error Latching: 

• Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status will be indicated by a colored 
border surrounding the Status Indicator, while the 
Indicator itself will continue to display the current 
status. 

Transparency: 
Use the slider to select a transparency for the Status 
Indicator. The transparency is only seen when the 
Status Indicator is overlaid on a Video Screen. The 
selected value is shown as a percentage beneath the 
slider. Possible values are 0, 15, 30, 45, 55, 70, 85 
and 100%. 

 



Channel: 

If this Status Indicator is within a Monitor, the name of 
the assigned Channel will be shown, and the Link 
order box will be active, showing the current link order 
of the Alarm within the Channel displayed by this 
Monitor. Enter a new value if desired. 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Status 
Indicator is single-clicked using the mouse attached 
to the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Status 
Indicator is double-clicked using the mouse attached 
to the Kaleido-K2. 

 

3.12.2.2 Online Panels  (Kaleido-K2 only) 



Alarm Tab 

Icon Selection: 

Four different icons can be selected for each Status 
Indicator, corresponding to Disable, Normal, Warning 
and Error conditions. The current selection is shown. 
Clicking on the Select… box opens a selection screen 
where a variety of possible icons are shown. Click on 
an appropriate icon to select it; the selection screen 
closes automatically. 

The Status Indicator can be made to flash under Error 
and Warning conditions. Click on the Flashing 
checkbox to turn flashing mode on or off. 

Assign Alarm Monitor: 

Select one of the available Alarm Monitor from the 
pull-down list to assign it to this Status Indicator. 

New:   open the Alarm Monitor panel to create a new 
alarm, which will be assigned to this Status Indicator 
when the Alarm Monitor panel is closed. 

Edit:   open the Alarm Monitor panel  to edit the alarm 
selected in the pull-down list. Grayed-out if “none” is 
selected. 

Error Latching: 

• Use these controls to keep the Alarm on after the 
error has passed, to make detection of transient 
errors easier. 

• No Latch – do not latch the error.  

• Latch – hold the Alarm on indefinitely. 

• Hold – hold the Alarm on for the duration 
specified in the box. 

The latched status will be indicated by a colored 
border surrounding the Status Indicator, while the 
Indicator itself will continue to display the current 
status. 

Transparency: 
Use the slider to select a transparency for the Status 
Indicator. The transparency is only seen when the 
Status Indicator is overlaid on a Video Screen. The 
selected value is shown as a percentage beneath the 
slider. Possible values are 0, 15, 30, 45, 55, 70, 85 

 



and 100%. 

Channel: 

If this Status Indicator is within a Monitor, the name of 
the assigned Channel will be shown, and the Link 
order box will be active, showing the current link order 
of the Alarm within the Channel displayed by this 
Monitor. Enter a new value if desired. 

Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Status 
Indicator is single-clicked using the mouse attached 
to the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Status 
Indicator is double-clicked using the mouse attached 
to the Kaleido-K2. 

 

3.12.3 Operation 

3.12.3.1 Fire an Action 

Left-click on the Status Indicator in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Status Indicator in the Action pane 
of its Configuration Panel. 

• Double-click fires the double-click Action configured for this Status Indicator in the Action 
pane of its Configuration Pane. 

3.12.3.2 Unlatch Error Status 

Right-click on the Status Indicator in the Kaleido display using the mouse, and select Unlatch 
Error Status. The Status Indicator’s error detection will be unlatched. 



3.13 Alarm Group Inhibit Button 

3.13.1 Creation: 

An Alarm Group Inhibit Button cannot be included in a Monitor. 

To add an Alarm Group Inhibit Button to a Layout: 

• Select the Alarm Group Inhibit Button tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Alarm Group Inhibit Button of 
the desired size. 

3.13.2 Configuration: 

The attributes of an Alarm Group Inhibit Button are adjustable using its configuration panel in 
KEdit. To access the panel for an Alarm Group Inhibit Button: 

1. Click on the Alarm Group Inhibit Button. Control points will appear at the corners and the 
center of the long side, showing it is selected.  

NOTE: at this point the Alarm Group Inhibit Button may be positioned (click on the Alarm 
Group Inhibit Button and drag) and scaled (click and drag a control point) within the Layout. 

2. Open the Configuration Panel for the Alarm Group Inhibit Button by pushing F5, or from the 
Configuration Panel item in the View menu 



3.13.2.1 Offline Panel 

Configuration Tab 

Alarm Inhibit Group 

From the pull down list, select the Alarm Group that 
will be controlled by this button. 

Transparency 

Use the slider to select a transparency for the Alarm 
Group Inhibit Button. The transparency is only seen 
when the button is overlaid on a Video Screen. The 
selected value is shown as a percentage beneath the 
slider. Possible values are 0, 15, 30, 45, 55, 70, 85 
and 100%. 

 

3.13.2.2 Online Panel  (Kaleido-K2 only) 



Configuration Tab 

Alarm Inhibit Group 

From the pull down list, select the Alarm Group that 
will be controlled by this button. 

Transparency 

Use the slider to select a transparency for the Alarm 
Group Inhibit Button. The transparency is only seen 
when the button is overlaid on a Video Screen. The 
selected value is shown as a percentage beneath the 
slider. Possible values are 0, 15, 30, 45, 55, 70, 85 
and 100%. 

 

3.13.3 Operation 

3.13.3.1 Toggle the Alarm Group status 

Left-click on the Alarm Group Inhibit Button in the Kaleido display using the mouse. 

The Alarm Group Inhibit Button toggles the status of its associated Alarm Group between 
Enabled and Disabled modes. The current status is always indicated by the on-screen icon, 
which names the associated Alarm Group, and shows the status by the brightness of the “Button” 
within the icon: 

 
The “Montréal” Alarm Group is ENABLED 

 
The “Montréal” Alarm Group is DISABLED 

3.14 MPEG Monitor 
 

 NOTE:  No sources of information for this element are supported in the current release. 

All references to the PixelMetrix DV Station refer to earlier versions of this software 



3.14.1 Creation: 

An MPEG Monitor cannot be included in a Monitor. 

To add an MPEG Monitor to a Layout: 

• Select the MPEG Monitor tool in the KEdit toolbar. Use the pull down arrow to change the 
current default MPEG Monitor type selection if necessary (select between stack chart, pie 
chart and bar graph). 

• Click at the appropriate place in the layout, and drag to place an MPEG Monitor of the 
desired size. 

Note: The MPEG data displayed by the MPEG Monitor originates on the PixelMetrix DV Station. 

3.14.2 Configuration: 

The attributes of an MPEG Monitor are adjustable using its configuration panel in KEdit. To 
access the panel for an MPEG Monitor: 

1. Click on the MPEG Monitor. Control points will appear at the corners and the center of the 
long side, showing it is selected. 

NOTE: at this point the MPEG Monitor may be positioned (click on the MPEG Monitor and 
drag) and scaled (click and drag a control point) within the Layout. 

2. Open the Configuration Panel for the MPEG Monitor by pushing F5, or from the Configuration 
Panel item in the View menu. 



3.14.2.1 Offline Panels 

Assignment Tab 

Assign Service ID 

The service ID is the Miranda long ID of the 
PixelMetrix analyzer, or an alias, which has been 
installed in the file C:\iControl\ Startup\KG2Config.xml 
(see PixelMetrix MPEG Analyzer for details). 

Chart Type 

The PixelMetrix MPEG analyzer can display the 
analysis results in any of three formats. Click on the 
appropriate button to select the desired format. 

Display Option 

Time Length is enabled only for the Stacked Area 
Chart option, and defines the time period over which 
the results are calculated (i.e. the previous 30 
seconds in the above sample chart). 

Background Color selects the color of the chart 
background when it is displayed on the Kaleido 
monitor wall output. 

 

3.14.2.2 Online Panels  (Kaleido-K2 only) 



Assignment Tab 

Assign Service ID 

The service ID is the Miranda long ID of the 
PixelMetrix analyzer, or an alias, which has been 
installed in the file C:\iControl\ Startup\KG2Config.xml 
(see PixelMetrix MPEG Analyzer for details). 

Chart Type 

The PixelMetrix MPEG analyzer can display the 
analysis results in any of three formats. Click on the 
appropriate button to select the desired format. 

Display Option 

Time Length is enabled only for the Stacked Area 
Chart option, and defines the time period over which 
the results are calculated (i.e. the previous 30 
seconds in the above sample chart). 

Background Color selects the color of the chart 
background when it is displayed on the Kaleido 
monitor wall output. 

 

3.14.3 Operation 

There are no operational features that can be controlled on-line for an MPEG Monitor. 

3.15 MPEG Service Info 
 

 NOTE:  No sources of information for this element are supported in the current release. 

All references to the PixelMetrix DV Station refer to earlier versions of this software 

3.15.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more MPEG Service Info viewers to 
the current Layout.  

3. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard. 



4. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

5. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a MPEG Service Info viewer to an existing Monitor in the Layout: 

• Unlock the Monitor by right-clicking it and selecting Unlock Monitor from the contextual menu. 
The Monitor’s border will turn yellow, indicating it may be edited. You may also ALT-click 
anywhere in the Monitor, which will unlock the Monitor and select the item you clicked. 

• Select the MPEG Service Info tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a MPEG Service Info viewer of the desired size. 

Note that if the new MPEG Service Info viewer extends beyond the Monitor boundary, then it will 
not be part of the Monitor. 

Or add a MPEG Service Info viewer that is not part of a Monitor to the Layout: 

• Select the MPEG Service Info tool in the KEdit toolbar. 

• Click at the appropriate place in the layout, and drag to place a MPEG Service Info viewer of 
the desired size. 

Or copy an existing MPEG Service Info viewer, inside or outside a Monitor: 

• Select the MPEG Service Info viewer to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new MPEG Service 
Info viewer. 

- OR - 

• While holding CTRL, click on the MPEG Service Info viewer to be copied, and drag to a new 
location. The original MPEG Service Info viewer will remain, and a copy will appear at the 
new location. 

Note that if the new MPEG Service Info viewer extends beyond the Monitor boundary, then it will 
not be part of the Monitor. 

3.15.2 Configuration: 

The attributes of an MPEG Service Info viewer are adjustable using its Configuration Panel in 
KEdit. To access the panel for an MPEG Service Info viewer within a Monitor: 

1. Select the MPEG Service Info viewer using one of these methods: 

• Unlock the Monitor in which the MPEG Service Info viewer is located, by right-clicking and 
selecting Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified 
by a YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then 
click on the MPEG Service Info viewer to select it  



• ALT-click on the MPEG Service Info viewer. The monitor will unlock, and the MPEG 
Service Info viewer will be selected. 

NOTE: at this point the MPEG Service Info viewer may be positioned (click on the MPEG 
Service Info viewer and drag) and scaled (click and drag a control point) within the Monitor. It 
cannot be moved outside the Monitor boundary. 

2. Open the Configuration Panel for the MPEG Service Info viewer by pushing F5, or from the 
Configuration Panel item in the View menu. 



3.15.2.1 Offline Panels 

Assignment Tab 

Assign Service ID: 

The service ID is the Miranda long ID of the 
PixelMetrix analyzer, or its alias, in the file C:\iControl\ 
Startup\KG2Config.xml (see PixelMetrix MPEG 
Analyzer). 

Assign Logical Service Name: 

Enter the name assigned on the PixelMetrix analyzer 
to the service you wish to monitor. See the 
PixelMetrix manual for details. 

Display Options: 

Select any number of these three display options. 

• Show Logical Service Info:  Shows the name of 
the program e.g. the PID and the bandwidth. 

• Show Bandwidth Usage in Percentage:  if this 
box is checked, the bandwidth used by this 
particular MPEG stream will be shown as a 
percentage of the total available bandwidth. 

If the box is unchecked, the actual bandwidth 
used by this MPEG stream will be shown, 
nominally in Mbits/sec. 

• Optimize Units of Measurement:  If the actual 
bandwidth is being shown (i.e. the above box is 
unchecked), then checking this box will adjust the 
units of the displayed value to produce a more 
readable display, e.g. instead of .00434 MB/s, it 
will show 4.34 KB/s. 

Channel: 

If this MPEG Service Info indicator is within a Monitor, 
the name of the assigned Channel will be shown, and 
the Link order box will be active, showing the current 
link order of the MPEG service within the Channel 
displayed by this Monitor. Enter a new value if 
desired. 

 

3.15.2.2 Online Panels  (Kaleido-K2 only) 



Assignment Tab 

Assign Service ID: 

The service ID is the Miranda long ID of the 
PixelMetrix analyzer, or its alias, in the file 
C:\iControl\ Startup\KG2Config.xml (see PixelMetrix 
MPEG Analyzer). 

Assign Logical Service Name: 

Enter the name assigned on the PixelMetrix analyzer 
to the service you wish to monitor. See the 
PixelMetrix manual for details. 

Display Options: 

Select any number of these three display options: 

• Show Logical Service Info:  Shows the name of 
the program e.g. the PID and the bandwidth. 

• Show Bandwidth Usage in Percentage:  if this 
box is checked, the bandwidth used by this 
particular MPEG stream will be shown as a 
percentage of the total available bandwidth. 

If the box is unchecked, the actual bandwidth 
used by this MPEG stream will be shown, 
nominally in Mbits/sec. 

• Optimize Units of Measurement:  If the actual 
bandwidth is being shown (i.e. the above box is 
unchecked), then checking this box will adjust the 
units of the displayed value to produce a more 
readable display, e.g. instead of .00434 MB/s, it 
will show 4.34 KB/s. 

Channel: 

If this MPEG Service Info indicator is within a 
Monitor, the name of the assigned Channel will be 
shown, and the Link order box will be active, showing 
the current link order of the MPEG service within the 
Channel displayed by this Monitor. Enter a new value 
if desired. 

 

3.15.3 Operation 

There are no operational features that can be controlled on-line for an MPEG Service Info 
display. 



3.16 Streaming Viewer 

3.16.1 Creation: 

A Streaming Viewer cannot be included in a Monitor. 

To add a Streaming Viewer to a Layout: 

• Select the Streaming Viewer tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Streaming Viewer of the 
desired size. 

3.16.2 Configuration: 

The attributes of a Streaming Viewer are adjustable using its Configuration Panel in KEdit. To 
access the panel for a Streaming Viewer: 

1. Click on the Streaming Viewer. Control points will appear at the corners and the center of the 
long side, showing it is selected. 

NOTE: at this point the Streaming Viewer may be positioned (click on the Streaming Viewer 
and drag) and scaled (click and drag a control point) within the Layout. 

2. Open the Configuration Panel for the Streaming Viewer by pushing F5, or from the 
Configuration Panel item in the View menu. 



3.16.2.1 Offline Panels 

Assignment Tab 

RTP: 

The streaming video source may be an Allegro1 
Encoder, or an encoder embodied in a Miranda 
Densité Probe producing thumbnail images of the 
signal it is monitoring. Kaleido accesses the source 
using an address of the form 
RTSP://ip_address/feedid.  

In this panel, enter the two components of the 
address separately. 

IP Address:  Specify the IP address of the streaming 
video source. 

• If the source is an Allegro1 encoder, the IP 
address is that of the encoder itself. 

If the source is a Densité probe, the IP address is that 
of the Miranda Application Server that is controlling 
the Densité frame. 

Feed ID:  Identify which of several possible feeds is to 
be displayed 

• If the source is an Allegro1 encoder, give the 
number of the channel in the data stream, in the 
format C1, C2, etc. 

• If the source is a Densité probe, give the LongID 
of the Densité frame and card (see How To 
Display thumbnails or streaming video on the 
Kaleido-K2?). 

Display Options: 

Clicking the Restore Native Resolution button will 
change the size of the Streaming Viewer to be of the 
native size (pixels) of the current stream. If no stream 
is available, this has no effect. 

 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Streaming 
Viewer is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, select 
the Action that will be executed when this Streaming 
Viewer is double-clicked using the mouse attached to 
the Kaleido-K2. 

 



Appearance Tab 

Transparency  

Use the slider to select a transparency for the 
Streaming Viewer. The transparency is only seen 
when the Streaming Viewer is overlaid on a Video 
Screen. The selected value is shown as a percentage 
beneath the slider. Possible values are 0, 15, 30, 45, 
55, 70, 85 and 100%. 

Border 

The appearance of the Streaming Viewer at the 
Kaleido-K2 output can be enhanced by adding a 
frame, which creates the appearance of depth. This 
frame does not appear in the KEdit rendition of the 
Layout. Select the format of the frame around the 
screen: 

• None - no frame is shown. 

• Lowered Bevel - shows a frame with a beveled 
profile as a graphic effect at the Kaleido-K2 
output. 

  

3.16.2.2 Online Panels  (Kaleido-K2 only) 



Assignment Tab 

RTP:  

The streaming video source may be an Allegro1 
Encoder, or an encoder embodied in a Miranda 
Densité Probe producing thumbnail images of the 
signal it is monitoring. Kaleido accesses the source 
using an address of the form 
RTSP://ip_address/feedid. 

In this panel, enter the two components of the 
address separately. 

IP Address:  Specify the IP address of the streaming 
video source. 

• If the source is an Allegro1 encoder, the IP 
address is that of the encoder itself. 

• If the source is a Densité probe, the IP address is 
that of the Miranda Application Server that is 
controlling the Densité frame. 

Feed ID:  Identify which of several possible feeds is 
to be displayed. 

• If the source is an Allegro1 encoder, give the 
number of the channel in the data stream, in the 
format C1, C2, etc. 

• If the source is a Densité probe, give the LongID 
of the Densité frame and card (see How To 
Display thumbnails or streaming video on the 
Kaleido-K2?). 

Display Options:  

Clicking the Restore Native Resolution button will 
change the size of the Streaming Viewer to be of the 
native size (pixels) of the current stream. If no stream 
is available, this has no effect. 

 



Action Tab 

Assign Actions  

Action on single click:  from the pull-down box, select 
the Action that will be executed when this Streaming 
Viewer is single-clicked using the mouse attached to 
the Kaleido-K2. 

Action on double click:  from the pull-down box, 
select the Action that will be executed when this 
Streaming Viewer is double-clicked using the mouse 
attached to the Kaleido-K2. 

 

3.16.3 Operation 

3.16.3.1 Fire an Action 

Left-click on the Streaming Viewer in the Kaleido display using the mouse. 

• Single-click fires the single-click Action configured for this Streaming Viewer in the Action 
pane of its Configuration Panel 

• Double-click fires the double-click Action configured for this Streaming Viewer in the Action 
pane of its Configuration Panel 

3.17 Close Caption Status Indicator 

3.17.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more Close Caption Status 
Indicators to the current Layout.  

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu 



• Push F6 on the keyboard  

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a Close Caption Status Indicator to an existing Monitor in the Layout: 

• Unlock the Monitor by right-clicking and selecting Unlock Monitor from the contextual menu. 
The Monitor’s border will turn yellow, indicating it may be edited. You may also ALT-click 
anywhere in the Monitor, which will unlock the Monitor and select the item you clicked. 

• Select the Close Caption Status Indicator tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a Close Caption Status Indicator of the desired 
size. 

Note that if the new Close Caption Status Indicator extends beyond the Monitor boundary, then it 
will not be part of the Monitor. 

Or add a Close Caption Status Indicator that is not part of a Monitor to the Layout: 

• Select the Close Caption Status Indicator tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Close Caption Status 
Indicator of the desired size. 

Or copy an existing Close Caption Status Indicator, inside or outside a Monitor: 

• Select the Close Caption Status Indicator to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new Close Caption 
Status Indicator 

- OR - 

• While holding CTRL, click on the Close Caption Status Indicator to be copied, and drag to a 
new location. The original Close Caption Status Indicator will remain, and a copy will appear 
at the new location. 

Note that if the new Close Caption Status Indicator extends beyond the Monitor boundary, then it 
will not be part of the Monitor. 

3.17.2 Configuration: 

The attributes of a Close Caption Status Indicator are adjustable using its Configuration Panel in 
KEdit. To access the panel for a Close Caption Status Indicator within a Monitor: 

4. Select the Close Caption Status Indicator using one of these methods: 

• Unlock the Monitor in which the Close Caption Status Indicator is located, by right-clicking 
and selecting Unlock Monitor from the contextual menu (an UNLOCKED Monitor is 



identified by a YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), 
and then click on the Close Caption Status Indicator to select it  

• ALT-click on the Close Caption Status Indicator. The monitor will unlock, and the Close 
Caption Status Indicator will be selected. 

NOTE: at this point the Close Caption Status Indicator may be positioned (click on the Close 
Caption Status Indicator and drag) and scaled (click and drag a control point) within the 
Monitor. It will retain its proportions when scaled. It cannot be moved outside the Monitor 
boundary 

5. Open the Configuration Panel for the Close Caption Status Indicator by pushing F5, or from 
the Configuration Panel item in the View menu 



3.17.2.1 Offline Panel 

Assignment Tab 

Icon Selection:  

Four different icons can be selected for each Close 
Caption status Indicator, corresponding to Disable, 
Normal, Warning and Error conditions. The current 
selection is shown. Clicking on the Select… box 
opens a selection screen where a variety of possible 
icons are shown. Click on an appropriate icon to 
select it; the selection screen closes automatically. 

The Close Caption Status Indicator can be made to 
flash under Error and Warning conditions. Click on 
the Flashing checkbox to turn flashing mode on or off. 

Assign Service ID: 

In the current Kaleido software version the provider of 
the VBI information can be the Kaleido K2 frame 
itself, or a Densité probe (e.g. VCP-1021). 

The service ID is the Miranda long ID of the Densité 
probe, or its alias in the file C:\iControl\ 
Startup\KG2Config.xml (see How To Display 
thumbnails or streaming video on the Kaleido-K2?), 
or the alias of the Kaleido K2 (typically A). 

Assign Input Number: 

Reflects the video input number. It should be 1 in the 
case of a Miranda VCP-1021 probe, or the video 
input for the Kaleido-K2 [between 1 and 32]. 

Channel: 

If this Closed Caption status indicator is within a 
Monitor, the name of the assigned Channel will be 
shown, and the Link order box will be active, showing 
the current link order of the Close Caption Status 
Indicator within the Channel displayed by this 
Monitor. Enter a new value if desired. 

 

3.17.2.2 Online Panel  (Kaleido-K2 only) 



Assignment Tab 

Icon Selection: 

Four different icons can be selected for each Close 
Caption Status Indicator, corresponding to Disable, 
Normal, Warning and Error conditions. The current 
selection is shown. Clicking on the Select… box 
opens a selection screen where a variety of possible 
icons are shown. Click on an appropriate icon to 
select it; the selection screen closes automatically. 

The Close Caption Status Indicator can be made to 
flash under Error and Warning conditions. Click on 
the Flashing checkbox to turn flashing mode on or 
off. 

Assign Service ID: 

In the current Kaleido software version the provider of 
the VBI information can be the Kaleido K2 frame 
itself, or a Densité probe (e.g. VCP-1021). 

The service ID is the Miranda long ID of the Densité 
probe, or its alias in the file C:\iControl\ 
Startup\KG2Config.xml (see How To Display 
thumbnails or streaming video on the Kaleido-K2?), 
or the alias of the Kaleido K2 (typically A). 

Assign Input Number: 

Reflects the video input number. It should be 1 in the 
case of a Miranda VCP-1021 probe, or the video 
input for the Kaleido-K2 [between 1 and 32]. 

Channel: 

If this Closed Caption Status Indicator is within a 
Monitor, the name of the assigned Channel will be 
shown, and the Link order box will be active, showing 
the current link order of the Close Caption Status 
Indicator within the Channel displayed by this 
Monitor. Enter a new value if desired. 

 

3.17.3 Operation 

There are no operational features that can be controlled on-line for a Closed Caption Status 
Indicator. 



3.18 Close Caption Text 

3.18.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more Close Caption Text Boxes to 
the current Layout.  

6. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu. 

• Push F6 on the keyboard  

7. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

8. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a Close Caption Text box to an existing Monitor in the Layout: 

• Unlock the Monitor by right-clicking and selecting Unlock Monitor from the contextual menu. 
The Monitor’s border will turn yellow, indicating it may be edited. You may also ALT-click 
anywhere in the Monitor, which will unlock the Monitor and select the item you clicked. 

• Select the Close Caption Text tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a Close Caption Text Box of the desired size. 

Note that if the new Close Caption Text Box extends beyond the Monitor boundary, then it will not 
be part of the Monitor. 

Or add a Close Caption Text Box that is not part of a Monitor to the Layout: 

• Select the Close Caption Text tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Close Caption Text Box of 
the desired size. 

Or copy an existing Close Caption Text box, inside or outside a Monitor: 

• Select the Close Caption Text Box to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new Close Caption 
Text box. 

- OR - 

• While holding CTRL, click on the Close Caption Text Box to be copied, and drag to a new 
location. The original Close Caption Text box will remain, and a copy will appear at the new 
location. 



Note that if the new Close Caption Text Box extends beyond the Monitor boundary, then it will not 
be part of the Monitor. 

3.18.2 Configuration: 

The attributes of a Close Caption Text Box are adjustable using its Configuration Panel in KEdit. 
To access the panel for a Close Caption Text box within a Monitor: 

9. Select the Close Caption Text Box using one of these methods: 

• Unlock the Monitor in which the Close Caption Text Box is located, by right-clicking and 
selecting Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified 
by a YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then 
click on the Close Caption Text Box to select it  

• ALT-click on the Close Caption Text Box. The monitor will unlock, and the Close Caption 
Text Box will be selected. 

NOTE: at this point the Close Caption Text Box may be positioned (click on the Close 
Caption Text box and drag) and scaled (click and drag a control point) within the Monitor. It 
cannot be moved outside the Monitor boundary. 

10. Open the Configuration Panel for the Close Caption Text Box by pushing F5, or from the 
Configuration Panel item in the View menu 



3.18.2.1 Offline Panel 

Assignment Tab 

Add a Background: 

Click on the box to add a background behind the Closed 
Caption text. 

Assign Service ID: 

In the current Kaleido software version the provider of 
the VBI information can be the Kaleido K2 frame 
itself, or a Densité probe (e.g. VCP-1021). 

The service ID is the Miranda long ID of the Densité 
probe, or its alias in the file 
C:\iControl\Startup\KG2Config.xml (see How To 
Display thumbnails or streaming video on the 
Kaleido-K2?), or the alias of the Kaleido K2 (typically 
A). 

Assign Input Number: 

Reflects the video input number. It should be 1 in the 
case of a Miranda VCP-1021 probe, or the video 
input for the Kaleido K2 [between 1 and 32]. 

Assign Number of Lines: 

Number of CC lines to be displayed on the Kaleido 
monitor wall. 

Transparency: 

Use the slider to select a transparency for the Closed 
Caption text. The transparency is only seen when the 
Closed Caption text is overlaid on a Video Screen. 
The selected value is shown as a percentage 
beneath the slider. Possible values are 0, 15, 30, 45, 
55, 70, 85 and 100%. 

Channel: 

If this Closed Caption text is within a Monitor, the 
name of the assigned Channel will be shown, and the 
Link order box will be active, showing the current link 
order of the VBI within the Channel displayed by this 
Monitor. Enter a new value if desired. 

 

3.18.2.2 Online Panel  (Kaleido-K2 only) 



Assignment Tab 

Add a Background: 

Click on the box to add a background behind the Closed 
Caption text. 

Assign Service ID: 

In the current Kaleido software version the provider of 
the VBI information can be the Kaleido K2 frame 
itself, or a Densité probe (e.g. VCP-1021). 

The service ID is the Miranda long ID of the Densité 
probe, or its alias in the file 
C:\iControl\Startup\KG2Config.xml (see How To 
Display thumbnails or streaming video on the 
Kaleido-K2?), or the alias of the Kaleido K2 (typically 
A). 

Assign Input Number: 

Reflects the video input number. It should be 1 in the 
case of a Miranda VCP-1021 probe, or the video 
input for the Kaleido K2 [between 1 and 32]. 

Assign Number of Lines: 

Number of CC lines to be displayed on the Kaleido 
monitor wall. 

Transparency  

Use the slider to select a transparency for the Closed 
Caption text. The transparency is only seen when the 
Closed Caption text is overlaid on a Video Screen. 
The selected value is shown as a percentage 
beneath the slider. Possible values are 0, 15, 30, 45, 
55, 70, 85 and 100%. 

Channel: 

If this Closed Caption text is within a Monitor, the 
name of the assigned Channel will be shown, and the 
Link order box will be active, showing the current link 
order of the VBI within the Channel displayed by this 
Monitor. Enter a new value if desired. 

 

3.18.3 Operation 

There are no operational features that can be controlled on-line for Closed Caption text. 



3.19 V-Chip Status Indicator 

3.19.1 Creation: 

Use the Monitor Browser to add a Monitor containing one or more V-Chip Status Indicators to the 
current Layout. 

1. Open the Monitor Browser in KEdit in one of three ways: 

• Select its icon from the KEdit toolbar. 

• Select the Monitor Browser item in the View menu 

• Push F6 on the keyboard  

2. Select an appropriate Monitor from the pull down list, using the Preview to see its 
appearance. 

3. Click on the preview, and drag a copy of the Monitor onto the Layout. 

Or add a V-Chip Status Indicator to an existing Monitor in the Layout: 

• Unlock the Monitor by right-clicking and selecting Unlock Monitor from the contextual menu. 
The Monitor’s border will turn yellow, indicating it may be edited. You may also ALT-click 
anywhere in the Monitor, which will unlock the Monitor and select the item you clicked. 

• Select the V-Chip Status Indicator tool in the KEdit toolbar. 

• Click inside the Monitor, and drag to place a V-Chip Status Indicator of the desired size. 

Note that if the new V-Chip Status Indicator extends beyond the Monitor boundary, then it will not 
be part of the Monitor. 

Or add a V-Chip Status Indicator that is not part of a Monitor to the Layout: 

• Select the V-Chip Status Indicator tool in the KEdit toolbar. 

• Click at the appropriate place in the layout, and drag to place a V-Chip Status Indicator of the 
desired size. 

Or copy an existing V-Chip Status Indicator, inside or outside a Monitor: 

• Select the V-Chip Status Indicator to be copied. 

• Use the Copy (CTRL+C) and Paste (CTRL+V) commands to create a new V-Chip Status 
Indicator. 

- OR - 

• While holding CTRL, click on the V-Chip Status Indicator to be copied, and drag to a new 
location. The original V-Chip Status Indicator will remain, and a copy will appear at the new 
location. 



Note that if the new V-Chip Status Indicator extends beyond the Monitor boundary, then it will not 
be part of the Monitor. 

3.19.2 Configuration: 

The attributes of a V-Chip Status Indicator are adjustable using its Configuration Panel in KEdit. 
To access the panel for a V-Chip Status Indicator within a Monitor: 

1. Select the V-Chip Status Indicator using one of these methods: 

• Unlock the Monitor in which the V-Chip Status Indicator is located, by right-clicking and 
selecting Unlock Monitor from the contextual menu (an UNLOCKED Monitor is identified 
by a YELLOW BORDER and YELLOW RESIZING HANDLES  in its corners), and then 
click on the V-Chip Status Indicator to select it  

• ALT-click on the V-Chip Status Indicator. The monitor will unlock, and the V-Chip Status 
Indicator will be selected. 

NOTE: at this point the V-Chip Status Indicator may be positioned (click on the V-Chip Status 
Indicator and drag) and scaled (click and drag a control point) within the Monitor. It will retain 
its proportions when scaled. It cannot be moved outside the Monitor boundary. 

2. Open the Configuration Panel for the V-Chip Status Indicator by pushing F5, or from the 
Configuration Panel item in the View menu. 



3.19.2.1 Offline Panel 

Assignment Tab 

Assign Service ID: 

In the current Kaleido software version the provider of 
the VBI information is the Kaleido K2 frame or a 
Densité VCP-1021 probe. 

The service ID is the Miranda long ID of the Densité 
probe, or its alias in the file 
C:\iControl\Startup\KG2Config.xml (see How To 
Display thumbnails or streaming video on the 
Kaleido-K2?), or the alias of the Kaleido K2 (typically 
A). 

Assign Input Number: 

Reflects the video input number. It should be 1 in the 
case of a Miranda VCP-1021 probe, or the video 
input for the KaleidoK2 [between 1 and 32]. 

Channel: 

If this V-Chip Status Indicator is within a Monitor, the 
name of the assigned Channel will be shown, and the 
Link order box will be active, showing the current link 
order of the VChip within the Channel displayed by 
this Monitor. Enter a new value if desired. 

 

3.19.2.2 Online Panel  (Kaleido-K2 only) 



Assignment Tab 

Assign Service ID: 

In the current Kaleido software version the provider of 
the VBI information is the Kaleido K2 frame or a 
Densité VCP-1021 probe. 

The service ID is the Miranda long ID of the Densité 
probe, or its alias in the file 
C:\iControl\Startup\KG2Config.xml (see How To 
Display thumbnails or streaming video on the 
Kaleido-K2?), or the alias of the Kaleido K2 (typically 
A). 

Assign Input Number: 

Reflects the video input number. It should be 1 in the 
case of a Miranda VCP-1021 probe, or the video 
input for the KaleidoK2 [between 1 and 32]. 

Channel: 

If this V-Chip Status Indicator is within a Monitor, the 
name of the assigned Channel will be shown, and the 
Link order box will be active, showing the current link 
order of the VChip within the Channel displayed by 
this Monitor. Enter a new value if desired. 

 

3.19.3 Operation 

There are no operational features that can be controlled on-line for a VChip Status Indicator. 

3.20 Logo 

3.20.1 Creation: 

A Logo cannot be included in a Monitor. 

To add a Logo to a Layout: 

• Select the Logo tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Logo of the desired size 

3.20.2 Configuration: 

The attributes of a Logo are adjustable using its configuration panel in KEdit. To access the panel 
for a Logo: 



1. Click on the Logo. Control points will appear at the corners and the center of the long side, 
showing it is selected. 

NOTE: at this point the Logo may be positioned (click on the Logo and drag) and scaled (click 
and drag a control point) within the Layout. 

2. Open the configuration panel for the Logo by pushing F5, or from the Configuration Panel 
item in the View menu 



3.20.2.1 Offline Panel 

Appearance Tab 

Select the Logo Image: 

The selection window shows a list of all logos 
currently available on the KEdit’s computer. Select 
one by clicking on it; a preview of the selected image 
is shown at the top of the panel. 

To add a new image: 

• Click on the Browse button located to the right of 
the selection window.  

• In the Add Logo Picture dialog, browse the 
computer to find the desired image, and click to 
select it 

• Click Open to add the image. 

Transparency: 

Use the slider to select a transparency for the logo. 
The transparency is only seen when the Logo is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

NOTE:  Any pixel in a logo image that has RGB 
values of 0,0,0 will be considered as transparent, and 
will be invisible in the monitor-wall display. This 
permits “see-through” sections in the Logo. This is 
separate from the Transparency set by the slider in 
this panel, which sets a degree of transparency for all 
other pixels in the logo. 

Downloading:   When a Layout containing new Logo 
images that was created offline is downloaded to an 
online Kaleido, the images can be downloaded to the 
Kaleido-K2 along with the Layout. Click the Images 
checkbox in the Apply Layout Online dialog (see File 
Menu). 

 

3.20.2.2 Online Panel  (Kaleido-K2 only) 



Appearance Tab 

Select the Logo Image: 

The selection window shows a list of all logos 
currently available on the Kaleido-K2. Select one by 
clicking on it; a preview of the selected image is 
shown at the top of the panel. 

To add a new image: 

• Click on the Browse button located to the right of 
the selection window. 

• In the Add Logo Picture dialog, browse the 
computer to find the desired image, and click to 
select it. 

• Click Open to add the image. 

Transparency: 

Use the slider to select a transparency for the Logo. 
The transparency is only seen when the Logo is 
overlaid on a Video Screen. The selected value is 
shown as a percentage beneath the slider. Possible 
values are 0, 15, 30, 45, 55, 70, 85 and 100%. 

NOTE:  Any pixel in a logo image that has RGB 
values of 0,0,0 will be considered as transparent, and 
will be invisible in the monitor-wall display. This 
permits “see-through” sections in the Logo. This is 
separate from the Transparency set by the slider in 
this panel, which sets a degree of transparency for all 
other pixels in the logo. 

 

3.20.3 Operation 

There are no operational features that can be controlled on-line for a Logo. 

3.21 Background 

3.21.1 Creation: 

The Background is integral to every Layout, and is created by default. 

3.21.2 Configuration: 

The attributes of the Background are adjustable using its Configuration Panel in KEdit. To access 
the panel for the background of a Layout: 



1. Click anywhere on the background.  

2. Open the Configuration Panel for the Background by pushing F5, or from the Configuration 
Panel item in the View menu 



3.21.2.1 Offline Panel 

Appearance Tab 

Select the background picture or color: 

Select a picture or a solid color as the Layout 
background. 

The selection window shows a list of all images 
currently available on the machine running KEdit. Select 
one by clicking on it; a preview of the selected image is 
shown at the top of the panel. 

To add a new image: 

• Click on the Browse button located to the right of 
the selection window. 

• In the Add Background Picture dialog, browse the 
computer to find the desired image, and click on its 
name or icon to select it. 

• Click Open to add the image. 

Image Selection Considerations 

The background image should not be too large, or it 
may cause processing problems. Background images 
should respect these guidelines: 

• No larger than 1920 W and 1080 H for single-head 
systems 

• No larger than 2048 W and 2048 H for dual-head 
systems  

• The size of the image file should not be greater than 
300K. 

Clicking on the Tiled checkbox enables the tiling 
feature, where copies of the picture are laid out in a grid 
pattern to fill the background. . 

Clicking the down arrow beside the Color Selection icon 
opens the Color Palette window. Select a color using 
one of the three optional methods, and then click the 
Apply button while the Color Palette window is still open 
to make a solid-color background. 

Downloading:   When a Layout that was created offline 
containing new Background images is downloaded to 
an online Kaleido-K2, the images can be downloaded to 
the Kaleido-K2 along with the Layout. Click the Images 

 



checkbox in the Apply Layout Online dialog (see File 
Menu). 



3.21.2.2 Online Panel  (Kaleido-K2 only) 

Appearance Tab 

Select the background picture or color: 

Select a picture or a solid color as the Kaleido Monitor 
Wall output background. 

The selection window shows a list of all images 
currently available on the Kaleido.  

Select one by clicking on it; a preview of the selected 
image is shown at the top of the panel. 

To add a new image: 

• Click on the Browse button located to the right of 
the selection window. 

• In the Add Background Picture dialog, browse the 
computer to find the desired image, and click on its 
name or icon to select it. 

• Click Open to add the image. 

Image Selection Considerations 

The background image should not be too large, or it 
may cause processing problems. Background images 
should respect these guidelines: 

• No larger than 1920 W and 1080 H for single-head 
systems 

• No larger than 2048 W and 2048 H for dual-head 
systems  

• The size of the image file should not be greater than 
300K. 

Clicking on the Tiled checkbox enables the tiling 
feature, where copies of the picture are laid out in a grid 
pattern. 

Clicking the down arrow beside the Color Selection icon 
opens the Color Palette window. Select a color using 
one of the three optional methods, and then click the 
Apply button while the Color Palette window is still open 
to make a solid-color background. 

 

3.21.3 Operation 

There are no operational features that can be controlled on-line for the Background. 



3.22 Group Box 

3.22.1 Creation: 

A Group Box cannot be included in a Monitor. 

To add a Group Box to a Layout: 

• Select the Group Box tool in the KEdit toolbar. 

• Click at the appropriate place in the Layout, and drag to place a Group Box of the desired 
size 

3.22.2 Configuration: 

The only attributes of a Group Box that are adjustable are size and location. To modify them:  

1. Click on the Group Box. Control points will appear at the corners and the center of the long 
side, showing it is selected.  

2. Adjust the position (click on the Group Box and drag) and size (click and drag a control point) 
of the Group Box as desired. 

There is no Configuration Panel for a Group Box. 

3.22.3 Operation 

There are no operational features that can be controlled on-line for a Group Box. 



4 Alarms and Alarm Monitors 

4.1 Alarm Browser 

Access Kaleido-K2’s alarm resources by opening the Alarm Browser from the View menu, or by 
using F7. The browser shows a list of existing Alarm Monitors, and the Alarm Inhibition group to 
which each Alarm Monitor is associated, if any. Click on the header of either column to sort the 
table in ascending order according to that column. 

New:   Click New to add a new Alarm 
Monitor to this list. A blank Alarm Monitor 
control panel will open.  

Edit:   Click on an existing Alarm Monitor to 
select it, then click Edit (or, double–click on 
the existing alarm monitor) to modify it. The 
Alarm Monitor control panel will open, 
containing the current definition of the 
selected Alarm Monitor. 

Remove:   Click on an existing Alarm 
Monitor to select it, then click Remove to 
delete it 

Alarm Inhibition Group assignment:  you 
can reassign an alarm monitor to a different 
Alarm Inhibition Group by: 

• Using the drop-down list to select an 
existing alarm group 

• Typing directly into the box to create a 
new group 

This can also be done from the Alarm 
Monitor; click on an Alarm Monitor name 
and click Edit to open it. 

 

4.2 Alarm Monitor 

The Alarm Monitor control panel provides all the necessary resources to create and manage 
Alarms on the Kaleido-K2. 



Alarm Monitor Name:  Type a name for this Alarm 
Monitor in the box.  

Alarm Group:   The pull-down list includes all existing 
Alarm Group names. Click on one to select it. This 
Alarm Monitor will be associated with that group once 
the changes have been saved. 

Create a new group by typing a new name directly 
into the box. It will be added to the list of groups once 
the new or revised Alarm Monitor has been saved. 

Use Alarm Groups to enable and disable many 
Alarms at once using Actions which work on Alarm 
Groups, or using the Alarm Group Inhibit Button 
component in a layout. 

When a new alarm group is created, two Actions are 
also created: 

• Enable_alarmgroupname_alarms 

• Disable_alarmgroupname_alarms 

These actions are deleted when the alarm group is 
removed. 

Alarms List:   This table shows all of the individual 
alarms which are included in this Alarm Monitor. 

A detailed explanation of how to use this list follows. 

Assign Actions to trigger:   The Alarm Monitor will 
be in one of four states, depending on the status of 
its individual alarms. An Action can be assigned to 
each of these. The Action will be triggered when the 
status of the Alarm Monitor changes to that state 
from another state. The Alarm Monitor is active only 
when assigned in the current layout. 

Select the appropriate Action for each state from the 
pull-down box. The pull-down shows all actions which 
are currently defined for this Kaleido-K2 

The state of the Alarm Monitor is defined to be the 
highest-priority severity reported by any of its 
constituent alarms, where the priority of severities, 
from highest to lowest, is: 

• Error 

• Warning 

• Disabled 

 



• Normal 

4.2.1 Alarm Types 

The Alarms List in the Alarm Monitor control panel shows all of the individual Alarms which are 
included in the Alarm Monitor. Each is identified by Type and Assignment.  

Type:   Click on the entry in the Type column to see a 
pull-down list of all available types of Alarms. Select 
one by clicking on it. An Alarm Setting dialog box will 
open, allowing the necessary information to be entered 
for the Alarm type selected. 

Hint: it is preferable to select and open existing Alarms 
by clicking on the alarm in the Assignment column and 
pushing Edit, or by double-clicking on the Alarm in the 
Assignment column. Clicking on the alarm in the Type 
column will open the pull-down list and may result in 
the alarm type being inadvertently changed. 

Assignment:   Once the data has been entered and 
saved, the Assignment column will show a summary of 
the data. 

Severity:   Assign a degree of severity to this alarm. 
Click in the severity box beside any alarm, and select 
either ERROR or WARNING from the pulldown.  

• The alarm will report the assigned severity to this 
alarm monitor when it is triggered. 

 

Here is a list of all types of Alarms, and a description of their associated Alarm Setting dialogs. 



Video Alarm 

Video:   Enter the number of the Video input to the 
Kaleido-K2 [enter a number between 1 and 32]. This 
Alarm is generated internally by the Kaleido-K2. 

Video Error:   Use the checkboxes to select which of 
the available error types are to be associated with 
this Alarm. 

Calibration:   Click the calibration button to open the 
Video Detection Calibration dialog, allowing the 
settings for Luma Too High, Black Detection and 
Freeze Detection to be customized. 

Use the selection buttons at the left of the Video 
Detection Calibration dialog to select the error 
detection settings to be adjusted. 

Note that the Calibration is only available when in 
online mode. 

 

Luma Too High 

Select Default  to use the factory 
settings. 

Select Custom  to enable the three 
parameter controls. 

If the input is analog video, you 
must disable the AGC at the Kaleido 
input in order to detect high input 
luminance. 

Threshold Level: Define the level 
above which Luma Too High will be 
reported. Choose IRE for NTSC and 
or mV for PAL input signals. 

Occurrence and Interval:   an error 
will not be flagged unless it is 
present for at least the percentage 
shown in the Occurrence window of 
the time shown in the Interval 
window. For example, if Occurrence 
is 15% and Interval is 2 seconds, 
the error will not be flagged unless it 
has been detected during 15% of 
the previous 2 seconds, i.e. 0.3 
seconds total. 

 



Black Detection 

Select Default  to use the factory 
settings. 

Select Custom  to enable the three 
parameter controls. 

Threshold Level: Define the level 
below which Black Detection will be 
reported. Choose IRE for NTSC and 
or mV for PAL input signals. 

Occurrence and Interval:   an error 
will not be flagged unless it is 
present for at least the percentage 
shown in the Occurrence window of 
the time shown in the Interval 
window. For example, if Occurrence 
is 15% and Interval is 2 seconds, 
the error will not be flagged unless it 
has been detected during 15% of 
the previous 2 seconds, i.e. 0.3 
seconds total. 

 

Freeze Detection 

Select Default  to use the factory 
settings. 

Select Custom  to enable the three 
parameter controls. 

Sensitivity:   Freeze detection is 
done by comparing successive 
frames. Noise in the signal could 
disrupt this process, so filtering is 
added to remove it. Adjust the 
sensitivity to suit the signal being 
monitored, using the slider. 

Occurrence and Interval: an error 
will not be flagged unless it is 
present for at least the percentage 
shown in the Occurrence window of 
the time shown in the Interval 
window. For example, if Occurrence 
is 100% and Interval is 100 
seconds, the error will not be 
flagged unless it has been 
continuously detected for the 
previous 100 seconds. 

 



Audio Alarm 

The Audio Input: 

Format: select Embedded (audio embedded in a 
digital video signal) or Audio Card (audio from one 
of the Kaleido’s audio input cards). If Embedded is 
selected, you need to specify the Video Input [any 
number between 1 and 32] and Group [between 1 
and 4] so that the audio can be identified. 

Alarms are not supported for streaming sources. 

In the AES/Stereo window, select which of the 
available signals is to be used. Embedded audio 
can include one or two, while an audio card can 
include up to 48. 

Click the appropriate button to determine whether 
the Alarm will report errors on both channels 
(stereo), left-channel only or right-channel only. 

Audio Error:  Use the checkboxes to select which 
of the available error types are to be reported by 
this Alarm. 

Calibration:   Click the calibration button to open 
the Audio Detection Calibration dialog, allowing the 
settings for Audio Silence, Overload, Out of Phase 
and Mono Detected to be customized. 

Use the selection buttons at the left to select the 
error detection settings to be adjusted. 

Note that the Calibration is only available when in 
online mode. 

 

Audio Silence 

Select Default  to use predefined settings: 

• The default Threshold value is 30dB 
below the Audio Operation Level set 
on the Audio Meter Calibration tab (for 
both analog and digital inputs). 

• The default Duration is 15 seconds 

Select Custom  to enable the two 
parameter data entry controls. 

Threshold:   Select the level below which 
audio will be considered silent.  

 
(for analog audio inputs) 
 



• For analog sources, the Threshold 
value may be Real (in dBU), for 
comparison with the audio input signal, 
or Normalized (in dB) for comparison 
with the input that has been scaled by 
the Audio Operation Level setting on 
the Audio Meter Calibration tab 

• For digital sources, the Threshold 
value (in dBFS) is compared to the 
input signal 

Duration:   Select the time period (in 
seconds) for which audio must be 
continuously silent before the Audio 
Silence error is flagged. 

 
(for digital audio inputs) 

 



Overload 

Select Default  to use predefined settings. 

• The default threshold value is: 

12dB above the Audio Operation Level 
set on the Audio Meter Calibration tab 
for analog audio inputs 

9dB above the Audio Operation Level 
set on the Audio Meter Calibration tab 
for digital audio inputs 

• The default duration is 2 seconds 

Select Custom  to enable the two 
parameter controls. 

Threshold:   Select the level above which 
audio will be considered overloaded.  

• For analog sources, the Threshold 
value may be Real (in dBU), for 
comparison with the audio input signal, 
or Normalized (in dB) for comparison 
with the input that has been scaled by 
the Audio Operation Level setting on 
the Audio Meter Calibration tab 

• For digital sources, the Threshold 
value (in dBFS) is compared to the 
input signal 

Duration:   Select the time period (in 
seconds) for which audio must be 
continuously overloaded before the 
Overload error is flagged. 

 
(for analog audio inputs) 
 

 
(for digital audio inputs) 

 

Out of Phase 

Select Default  to use the factory settings. 

Select Custom  to enable the two 
parameter controls. 

Sensitivity:   Select the level above which 
audio will be considered out of phase. The 
sensitivity is between –1 and +1, where –1 
means completely out of phase and +1 
means perfectly in-phase. 

Duration:   Select the time period for which 
audio must be continuously out. 

 



Mono Detected 

Select Default  to use the factory settings. 

Select Custom  to enable the single 
parameter control. 

Duration:  Set the time period for which the 
signal must continuously be determined as 
Mono before the Mono Detected error is 
flagged. 

 

GPI Alarm 

Enter the number of the GPI input on the Kaleido-K2 
that will trigger this Alarm [any number between 1 
and 66]. 

 

VBI/ANC Data Alarm 

Service ID:   Enter either the Miranda LongID or the 
Alias for the source of the VBI/ANC data. If the data 
is found on a video stream entering this Kaleido-K2, 
enter its alias A in the service ID box. If the data is 
coming from a remote source, enter its Miranda 
LongID or alias in the service ID box. 

Video Input Number:   If the source of the VBI/ANC 
data is an input to this Kaleido, enter the input 
number [between 1 and 32], otherwise enter 1. 

North American Standard (EIA 608):  Use the radio 
buttons to assign this Alarm to monitor Line 21 Data 
Presence, CC1 Presence or VChip Presence 
according to this standard. 

North American Standard (EIA 708):  Use the radio 
button to assign this Alarm to monitor CC Presence 
according to this standard. 

Teletext Standard (WST – EST 300 706):   Use the 
radio buttons to assign this Alarm to monitor one of 
the four available pages. For the selected page, use 
the radio buttons to choose whether to monitor 
Teletext only or Teletext and Subtitling. 

Note: In order to work correctly, you need to ensure 
your system is configured to detect Teletext or 
Closed Captioning accordingly. See section View 
menu.  



Calibration:   Push this button to open the VBI/ANC 
Detection Calibration dialog, allowing the settings for 
CC Text Presence, VChip Presence, and 
Subtitling/Teletext Presence to be customized. 

Use the selection buttons at the left to select the error 
detection settings to be adjusted.  



CC Text Presence 

Select Default  to use the factory 
settings. 

Select Custom  to enable the single 
parameter control. 

Duration:   Select the time period for 
which CC Text must be continuously 
absent before the CC Text Presence 
error is flagged. 

 

VChip Presence 

Select Default  to use the factory 
settings. 

Select Custom  to enable the single 
parameter control. 

Duration:   Select the time period for 
which VChip data must be 
continuously absent before the VChip 
Presence error is flagged. 

 

Subtitling/Teletext Presence 

Select Default  to use the factory 
settings. 

Select Custom  to enable the 
parameter controls. 

Duration:   Select the time period for 
which Subtitling/Teletext data must be 
continuously absent before the 
Subtitling/Teletext Presence error is 
flagged. 

Teletext:  The Kaleido is able to detect 
the presence of 4 pages of Teletext 
simultaneously. In the four fields, enter 
the pages you want to monitor 
[between 100 and 899]. 

 



Tally Alarm 

Service ID:   Enter either the Miranda LongID or the 
Alias for the TSL, Andromeda or Kalypso service 
whose Tallies will be monitored by this Alarm. 

Text Address: Enter the address of the dynamic data. 
For a TSL, the address is between 1 and 127, for an 
Andromeda, the address is between 1 and 255 and for 
a Kalypso it is between 1 and 128.. 

Level: Enter the level of the dynamic data. 

For a Kalypso, this field is not used. 

For an Andromeda, the level can be between 0 and 15. 

For a TSL, the level can be 0, 1 or 2. In case of a TSL, 
the level has a particular meaning. The TSL box has 4 
Tallies per address, but the Kaleido is able to treat only 
2 Tallies per address (one left and one right), so here is 
the rule followed to retrieve the Tally left and Tally right 
status:  

Level 0  1 2  

UMD meaning  16 chars First 8 
chars 

Last 8 
chars 

 

Tally Left  T1 or T3 T1 T3  

Tally Right  T2 or T4 T2 T4 

 

 

 



GSM Device Alarm  

Service ID:   Enter either the Miranda LongID or the 
Alias for the iControl GSM server that is monitored by 
this Alarm. 

NOTE: this alarm replaces the iControl Device Alarm 
that was included in previous releases of this software. 
If you have layouts created in previous versions that 
include these iControl Device alarms, be aware that 
they will not work in this release, and should be 
manually converted to GSM Device Alarms.  

 

Gateway Alarm 

Gateway status Message input: Enter any text here. 
This will be the same as in the Gateway command 
used to set the status. 

 

MPEG Alarm 

Service ID:   Enter either the Miranda LongID or the 
Alias for the PixelMetrix analyzer that is monitored by 
this Alarm. 

 

Power Supply Alarm 

Service ID:    Enter the Alias of the Kaleido-K2 whose 
power supply is monitored by this Alarm.  

Use the alias A to refer to this Kaleido-K2. 

 

Reference Input Alarm 

Service ID:     

 



WSS Presence Alarm 

The Video input:  enter the number of the Kaleido 
video input whose WSS presence will be monitored by 
this alarm 

Aspect Ratio source error:   Click the Calibration 
button to open the Aspect Ratio Detection Calibration 
panel. WSS Presence is pre-selected, but this panel 
also gives access to the Video Index Presence and 
Video AFD ANC Presence calibration. Use the radio 
buttons to select the Default or a Custom duration. The 
WSS will be considered as “Present” if it is continuously 
detected for the duration selected on this panel.   

Note that the Aspect Ratio Detection Calibration panel 
is only available in an online layout, so the calibration 
button will be grayed-out in the offline mode 

 

 

Video Index Presence Alarm 

The Video input:  enter the number of the Kaleido 
video input whose Video Index presence will be 
monitored by this alarm 

Aspect Ratio source error:   Click the Calibration 
button to open the Aspect Ratio Detection Calibration 
panel. Video Index Presence is pre-selected, but this 
panel also gives access to the WSS Presence and 
Video AFD ANC Presence calibration. Use the radio 
buttons to select the Default or a Custom duration. The 
Video Index will be considered as “Present” if it is 
continuously detected for the duration selected on this 
panel. 

Note that the Aspect Ratio Detection Calibration panel 
is only available in an online layout, so the calibration 
button will be grayed-out in the offline mode 

 

 



Video AFD ANC Alarm 

The Video input:  enter the number of the Kaleido 
video input whose Video AFD ANC presence will be 
monitored by this alarm 

Aspect Ratio source error:   Click the Calibration 
button to open the Aspect Ratio Detection Calibration 
panel. Video AFD ANC presence is pre-selected, but 
this panel also gives access to the WSS Presence and 
Video Index Presence calibration. Use the radio buttons 
to select the Default or a Custom duration. The Video 
Index will be considered as “Present” if it is 
continuously detected for the duration selected on this 
panel. 

Note that the Aspect Ratio Detection Calibration panel 
is only available in an online layout, so the calibration 
button will be grayed-out in the offline mode 

 

 

 

 

4.3 Transfer of Alarms when applying a Layout Onlin e 
 

The Alarms which appear in the pull-down lists of various 
dialogs depend on the operating mode: 

• When working offline, the available Alarms are those 
found on the machine running KEdit. 

• When working online, the available Alarms are those 
found on the Kaleido. 

When a Layout is transferred from KEdit to the Kaleido-
K2 by applying the Layout online, you should elect to 
transfer any newly-defined Alarms along with the Layout.  

• Tick the Alarm Monitors checkbox in the Exporting 
data from KEdit section. 

Note that you will overwrite any Alarm with the same 
name that is already saved on the Kaleido-K2. 

Note also that, if your layout contains any alarms that are 
not currently defined on the KEdit machine, e.g. left over 
from a previous layout, or alarms that were subsequently 
deleted, then KEdit cannot transfer them to the K2, and 
the on-line layout will show <none> in all alarm selection 
dialogs where that alarm was referenced. A pop-up will 
appear during the export process listing all referenced 

 



alarms that could not be found. 

 

 



5 Actions and Triggers 

An Action is the execution of a predefined series of individual Action Elements in response to a 
Trigger. 

Here is the list of available Action Elements and Triggers. 

Action Elements 

• Alarm Group 

• Alto Monitoring  

• Audio Monitoring 

• Full screen 

• GPI out 

• Load layout 

• Play Sound 

• Previous Layout 

• Router cross point 

• Stop Sound 

• Subtitling 

• Timer  

• Timer Stop 

• Unlatch Alarms 

Triggers 

• Mouse click or double click 

• GPI in 

• Alarm Monitor 

• XML Messages over the Gateway 

• Schedule entry 

• End of count from a timer 



5.1 Action creation/destruction 

Actions are created, edited and removed using the Action Browser panel accessible in KEdit. The 
Action Browser panel can be opened from the View menu, or by using the F9 key. 

The window contains a scrollable list of 
all currently defined Actions. 

Click New to create a new action. 

Click on an existing Action to select it, 
and then click: 

• Edit  to modify it. 

• Remove  to delete it. 

When you select New or Edit, the Action 
Configuration panel opens. It will be 
blank if you have selected New, and will 
contain the definition of the selected 
action if you have selected Edit   

5.2 Action configuration 

The configuration of Actions is done using the Action Configuration panel, which is available 
through KEdit via the Action Browser. 

An Action includes one or more Action Elements that will be sequentially executed. Here is the list 
of the supported Action Element types: 

• Alarm Group 

• Alto Monitoring 

• Audio Monitoring 

• Full screen 

• GPI out 

• Load layout 

• Play Sound 

• Previous Layout 

• Router cross point 

• Stop Sound 

• Subtitling 



• Timer  

• Timer Stop 

• Unlatch Alarms 

 

Set the Action Name: 

The Name edit box allows the user to name the 
Action. 

Action List: 

The Action Element list contains the sequence of 
elements that make up the Action, listed in order of 
execution. 

Click New to add an element to the list – it will appear 
with the text <none> under both Type and 
Assignment. 

Select an existing element (hint: click the item under 
Assignment, because if you click under Type the pull-
down list will open) and click Edit  to modify it. 

Select an existing item and click Remove  to delete it 
from the list. 

Click a selected item under Type, and a pull-down 
scrolling list will show all possible Action Element 
types that are available (see the list above). Click on 
one to select it. A dialog box will open which is 
specific to that type (see Action Elements 
Configuration). Enter all the indicated information, 
and click on Ok. The box will close, and the 
information you entered will be shown in the 
Assignment column. 

The user can change the order of the Action 
Elements in the list by selecting an item and using 
the Up and Down  buttons to move it up or down the 
list. The order is significant because the Action 
Elements are executed in order of their position in the 
list. 

Use the Save button to save the Action to disk.  

 

5.3 Action Elements Configuration 
 



5.3.1 Alarm Group 

Executing this Action Element will enable or 
disable a group of Alarms. 

Select an Alarm Group from the pull-down 
list. 

Select the radio button to set whether 
executing this Action Element will enable or 
disable that Alarm Group. 

Click OK to confirm the selection and return 
to the Action Configuration panel. 

5.3.2 Audio Monitoring 

Executing this Action Element will select an 
audio to be monitored at the output. 

Select the desired audio: Choose between 
Audio inside the selected Channel by link 
order, and Specific Audio. 

When the Audio inside Selected Channel by 
link order is selected, the user will hear the 
audio with link order 1 the first time the action 
is fired, the audio with link order 2 on the 
second firing, etc. until all audio signals have 
been heard. On the next firing, the audio 
monitoring will be muted. 

When the Specific Audio is selected, the 
audio source has to be specified. Choose 
between Streaming, Embedded and Audio 
Card, and then fill the fields as done for an 
Audio Meter Component (see Audio Meter). 

When selected for monitoring, the Audio 
Meter will display an orange border. 

N.B. any other Audio Meters configured to 
monitor the same signal as that selected for 
monitoring will also display an orange border. 

Note: if this Action Element is configured to 
be executed with the Selected Channel and it 
is assigned to a Component that is not part of 
a Monitor, nothing will be executed. 

 



5.3.3 Full screen  

Executing this Action Element will load the 
Full screen Layout for the specified Channel. 

Channel:  Select the Channel to be displayed 
Full Screen, using the pull-down box to select 
an existing Channel or Selected Channel. 
When Selected Channel is used, the Action 
will take the Channel from the selected 
Monitor (i.e. the Monitor containing a 
Component clicked by the user). If the Action 
is triggered without such information (e.g. the 
user clicked on a Component that is not part 
of a Monitor), then the Action is just ignored. 
By default, the Selected Channel will be 
selected. 

Click OK to confirm the selection and return 
to the Action Configuration panel. 

 

5.3.4 GPI out 

Executing this Action Element will trigger a 
GPI Out. 

Action Type:   Enter the GPI output to be 
addressed when this Action Element is 
executed [between 1 and 36]. 

Select the Action to be performed on the GPI 
output when this Action Element is executed. 
The GPI output can be turned ON, turned 
OFF or toggled between the two states. 

GPI Properties:  When ON or OFF is 
selected, the GPI properties options are 
activated. Select pulse and enter an 
appropriate duration, or choose to latch the 
GPI output in the selected state. 

Click OK to confirm the selection and return 
to the Action Configuration panel. 

 



5.3.5 Internal Router 

Executing this action selects video on the 
internal router of a Kaleido Alto or Quad. It 
has no effect on a Kaleido K2. 

Select the desired Video :  use the radio 
buttons to choose between the current 
channel, or a specific numbered video input. 

Click OK to confirm the selection and return 
to the Action Configuration panel. 

 

5.3.6 Load layout  

Executing this Action Element will load the 
specified Layout on the Kaleido-K2. 

Select a Layout to load from the pull-down 
list: 

• Offline:  the list includes the preset 
Layouts (10 presets and the Full Screen 
Layout). 

• Online:  the list includes all available 
Layouts on the Kaleido-K2. 

At any time, you can directly enter the name 
of the Layout into the box. 

Click Ok to confirm the selection and return 
to the Action Configuration panel. 

 

5.3.7 Play Sound  

Executing this Action Element will cause a 
selected sound file to be played on the 
Kaleido’s audio monitors, interrupting the 
current audio program. 

The pulldown lists sound files currently 
stored in the Kaleido’s database.  

Click on the Load Sound from File icon to 
open a search window to locate other sound 
files. 

 

5.3.8 Previous layout 

There is no configuration panel for the 
Previous Layout action type. When triggered, 
the “current layout” will be loaded. Note that 

 



this Action Element will be executed only if 
the Kaleido-K2 is in Full Screen mode, and is 
used to restore the Kaleido-K2 to its previous 
Layout when exiting Full Screen mode. 



5.3.9 Router cross point  

Executing this Action Element will change a 
cross point on a specific Router. 

Router ID: Identify the Router [enter its alias 
or its LongID]. 

Router Output:  Enter the output of the 
Router [between 1 and the number of outputs 
on the router]. 

Router Level:  Enter the level of the Router 
where the cross point is to be changed 
[between 0 and the number of levels 
configured for your router]. 

Router Input:  Enter the input of the Router 
[between 1 and the number of inputs on the 
router]. 

Click OK to confirm the selection and return 
to the Action Configuration panel. 

 

5.3.10 Stop Sound  

Executing this Action Element will stop the 
playing of a sound file initiated by the Play 
Sound action element.  There is no 
configuration panel for this action. 

 

5.3.11 Subtitling 

Executing this Action Element will change the 
subtitling page associated with the specified 
video input (NB: 625-line systems only). 

Video input:  specify a video input by number 

Subtitling page:  specify the subtitling page 
that is to be extracted from the specified 
video input for display. 

Click Ok to confirm the selection and return 
to the Action Configuration panel. 

 



5.3.12 Timer  

Executing this Action Element will start the 
selected timer with the indicated count preset 
and count direction. 

• Select a timer, using its ID number. 

• Enter the desired preset value 
(HH:MM:SS). 

• Select whether it will count up or down. 

Click Ok to confirm the selection and return 
to the Action Configuration panel. 

 

5.3.13 Timer Stop  

Executing this Action Element will cause the 
selected timer to stop counting. 

Select a Count Down Timer, using its ID 
number. 

Click OK to confirm the selection and return 
to the Action Configuration panel. 

 

5.3.14 Unlatch Alarms 

Executing this Action Element will unlatch 
Alarms. 

Select between unlatching all Alarms in the 
current Layout, or only those associated with 
the selected Monitor. 

Click OK to confirm the selection and return 
to the Action Configuration panel  

Note: if this Action Element is configured to 
be executed with the Selected Monitor and it 
is assigned to a Component that is not part of 
a Monitor, nothing will be executed. 

 

5.4 Action Emergency Stop 

Under the View-Setting menu a Stop Action Processing option is available. Selecting this item (a 
check mark will appear beside it in the menu when it is selected) inhibits the operation of all 
Actions. It is useful when concurrent Actions are running making the Kaleido-K2 inoperable. 



 

5.5 Transfer of Actions when applying a Layout Onli ne 

The Actions which appear in the pull-down lists of various 
dialogs depend on the operating mode: 

• When working offline, the available Actions are those 
found on the machine running KEdit. 

• When working online, the available Actions are those 
found on the Kaleido. 

When a Layout is transferred from KEdit to the Kaleido-K2 
by applying the Layout online, you should elect to transfer 
any newly-defined Actions along with the Layout.  

• Tick the Actions checkbox in the Exporting data from 
KEdit section. 

Note that you will overwrite any Action with the same 
name that is already saved on the Kaleido-K2. 

 



6 Video Output Calibration 

Kaleido-K2 provides these outputs: 

• Two RGBHV analog outputs to feed its display screen directly (outputs 1 and 2) 

• Two independent SDI outputs driven by cards located in slots 1 (Output A) and 10 (Output B) 
of the Kaleido’s internal mezzanine.  

The SDI outputs are optional. The Kaleido will support 0, 1 or 2 SDI cards. 

Two types of SDI output cards are supported, with outputs as shown in the table: 
 

Card type     MWO-SDM     MWO-HDM 

Output formats 

(default in bold ) 

• 525 

• 525 (Mode 16x9) 

• 625 

• 625 (Mode 16x9) 

 

• 525 

• 525 (Mode 16x9) 

• 625 

• 625 (Mode 16x9) 

• 1280x720@59p 

• 1280x720@60p 

• 1920x1080@30i 

• 1920x1080@29i 

• 1920x1080@25i 

These video outputs can be calibrated from KEdit when the Kaleido-K2 is connected in the online 
mode. 

Select View–Settings–Kaleido Calibration  from the pulldown menu (or use the shortcut F11) to 
open the Output Configuration panel.. 



Resolution 

Select the output resolution on the RGBHV outputs 
from the pulldown list. 

You should restart the Kaleido after changing the 
resolution. 

RGB Outputs 

Set the output voltage on RGBHV outputs 1 and 2 

• Select between 0.7 Vp-p and 1.0 Vp-p 

Set the cable equalization on output 1 only 

• Select between low, medium and high. 

SDI Outputs 

There is a tab in the panel for each of the two 
available SDI outputs. If a card is mounted in the 
indicated slot, the settings will be active; otherwise 
they will be grayed out. 

Format:  select the output from one of those available 
on the card (see the table above for the list of formats 
for each card type) 

Color Bar: Check this box to set the output to 100% 
Color Bars in place of the Kaleido DVI output.  

Keep Layout Aspect Ratio. If it is checked, black bars 
will be added to the output signal to maintain the 
layout aspect ratio; if not, the layout will scale to fill the 
available display space.. 

Output Calibration 

• Detail enhancer – from 0 to 15 – Nominal = 8 

• Sharpness – from 0 to 15 – Nominal = 8 

 

 



7 GPI Input Configuration 

Kaleido-K2 has 66 GPI inputs on its rear panel connector. Kaleido-K2 uses Actions to respond to 
changes in the state of these GPI inputs. Two Actions can be assigned to each GPI input, one 
associated with each of the two possible changes of state, i.e. OFF� ON and ON�OFF. 

The GPI inputs are configured from KEdit, which must be in Online mode. 

Open the GPI Input Action Assignment panel, by selecting GPI Input Configuration from the View 
menu, or by pressing F12. 

The panel shows a list of existing GPI Input Action 
Assignments.  

• To add a new Action Assignment to the list, click 
New. 

• To edit an existing Action Assignment, click on it to 
select it, and then click Edit. 

• To delete an existing Action Assignment, click on it 
to select it, and then click Remove. 

 

If you click New or Edit, the GPI In On/Off State Actions dialog opens. 

Configure the GPI Input Actions as follows: 

• GPI Input :  type the number of the GPI input to be configured     
[between 1 and 66]. 

• On State Action :  from the pull-down list of all Actions 
currently defined on this Kaleido-K2, select the action to be 
fired when the state of this GPI input transitions from OFF to 
ON. 

• Off State Action:   from the pull-down list of all Actions 
currently defined on this Kaleido-K2, select the action to be 
fired when the state of this GPI input transitions from ON to 
OFF. 

Click OK to accept the Action Assignments and return to the GPI 
Input Action Assignment panel. Click Cancel to abandon these 
changes and return to the GPI Input Action Assignment panel. 

 



8 Schedule 

Kaleido can create a Schedule of events, each of which results in the execution of an Action. 
Events may be one-time-only (specific date execution) or repeated at some regular time period 
(recurrent executions), which are defined by days of the week between start and stop dates. 

Note: Schedules created in version 5.0 and earlier of Kaleido-K2 cannot be used with the current 
software version.  

The Schedule is unique for each Kaleido-K2 and can be edited online only. 

The schedule uses the Kaleido-K2’s internal time, and does not make any use of the external 
LTC input. 

8.1 Schedule Editor 

The Schedule is accessed from the KEdit view menu. When Schedule is selected, the Schedule 
Editor panel appears. 

 

The Schedule Editor shows a list of all currently-defined Schedule Entries for the Kaleido: 

• Start Date/Time: Shows a short-form summary of the Schedule Event details, 
so the time when the event will be triggered can be identified. 

• Action Name: Gives the name of the Action that will be fired at the 
scheduled time. 

• Fire Action: All Actions whose boxes are checked in this column will be 
executed when the Fire button immediately below the list is 
clicked. This can be useful to reset some items if Kaleido has 
been restarted. 



The following options are available: 

• New: Opens a blank Schedule Entry panel. 

• Edit: Opens the Schedule Entry panel for the selected entry. 

• Duplicate: Creates a copy of the selected entry, and opens its Schedule Entry 
panel. 

• Remove: Deletes the selected entry. 

8.2 Schedule Entry Panel 

The Schedule Entry panel is used to define the occurrence of events, and the Actions that result. 

 

Specific Date Execution: 

Define a single event, using three parameters: 

• Date: Select the date on which this event will occur. Click on the arrow to open a pop-
up calendar. Then use the arrows to change the month and the year, and 
double-click on the day to select the date. 



 

• Time: Enter the time of day at which the event will occur: 

• Click in the box to the right of the last number. 

• Type the numbers in sequence, ignoring the semicolon delimiters. 

• The entered numbers will fill the data box from right to left. 

• To remove the last digit entered, press backspace. 

• To clear the time data, press the space bar. 

• Action: Select the Action that will be triggered at the selected date and time from the 
list of available actions in the pull-down box. 

Note that if the Kaleido-K2 is not operational at the instant identified by the 
schedule, the Action will not be fired. 

Recurrent Executions: 

Define an event which will recur at a specific time on specific days of the week, commencing on a 
given start date, and optionally ending at a given end date. 

• Repeat Every: Use the check boxes to identify the days of the week on which the event 
will occur. 

• Time: Enter the time of day at which the event will occur: 

• Click in the box to the right of the last number. 

• Type the numbers in sequence, ignoring the semicolon delimiters. 

• The entered numbers will fill the data box from right to left. 

• To remove the last digit entered, press backspace. 

• To clear the time data, press the space bar. 



• Action: Select the Action that will be triggered at the selected date and time from 
the list of available actions in the pull-down box. 

• Start Date: Select the first date on which this event can occur. Click on the arrow to 
open a pop-up calendar. Then use the arrows to change the month and 
the year, and double-click on the day to select the date. 

 

• End (checkbox): Check this box if an End date is applicable. If the box is not checked, any 
date appearing in the End Date window will be ignored, and the Action will 
be scheduled for ever. 

• End Date: Select the last date on which this event can occur. Click on the arrow to 
open a pop-up calendar. Then use the arrows to change the month and 
the year, and double-click on the day to select the date. 

 

Click OK to confirm the data in the panel and return to the Schedule Editor panel. Click Cancel to 
return to the Schedule Editor without any changes. 



9 Quality Monitor 

The Quality Control concept allows the user to select one or more Monitors within the Kaleido 
Layout to display any of the desired available sources by a simple mouse click. To use this 
feature you need to have configured your Kaleido-K2 to control a router (see section Control of an 
External Router by Kaleido for more details). 

The Quality Control mode is available only in normal layout operation, not in Full Screen mode. 

9.1 Configuration 

1. The Monitor must be pre-configured for quality control by checking the Use this monitor as 
target Quality Monitor check box on the Action tab of its Video component’s Configuration 
panel. When the box is checked, the line for Action on Double Click will be grayed out, since 
double-click on this Monitor is now reserved for the Quality Control function. 

 

2. The target Quality Monitor, and all of the other Monitors in the Layout whose signal the 
Quality Monitor can display, must be fed at the Kaleido input through a Router, and must be 
configured in the Router Reference Table. 

9.2 Operation 

9.2.1 Identification of Quality Monitors 

All Monitors in a Layout that have been configured for Quality Control are identified by the 
presence of markers in the four corners of the screen (┌, ┐, └ and ┘). 

The appearance of the corner markers indicates whether the Monitor is currently selected for 
Quality Control use: 

• WHITE corner markers:  The Monitor is  currently selected for Quality Control. 

• GRAY corner markers:   The Monitor is not  currently selected for Quality Control. 



  

 Selected QC Monitor   Non-selected QC Monitor  

9.2.2 Selecting/Deselecting a Monitor for Quality C ontrol 

When a Monitor has been configured for Quality Control, the double-click is used for selecting 
and deselecting its Quality Control functionality. Note that only one Monitor can be selected for 
Quality Control, although more than one can be configured. 

The following are the results of double-clicking reserved Quality Control Monitors in a Layout: 

Double-click on…  Result 

• Non-Selected QC Monitor: The double-clicked QC Monitor is selected 

Any previously-selected QC Monitor is deselected 

• Selected QC Monitor: The double-clicked QC Monitor is deselected. 

Normal operation mode is restored. 

9.2.3 Operation in Quality Control Mode 

Once a Monitor configured for Quality Control has been selected by a double click, then single-
clicking on any other Monitor in the Layout that has been configured in the Router Reference 
table will send its video to the Quality Control Monitor. 

Note that: 

• The normal single-click action function of these other Monitors has been pre-empted. The 
double-click action function remains available. 

• A non-selected Quality Control Monitor acts like any other Monitor. It displays the signal for 
which it was configured, and its signal can be routed to the selected Quality Control Monitor 
by a single click. 



10 The Kaleido-RCP Remote Control Panel 

The Kaleido-RCP is designed specifically to operate Kaleido. It may be used to control, singly or 
together, multiple Kaleidos. See the Kaleido Hardware manual for installation instructions. The 
panel layout is shown here. 

 

Figure 10-1  Kaleido-RCP Functions 

The use of these controls for operational adjustment of the Kaleido is detailed in the following 
section. 

Layout Presets Group 

In a production environment, display layouts need to be accessed quickly and easily. The 
Kaleido-RCP allows the user to access stored layouts through Layout Presets buttons 1 through 
10. Push one of these buttons and the Kaleido instantly updates the layout being displayed. 
Above the buttons is a paper strip that can be used to identify these customized layouts.  

You can also store the current layout in a Preset. Just hold the Preset for at least 6 seconds, and 
the current layout will be saved at that Preset. 

Functions Group 

The up, down, left and right arrow buttons are used for moving the selection pointer when 
adjusting the monitor-wall output.  

• The Select button enables monitors to be accessed on-screen for adjustment.  

• The Enter button is used to add monitors to the selection group. 

• The Esc button allows the user to escape an action without changes. 

• The Menu button is inactive for this version of the software. 

Alphanumeric Group 

The alphanumeric buttons are used to enter ID numbers when selecting a Kaleido to control. The 
DELETE key is included in this group. 



Direct Command Access Group 

This group is used to control certain on-screen effects directly. 

Input invokes the input list to assign a Channel to a selected Monitor. 

Full Screen applies to the most recently selected Monitor and enlarges it until it fills up the display 
area. You can cycle through all monitors having Channel assignments using the Right and Left 
buttons. Press Full Screen again to return to the multi-screen mode. 

The Full Screen window’s appearance does not necessarily match that shown in the Layout. All 
Full Screen presentations are identical. A default Layout is present, but may be modified by the 
user (see How to change the default Full Screen Layout?). If you push and hold the Full Screen 
button for at least 6 seconds, the current Layout is saved as the Full Screen Layout. 

Aspect Ratio toggles a window’s aspect ratio between 16:9 and 4:3. 

Underscan toggles a window’s scan mode between Underscan/Normal and Overscan, allowing 
the user to select whether the vertical and horizontal blanking areas are seen in the Video 
Screen. 

Audio Mon activates audio monitoring for the selected window. Audio volume may be controlled 
by the Up and Down buttons; depressing the Left button will mute the audio output and 
depressing the Right button will attenuate the level by 20 dB. When multiple meters are active for 
the selected window, depressing Audio Mon again will cycle audio monitoring among the 
available pairs of audio inputs. 

Note:  if the audio originates in a .WAV file, its volume must be adjusted using the Kaleido’s 
Windows volume control, as the signal is not processed through the Kaleido’s hardware. You 
must connect a keyboard and mouse to the Kaleido to do this. 

Display the Windows task bar on the Kaleido screen (CTRL+ESC or Windows Logo key) and 
click the Volume icon on the taskbar. Adjust the Volume Control in the window until the 
appropriate volume is heard on the audio monitor, then close the window. 

 

Load allows the user to change the current layout. Push the Load button to open a dialog listing 
layouts currently saved on the Kaleido  [Note: This dialog lists the names of Layouts located in 



the “c:\iControl\Startup\KALEIDO_LAYOUTS” folder – layouts saved at other locations are not 
available through this dialog].  

 

The top layout will be highlighted. 

• Use the up and down arrow keys on the Kaleido-RCP (see figure 9-1) to move through the 
list 

• When the desired layout is highlighted, push the ENTER button to load it 

• Push the ESCAPE button to exit the process without changing the layout. 

Save allows the user to save the currently-displayed layout, under its present name, or with a 
new name. Pushing the Save button opens the following dialog, showing the current name: 

 

To save the layout under the current name, push the Enter button 

If the name already exists, the user will be 
asked whether to continue and overwrite the 
existing layout with the new one (push ENTER 
to select “yes”), or to cancel the save process 
(push ESC to select “no”). 

 

If you select to cancel the save process by pushing ESC, the previous dialog will reappear. You 
may push ESC again to close the dialog, or change the name in the Layout Name window as 
follows. 

• To enter a new name, use the alphanumeric keypad on the Kaleido RCP as shown in the 
following table: 

 

KEY 
PRESSED 

ONCE 
PRESSED 

TWICE 
PRESSED 
3 TIMES 

PRESSED 
4 TIMES 

PRESSED 
5 TIMES 

PRESSED 
6 TIMES 

PRESSED 
7 TIMES 

1 _ # * 1 _ # * 



2 a b c A B C 2 

3 d e f D E F 3 

4 g h i G H I 4 

5 j k l J K L 5 

6 m n o M N O 6 

7 p q r P Q R 7 

8 s t u S T U 8 

9 v w x V W X 9 

0 y z - Y Z - 0 

DEL Deletes the character before the cursor position 

If you press more than seven times, you cycle through the list of options again; e.g. eighth press 
brings you back to the “Pressed Once” option. 

Use the right-arrow key to move to the next character once one has been entered. 

When the full name has been entered, push ENTER to accept the name, or push ESC to cancel 
the operation. 

NOTE: The case of letters used in the name will be preserved, but the software does not 
distinguish between cases when interpreting the name, so “LayOut” and “LAYOUT” will be 
considered as the same name. 

 
Status: not used in this software version 

Text: not used in this software version 

Modes Group 

The Kaleido-RCP has 4 modes of operation: Standby, Device, All Devices and Lock. 

In Standby mode, the unit is waiting for an instruction to enter one of the 3 other modes. Standby 
is the default mode upon startup. 

Device or All Devices modes let the user control a selected Kaleido frame or all Kaleido frames, 
respectively. In Device mode, the user is required to enter the ID number of the desired Kaleido. 
In All Devices mode, all Kaleido frames will be controlled at the same time (only the loading of 
Layouts can be controlled in ALL_DEVICES mode). 



Lock mode effectively disables all but the Layout Presets buttons, preventing any change in the 
configuration of the Kaleido frames. Additionally, it can be used to restrain access to a selected 
Kaleido. 

10.1 Keyboard Equivalents of Kaleido-RCP Keys 

If you are using a keyboard connected directly to the Kaleido instead of the Kaleido-RCP, here 
are the matching keys: 

 

KALEIDO-RCP KEY KEYBOARD KEY 

LOAD L 

SAVE S 

UP arrow ↑ (key up) 

DOWN arrow ↓ (key down) 

ESC Esc 

ENTER Enter 

Digits Character or digit 
keys directly. 

DEL Backspace 

10.2 Enabling / disabling RCP Support 

Kaleido’s RCP support may be enabled and disabled by editing the Kaleido-K2.properties file. 
Here is how to do it: 

• From your Kaleido-K2’s desktop, double click on the icon “My Computer”. 

• Navigate to “C:\iControl\Startup\” and open the file “KaleidoK2.properties” using the 
Notepad (right click on the “KaleidoK2.properties” file and select “Notepad” from the “Open 
With” menu). 

• Search the file for either of the following lines: 

KaleidoRCP=ON  

KaleidoRCP=OFF 

• If KaleidoRCP is ON, turn it OFF by replacing ON with OFF in this line 

• If KaleidoRCP is OFF, turn it ON by replacing OFF with ON in this line 

• Save your changes using the Save item in the File menu. 

• Close the Notepad editor. 

• Restart the Kaleido. 



 



11 Mouse Across Multiple Screens 

For installations of several Kaleidos where the screens are situated side-by-side, it may be 
convenient to control the Kaleidos with a single mouse and keyboard. 

This facility is provided by Synergy, third-party software which can be installed on multiple 
Kaleidos. 

• One Kaleido is designated as the server, and must be equipped with a keyboard and mouse 

• Multiple other Kaleidos can be configured as Clients. These  require a keyboard and mouse 
when the software is being installed, but not while the system is operating. 

Once the system is installed and operating, the mouse will move seamlessly across the boundary 
between screens, and the keyboard controls the Kaleido whose screen shows the cursor. 

See the How-to for detailed instructions on installing and configuring Synergy. 



12 Gateway 

Kaleido-K2 can execute commands received via a Gateway, allowing third-party developers and 
individual users remote access to some Kaleido functions. This section describes the Gateway 
functionality, and defines the commands that are available. 

12.1 Gateway Options 

Two Gateways are available for use with Kaleido-K2: 

• The Internal gateway is implemented within the Kaleido software 

• The MT-Gateway runs as a Windows service on the Kaleido’s operating system 

NOTE:  The Internal Gateway is the preferred gateway, and Miranda strongly recommends that it 
be used instead of the MT-Gateway, as it is more robust. The MT-Gateway might be used for 
legacy applications (the Internal gateway was not available in early versions of the software) or in 
specific situations based on design considerations, but its use is deprecated. 

It is important to note that only one gateway can be operating at a time , and the user must 
manage the gateway resources to ensure that this is the case.  

12.1.1 Internal Gateway 

The internal gateway is implemented in the Kaleido software itself, and is therefore internal to and 
exclusively functional with a specific Kaleido. 

The internal gateway is configured through the Kaleido Properties File, and is turned on or off by 
editing that file. Here is how to do it: 

• From your Kaleido-K2’s desktop, double click on the icon “My Computer”. 

• Navigate to “C:\iControl\Startup\” and open the file “Kaleido.properties” using the Notepad 
(right click on the “Kaleido.properties” file and select “Notepad” from the “Open With” 
menu). 

• Search the file for either of the following lines: 

activateInternalGateway=TRUE 

activateInternalGateway=FALSE 

• If activateInternalGateway is TRUE, the internal gateway is ON by default at startup. 
Disable the internal gateway at startup by replacing TRUE with FALSE in this line. 

• If activateInternalGateway is FALSE, the internal gateway is OFF by default at startup. 
Enable the internal gateway at startup by replacing FALSE with TRUE in this line. 

• Save your changes using the Save item in the File menu. 

• Close the Notepad editor. 



• Restart the Kaleido-K2. 

The internal gateway supports all Kaleido/Gateway commands when connected via port 13000, 
and supports only the <listnodes\> command when connected via port 10001. 

12.1.2 MT-Gateway 

The MT-Gateway is shipped with current versions of the Kaleido-K2 in support of legacy 
applications, but its use is not recommended. 

As the MT-Gateway must not be running when you are using the internal gateway, verify that it is 
turned off as follows: 

• On the Kaleido-K2 machine, display the desktop (use the desktop icon on the menu bar). 

• Double click on the “Services” icon. A dialog containing the services will appear. You can 
see if the MT-Gateway service is running, and whether it is configured to start 
automatically when the Kaleido-K2 is booted. 

 

• Right-click on MT_Gateway and choose Properties 

• Choose Manual as the Startup type, and click on OK. 

• Click the “Stop Service” icon on the toolbar to turn the gateway off 

 



12.2 Remote Operation of the Kaleido-K2 via the Gat eway 

Kaleido-K2 can execute XML commands received via the either the internal gateway (preferred) 
or the MT-gateway (deprecated). In an environment containing many Kaleido-K2s, there is a 
Gateway running on each Kaleido-K2. Remember that in such an environment you should 
configure your system to have at the most two lookups running (please refer to the “How to 
configure the Kaleido-K2 in systems including more than two units and application servers?” 
section of the documentation). 

Commands are sent to the Gateway via TCP/IP (Transmission Control Protocol/Internet 
Protocol), so you can use a Terminal Emulation (telnet) program or create your own application 
using the language of your choice (C++, Visual Basic, Java, …). A small application is provided 
as an example. In this section, the use of “HyperTerminal” software will be described. 
”Hyperterminal” is a Windows application that is typically installed on every Windows computer, 
you will find it under the “Program” - “Accessories” - “Communications” menu. This program will 
communicate with the machine on which the Gateway is running using communications port 
13000. 

NOTE – each XML command sent to a Kaleido-K2 must be followed by either of these two 
characters: 

• \n   (line feed) 

• \r  (carriage return) 

12.3 Remote Operation the Kaleido-Alto/Quad 

For remote operation, the ethernet port of the Kaleido Alto/Quad is continuously available to 
communicate with a remote computer. The functionality is similar to the Internal Gateway on the 
Kaleido-K2, but the Kaleido-Alto/Quad port is always “ON” and no configuration is required. 

Kaleido Alto/Quad can execute XML commands received via TCP/IP (Transmission Control 
Protocol/Internet Protocol). To send commands, you can use a Terminal Emulation (telnet) 
program or create your own application using the language of your choice (C++, Visual Basic, 
Java, …). In Section 3 below, the use of “Hyper Terminal” software will be described.  Hyper 
Terminal is a Windows application that is typically installed on every Windows computer, you will 
find it under the Program - Accessories - Communications menu. This program will communicate 
with the Kaleido-Alto/Quad using communication port 13000. 

12.4 Gateway Commands 

Kaleido supports the following commands through the Gateway access. Most of these apply to 
K2 and Alto/Quad, but some only apply to one platform, as indicated in the list. Furthermore, 
there may be differences in the use or syntax of some commands depending on the platform 
being used. All of these points are clarified in the list below, and in the detailed description of 
each command that follows. 

In particular, note that all commands sent to a Kaleido-K2 must end with \n (line feed) or \r 
(carriage return). Kaleido Alto/Quad does not require these to be sent, and will ignore them if 
present.. 

 



Command Applies to  Description 

openID  K2 AQ Opens a session with the specified Kaleido 

closeID  K2 AQ Closes a previously opened session. 

getKCurrentLayout  K2 AQ Gets the name of the current layout 

setKCurrentLayout  K2 AQ Loads a specific Layout. 

getKLayoutList  K2 AQ Gets the list of available Layouts. 

setKStatusMessage  K2 AQ Sets a Gateway Alarm to the specified state. 

setKChannel  K2 AQ Associates a Channel to the specified Monitor. 

setKDynamicText  K2 AQ Configures the text to display for a Dynamic Text. 

setKTimer  K2 AQ Configures the specified Count Down Timer. 

setKTimer2  K2 AQ Configures the specified Timer. 

setKTimerTrigger  K2 AQ Starts, stops or resets a Count Down Timer. 

setKFireAction  K2 AQ Fires the specified Action. 

setKEnableAlarmGroup  K2  Enables the Alarm Group. 

setKDisableAlarmGroup  K2  Disables the Alarm Group. 

setKSaveLayout  K2 AQ Saves the current layout 

getKAudioOut  K2 AQ Gets the identity of the current audio output 

setKAudioOut  K2 AQ Selects the audio to be monitored 

getKAudioOutVolume  K2 AQ Get the current audio monitoring output volume 

setKAudioOutVolume  K2 AQ Set the volume of the audio monitoring output 

getKAudioOutMode  K2 AQ Get the current audio monitoring output mode 

setKAudioOutMode  K2 AQ Set the audio monitoring output mode 

setKVerticalOffset   AQ Offset the graphic from display 

setKIcontrolMode   AQ Enable/Disable mouse color keying over video 

setKMouseColorA   AQ Mouse color to be keyed over video 

setKMouseColorB   AQ Mouse color to be keyed over video 

setKMouseColorC   AQ Mouse color to be keyed over video 



12.4.1 Command description 

Please note that: 

• the syntax must be exactly replicated when sending a command 

• every command sent to a Kaleido-K2 must  end with a line feed (\n) or Carriage return (\r) 
– these are not shown  in the descriptions below 

• Kaleido Alto/Quad does not require the line feed or carriage return, and will ignore it if it is 
present 

openID K2  AQ 

This command opens a session with the specified Kaleido .  

Please note that it is not necessary to open a session every time you want to send a 
command to the Gateway. Since opening a session takes a few seconds, it is 
recommended that you keep a session open as long as commands need to be sent. 

<openID>IP_ADDRESS_0_4_0_0</openID> 

Where: 

• IP_ADDRESS is the IP address of your destination Kaleido-K2. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

closeID K2  AQ 

This command closes a session with the specified Kaleido-K2 

<closeID>IP_ADDRESS_0_4_0_0</closeID> 

Where: 

• IP_ADDRESS is the IP address of the Kaleido-K2. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

Note that this command closes the current connection to the client via port 13000, so this 
connection must be re-established before another session can be opened. If you are 
using Hyperterminal, it will automatically re-establish the previous connection if you begin 
typing new commands, but other clients may require you to manually reconnect. 

getKCurrentLayout K2  AQ 



This command retrieves the name of the current layout. 

<getKCurrentLayout/> 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <kCurrentLayout>CurrentLayout.kg2 </kCurrentLayout> 

where CurrentLayout.kg2 is the name of the Layout currently in use by the Kaleido-K2. 
For Kaleido-Alto/Quad, the layout suffix is .xml instead of .kg2 

setKCurrentLayout K2  AQ 

This command loads the specified layout. 

<setKCurrentLayout>set LayoutToLoad.kg2</setKCurrentLayout> 

Where: 

• LayoutToLoad is the name of the Layout to load. This Layout must have been 
exported to the Kaleido-K2 prior to executing this command. Note that you can use 
the getKLayoutList command to retrieve the available layouts before sending this 
command. For Kaleido-Alto/Quad, the layout suffix is .xml instead of .kg2 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

getKLayoutList K2  AQ 

This command returns the list of Layouts that can be used on the Kaleido-K2. 

<getKLayoutList/> 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <kLayoutList> Layout1.kg2 Layout2.kg2 … AnAvailableLayout.kg2</kLayoutList> 

Where: 

• Layout1, Layout2 and AnAvailableLayout are the name of the Layouts that are 
available on the Kaleido-K2. For Kaleido-Alto/Quad, the layout suffix is .xml instead of 
.kg2 

 

 



setKStatusMessage K2  AQ 

This command associates an Alarm state with an id. The Kaleido-K2 can be configured to 
listen to this id using an Alarm Monitor, and thus report the state. This is a convenient 
way of reporting Alarms to the Kaleido-K2.  

<setKStatusMessage>set id=”AnId” status=”STATUS” 
message=”TheMessage”</setKStatusMessage> 

Where: 

• AnId is the identifier that will receive the new state. 

• Note:  Kaleido-Alto/Quad will only accept numeric vales for this parameter, in the 
range 0 to 1024 

• Status is any of the available statuses (OK, DISABLE, WARNING or ERROR). 

• TheMessage is reserved for future use, and will be ignored. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKChannel K2  AQ 

This command is used to assign a Channel to the specified Monitor in the current Layout. 

<setKChannel>set channelname=”ChannelName” monitor=”MonitorNumber” 
</setKChannel> 

Where: 

• ChannelName is the name of the Channel to assign to the specified Monitor. 

• MonitorNumber is the identifier of the Monitor to which the Channel must be assigned. 

Note: to get the identifier of Monitors of your current Layout press the TAB key of the 
Kaleido-K2’s keyboard or the SELECT key of the RCP. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKDynamicText K2  AQ 

This command is used to set the text of a UMD or Text Label Component that is 
configured to use Dynamic Text. Note that the Service ID for this component must be set 
to “Gateway” when the layout is created in KEdit in order for this command to work. 



<setKDynamicText>set address=”Address” text=”NewText” </setKDynamicText> 

Where: 

• Address is the configured Text Address of the UMD or Text Label Component. 

• Note:  Kaleido-Alto/Quad requires a numeric value in the range 0-1024 

• NewText is the text to display. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKTimer K2  AQ 

This command is used to configure the specified Count Down Timer Component. 

<setKTimer>set id=”TimerID” preset=”HH:MM:SS” direction=”Direction” loop=”Loop” 
</setKTimer> 

Where: 

• TimerID is the id or name of the Count Down Timer Component to modify. 

• HH:MM:SS is the preset to associate to the Count Down Timer Component. 

• Direction is the direction to count, this value can be UP or DOWN. 

• Loop indicates if the counter must count continuously. This value can be either ON or 
OFF. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

 

setKTimer2 K2  AQ 

This command is used to configure a Timer in the Kaleido system 

<setKTimer2>set TimerName="NAME" StartTime="HH:MM:SS:FF" 
PresetTime="HH:MM:SS:FF" TimerMode="UP" EndMode="STOP" </setKTimer2> 

Where: 

• NAME is the name assigned to the Timer in the Timer Configuration panel accessed 
from the Timer Browser. 



• StartTime may be one of the following: 

• HH:MM:SS:FF – time in hours:minutes:seconds:frames at which this Timer will 
start its count, depending on its configuration and presence of triggers. Note that 
if the HOURS is 00, the start time is deemed to be the previous midnight, 
whereas if HOURS is 24, it is considered to be the next midnight. This allows the 
timer to decide whether it should be counting or waiting to start when it 
compares the start time to the current time. (Note: the present implementation 
allows the user to send “Frames” information, but it is not used by the timer, 
which will start on the exact second) 

• NOW – the Timer will start counting immediately upon receiving the command 

• WAIT – the Timer will not start until it receives a setKTimerTrigger gateway 
command with the argument START 

• PresetTime  may be one of the following: 

• Count duration (hours:minutes:seconds:frames) for Count Up and Count Down 
modes,  

• End time (hours:minutes:seconds:frames) for the Remaining Time mode. 

• Note: the present implementation allows the user to send “Frames” information, 
but it is not used by the timer, which will use count durations or end times based 
on seconds. 

• Time Mode is the operating mode of the timer. Possible values are: UP, DOWN, 
REMAINING 

• EndMode defines what is to happen when the Timer reaches the end of its count. 
Possible vales are: LOOP, STOP, OVERRUN 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

 

setKTimerTrigger K2  AQ 

This command is used to control the specified Count Down Timer Component. The Count 
Down Timer can be started, stopped or reset. 

<setKTimerTrigger>set id=”TimerID” trigger=”Trigger”</setKTimerTrigger> 

Where: 

• TimerID is the id of the Count Down Timer Component to control. 

• Trigger is the action that the Count Down Timer must do. This value can either be 
START, STOP or RESET. 



Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKFireAction K2  AQ 

This command is used to fire the specified Action. 

<setKFireAction>set name=”NameOfTheActionToFire”</setKFireAction> 

Where: 

• NameOfTheActionToFire is the name of the Action to be executed. The Action must 
have been exported to the Kaleido-K2 in order to be executed. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKEnableAlarmGroup K2 

Note:  this command is not supported by Kaleido-Alto/Quad 

This command enables the specified Alarm Group. 

<setKEnableAlarmGroup>set 
name=”NameOfTheGroupToEnable”</setKEnableAlarmGroup> 

Where: 

• NameOfTheGroupToEnable is the name of the Alarm Group to enable. 

Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKDisableAlarmGroup K2 

Note:  this command is not supported by Kaleido-Alto/Quad 

This command is used to disable the specified Alarm Group. 

<setKDisableAlarmGroup>set 
name=”NameOfTheGroupToDisable”</setKDisableAlarmGroup> 

Where: 

• NameOfTheGroupToDisable is the name of the Alarm Group to disable. 



Gateway response: 

• <nack/>: the Gateway was not able to recognize the command. 

• <ack/>: the command was recognized by the Gateway. 

setKSaveLayout K2  AQ 

This command allows the user to save the currently displayed layout to a file. 

• <setKSaveLayout>set name=”FileName”</setKSaveLayout> 

Where: 

• FileName  is the name of the file that will contain the Layout. 

NOTE: do not specify an extension to the file name, as the file extension “kg2” is 
hardcoded for the Kaleido-K2 Layouts. 

Gateway response: 

• <ack/> The command was correctly interpreted and executed. 

• <nack/> The command wasn’t executed. 

getKAudioOut K2  AQ 

This command allows the user to get the selected Audio Monitoring Output 

• <getKAudioOut/> 

Returned value can be any of: 

• <nack/> The command was not executed (bad spelling).  

• <kAudioOut>DETAILS</kAudioOut> The command was executed 

 DETAILS will vary depending on the type of audio output detected. 

When no audio output is currently being monitored:  

• <kAudioOut>Type="NONE"</kAudioOut>. 

When the format is STREAMING, the returned value indicates the IP address and the 
Feed ID of the source using the following syntax: 

• <kAudioOut>Type=”STREAMING” IP=”999.999.999.999” FeedID=”XX”</kAudioOut> 

Where: 

999.999.999.999 is the IP of the machine from where the stream occurs. 

XX is the identifier of the feed to use. 



When the format is an AUDIO CARD, the returned value indicates which audio card input 
is being monitored: 

• <kAudioOut> Type=”AUDIOCARD” Input=”999”</kAudioOut> 

Where: 

999 indicates the input from the card. 

When the format is EMBEDDED, the returned value will contain the video input, the 
group and the AES used. The syntax will be: 

• <kAudioOut>Type=”EMBEDDED” Input=”AAA” Group=”BB” AES=”X”</kAudioOut> 

Where: 

AAA indicates the video input. 

BB indicates the group. Valid values range from 1 to 4. 

X indicates the AES. Valid value can be either 1 or 2. 

setKAudioOut K2  AQ 

The user can select the audio to be monitored by using this Gateway command. The 
syntax of the command will differ if the user indicates to monitor audio coming from a 
stream (Note – streaming sources are not supported by Kaleido Alto/Quad), from an 
audio card, from an embedded source or no audio at all. In general, you can select any 
audio source to be monitored, even if this source is not represented in an audiometer on 
the current layout. 

<setKAudioOut>DETAILS</setKAudioOut> 

DETAILS will differ depending on the type of audio source being selected for monitoring, 
as shown below. 

Gateway response:  

• <ack/> The command was correctly interpreted. 

• <nack/> The command was not executed (spelling error or invalid audio source). 

DETAILS: 

To select a STREAMING source (Kaleido-K2 only), format the command as follows: 

• <setKAudioOut>set Type=”STREAMING” IP=”999.999.999.999” 
FeedID=”XX”</setKAudioOut> 

Where: 

999.999.999.999 is the IP of the machine from where the stream occurs. 

XX is the identifier of the feed to use. 



To select an AUDIO CARD source, format the command as follows: 

• <setKAudioOut>set Type=”AUDIOCARD” Input=”999”</setKAudioOut> 

Where: 

999 indicates the input from the card. 

To select an EMBEDDED source, format the command as follows: 

• <setKAudioOut>set Type=”EMBEDDED” Input=”AAA” Group=”BB” 
AES=”X”</setKAudioOut> 

Where: 

AAA indicates the video input. 

BB indicates the group. Valid values range from 1 to 4. 

X indicates the AES. Valid value can be either 1 or 2. 

To STOP audio monitoring and MUTE the audio output: 

• <setKAudioOut>set Type=”NONE”</setKAudioOut> 

You may select any audio for monitoring, independent of whether it is being metered in 
the current Layout, with the exception that STREAMING sources must be part of the 
current layout. 

• If the source is included in the layout, the meter assigned to it will be highlighted. 

• If the source is not included in the layout, the sound will be routed to the audio 
monitors, but there will be no indication in the layout of the source. 

 

getKAudioOutVolume K2  AQ 

This command retrieves the Audio Monitoring Volume currently used: 

• <getKAudioOutVolume/> 

The returned value will have the form: 

• <kAudioOutVolume>volume=”XX” </kAudioOutVolume> 

Where: 

XX The value, expressed in dB, at which the Audio Monitoring volume is set. This 
value ranges between –90dB and 0. 

• <nack/> will be returned if the command was misspelt. 

 



setKAudioOutVolume K2  AQ 

This command sets the Audio Monitoring Volume: 

• <setKAudioOutVolume>set volume=”XX”</setKAudioOutVolume> 

Where: 

XX Value expressed in dB at which the volume will be set.  

 Valid values range from –90dB to 0dB. 

Returned value will be one of: 

• <ack/> The command was correctly interpreted. Volume was set to its new 
value. 

• <nack/> The command was not executed, due to bad spelling or invalid 
parameter. The volume remains unchanged. 

Note that if the audio is muted, then it shall be un-muted after this command. 

 

getKAudioOutMode K2  AQ 

This command retrieves the Audio Monitoring Mode currently used: 

• <getKAudioOutMode/> 

Returned value will have the form: 

• <kAudioOutMode>mode=”XXXXX”</kAudioOutMode> 

 Where: XXXXX is the mode, which can be any of NORMAL, MUTE or –20dB. 

• <nack/> The command was misspelled. In this case the Audio Monitoring Mode 
remains unchanged. 

 

setKAudioOutMode K2  AQ 

To set the Audio Monitoring Mode the following command will be used: 

• <setKAudioOutMode>set mode=”XXXXX”</setKAudioOutMode> 

Where: 

XXXXX is the value at which the mode must be set. Valid values are NORMAL, MUTE 
and –20dB. 

Returned value will be any of: 



• <ack/> The command was correctly interpreted. The Audio Monitoring Mode 
was set to the specified value.  

• <nack/> The command was not executed, due to bad spelling or invalid 
parameter. The Audio Monitoring Mode remains unchanged. 

setKVerticalOffset AQ 

This command is used to offset the graphic vertically on the display 

• <setKVerticalOffset>set offset="88"</setKVerticalOffset> 

Where offset is the number of lines to offset, 0 to 175. 

setKIcontrolMode AQ 

This command is used to enable the Alto/Quad to key the detected mouse colors on 
video. 

• <setKIcontrolMode>set mode="0"</setKIcontrolMode> 

Where: 

Mode = 0, Color not keyed, Mode = 1, color key enabled. 

setKMouseColorA AQ 

This command is used to set a color to key. 

• <setKMouseColorA>set mouseColorA= FF00FF00"</setKMouseColorA> 

mouseColorA is defined as FFBBGGRR 

BB: the blue component. 

GG: the green component. 

RR: the red component. 

setKMouseColorB AQ 

This command is used to set a color to key. 

• <setKMouseColorB>set mouseColorB= FF00FF00"</setKMouseColorB> 

mouseColorB is defined as FFBBGGRR 

BB: the blue component. 

GG: the green component. 

RR: the red component. 

setKMouseColorC AQ 



This command is used to set a color to key. 

• <setKMouseColorC>set mouseColorC= FF00FF00"</setKMouseColorC> 

mouseColorC is defined as FFBBGGRR 

BB: the blue component. 

GG: the green component. 

RR: the red component. 

 



13 A typical session 

Here is a description of how to open and close a typical session during which you will use these 
commands to operate a Kaleido. You can open sessions with multiple Kaleidos simultaneously; 
each session will have its own window on your desktop. 

• If you are using a Kaleido-K2, make sure the internal gateway is turned ON, and the MT-
gateway is turned OFF (see section 1.2) 

• If your environment includes a Miranda iControl Application Server, see the Application 
Server’s manual for a discussion of appropriate network configurations. 

Open the HyperTerminal software on another computer. 

• From the “Program” menu choose “Accessories”, “Communications” and “HyperTerminal”.  

A dialog will appear, asking you to enter a name for the connection and to select an icon. 

 

A second dialog, “Connect To”, will appear. 

• In the “Connect using” dropdown field choose “TCP/IP (Winsock)”. 

Two new fields will appear. 

• In the “Host address” field enter the IP address of your Kaleido  

• In the “Port number” field enter “13000”. This indicates that connection to the Kaleido will 
be established via the port 13000.  

• Click on the “OK” button. 



 

To be able to see the typed characters: 

• Select “Properties” from the “File” menu, the “Properties” dialog box appears. 

• Go to the “Settings” tab, click on the “ASCII Setup…” button located at the bottom of the 
dialog. 

• Select “Echo typed characters locally”. 

 

• Click on the “OK” button and click again on the “OK” button from the “Properties” dialog. 

The typed characters will appear in the console. 



Commands can be sent to the Gateway while a session is open. There is no maximum number of 
commands that can be sent in a session, and it is recommended to keep a session open as long 
as there are commands to send, since opening a session takes a few seconds. Here is a 
simplified example of a session: 

Open a session 

send command 
send command 
… 
send command 

Close the session. 

Remember that all commands sent to a Kaleido-K2 mus t end with a line feed (\n) or 
carriage return (\r). These are not required by a K aleido Alto/Quad and will be ignored 
if present. 

To open a session enter the openID command using the IP address of the Kaleido with which the 
connection has to be established. 

 

 

If the Gateway receives the command and recognizes it, it will respond with the following: 

 

 

If the command cannot be recognized the following message will appear: 

 



The Kaleido is now ready to receive commands. 

When no more commands need to be sent to the Kaleido , close the link to the Kaleido using the 
closeID command. 

 

 

To end the communication session, select the “Disconnect” icon from the toolbar. 

 

 

 



14 SNMP Traps 

The Kaleido K2 can send 5 categories of traps. The categories are Video, Audio, GPI, VBI and 
System. They are discussed individually in sections 14.2 to 14.6 below. 

14.1 Enabling SNMP Agents -  Trap Reporting and Pol ling 

In order to reduce network activity, by default the Kaleido-K2 SNMP agent is disabled. To enable 
SNMP traps reporting and polling, the Kaleidok2.properties file must be modified. Here is how it’s 
done: 

• From your Kaleido-K2’s desktop, double click on the icon “My Computer”. 

• Navigate to “C:\iControl\Startup\” and open the file “Kaleidok2.properties” using the 
Notepad (right click on the “Kaleidok2.properties” file and select “Notepad” from the “Open 
With” menu). 

• At the end of the file, you have the following lines: 

#Enable SNMP traps for VIDEO status, audio status (card and embedded), gpi in. 

# Entry must be separated by ','. 

#Possible values--> NULL => The system will not send any traps. 

#  --> any combination of VIDEO, AUDIO, GPI, VBI or SYSTEM  

SnmpEnabledTraps=NULL 

#Snmp manager IP addresses is the list of managers that should receive the Kaleido 
SNMP traps. IPs must be separated by ',' ex: 192.168.103.2,192.168.105.6. 

#possible values--> any valid IP address. 

#  --> default value is the broadcast IP : 255.255.255.255  

IPAddresses=255.255.255.255. 

• After the SnmpEnabledTraps replace “NULL” with the category of traps you want to send. 
You have the choice between VIDEO, AUDIO, GPI, VBI or SYSTEM. You can put any of 
these separated by a comma (,), being careful that no blank spaces are included.. 

• After the IPAddresses replace the broadcast IP with the SNMP manager’s IP address. 
You can enter several managers; just separate the IP addresses by a comma (,). Note 
that if you are sending error messages to a GSM server using traps, the GSM server’s IP 
address must be included here. 

• Save your changes using the Save item in the File menu. 

• Close the Notepad editor. 

• Restart the Kaleido. 



The statuses reported by the Kaleido system use the Miranda and Kaleido’s SNMP MIB. 

All Kaleido MIBs start with 1.3.6.1.4.1.3872.9, a concatenation of the Miranda OID 
(1.3.6.1.4.1.3872) and the Kaleido-K2 OID (9). 

14.2 Video MIB (Trap type = 1) 

All Kaleido Video Status Oids start with the VideoOidPrefix: 

VideoOidPrefix = KaleidoK2MIB.VideoStatusTable.VideoStatusEntry.VideoStatus  

= 1.3.6.1.4.1.3872.9.1.1.3 

The Video Status Oid is a concatenation of VideoOidPrefix, VideoChannelIndex, ErrorType and 
ErrorValue. 

VideoChannelIndex: 

Represents the video input reported by this status [between 1 and 32]. 

ErrorType:  

Represents the type of the error reported. Four errors can be reported by the Kaleido-K2 for a 
Video input: 

Loss of Video 2 

Luma Too High 3 

Freeze Detection 5 

Black Detection 6 

ErrorValue (Integer): 

Represents the status itself.  

Disable 0 

Ok 1 

Warning 2 

Error 3 

So the Video Status Oid will have the following form: 

1.3.6.1.4.1.3872.9.1.1.3.(1 to 32).(2,3,5 or 6):INTEGER:(0,1,2 or 3) 

For example, if the Kaleido reports that the Video input 3 is no longer detected (loss of video), 
then you should receive this trap: 

1.3.6.1.4.1.3872.9.1.1.3.3.2:INTEGER:3 



14.3 Audio MIB (Trap type = 2) 

All Kaleido Audio Status Oids start with the AudioOidPrefix: 

AudioOidPrefix = KaleidoK2MIB.AudioStatusTable.AudioStatusEntry.AudioStatus 

= 1.3.6.1.4.1.3872.9.2.1.7 

The Audio Status Oid is a concatenation of AudioOidPrefix , SourceType , Channel , Group , AES, Side , ErrorType  
and ErrorValue  

SourceType: 

Represents the type of the audio source. 

Audio Card  1 

Embedded  2 

Channel: 

In case of Embedded audio, it represents the video input [between 1 and 32]. 

In case of an Audio Card input, it represents the audio input [between 1 and 48]. 

Group: 

In case of Embedded audio, it represents the group [between 1 and 4]. 

In case of an Audio Card input, it will always be 0. 

AES: 

In case of Embedded audio, it represents the AES [1 or 2]. 

In case of an Audio Card input, it will always be 0. 

Side: 

Indicates if the error reported concerns the left channel only, the right channel only or both 
channels (stereo). 

Left 1 

Right 2 

Stereo 3 

ErrorType: 

Represents the type of the error reported. Four errors can be reported by the Kaleido-K2 for an 
audio input: 

Audio Silence 2 



Overload 3 

Mono Detected 4 

Out Of Phase 5 

ErrorValue (Integer): 

Represents the status itself. 

Disable 0 

Ok 1 

Warning 2 

Error 3 

So the Audio Status Oid will have the following form: 

Embedded: 

1.3.6.1.4.1.3872.9.2.1.7.2.(1 to 32).(1 to 4).(1 or 2).(0,1 or 2).(2 to 5):INTEGER:(0,1,2 or 
3) 

For example, if the Kaleido reports that the audio extracted from Video input 3, group 2, AES 1, 
Stereo is out of phase, then you should receive this trap: 

1.3.6.1.4.1.3872.9.2.1.7.2.3.2.1.2.5:INTEGER:3 

Audio card: 

1.3.6.1.4.1.3872.9.2.1.7.1.(1 to 48).0.0.(0,1 or 2).(2 to 5):INTEGER:(0,1,2 or 3) 

For example, if the Kaleido reports that audio input 36 right is in silence, then you should receive 
this trap: 

1.3.6.1.4.1.3872.9.2.1.7.1.36.0.0.1.2:INTEGER:3 

14.4 GPI Input MIB (Trap type = 3) 

All Kaleido GPI Input Status Oids start with GpiInOidPrefix: 

GpiInOidPrefix = KaleidoK2MIB.GpiStatusTable.GpiStatusEntry.GpiStatus 

= 1.3.6.1.4.1.3872.9.3.1.2 

The GPI Input Status Oid is a concatenation of GpiInOidPrefix , GpiInIndex , and State . 

GpiInIndex: 

Represents the GPI Input [between 1 and 66]. 



State (Integer): 

Represents the state of the GPI Input. 

Off  0 

On  1 

So the GPI Input Status Oid will have the following form: 

1.3.6.1.4.1.3872.9.3.1.2.(1 to 66):INTEGER:(0 or 1) 

For example, if the Kaleido reports that GPI Input 18 is on, then you should receive this trap: 

1.3.6.1.4.1.3872.9.3.1.2.18:INTEGER:1 

14.5 VBI/ANC MIB (Trap type = 4) 

All Kaleido VBI/ANC Status Oids start with VBIANCOidPrefix: 

VBIANCOidPrefix = KaleidoK2MIB.VBIANCStatusTable.VBIANCStatusEntry.VBIANCStatus 

= 1.3.6.1.4.1.3872.9.4.1.4 

The VBI/ANC Status Oid is a concatenation of VBIANCOidPrefix, IndexType, VideoInput, 
ErrorType and Value. 

IndexType: 

Represents the type of error reported. 

CC1 Presence 1 

VCHIP Presence 9 

Teletext Page 1  10 

Teletext Page 2  11 

Teletext Page 3  12 

Teletext Page 4  13 

VideoInput: 

Represents the Video Input affected by this error [between 1 and  32]. 

ErrorType 

In case of CC1 or VCHIP, it will always be 1. 

In case of a Page of Teletext, the Kaleido can report 2 errors: 

Presence of the page 1 



Presence of Subtitling 2 

Value (Integer): 

Represents the status itself. 

Disable 0 

Ok 1 

Warning 2 

Error 3 

So the VBI/ANC Status Oid will have the following form: 

1.3.6.1.4.1.3872.9.4.1.4.(1, 9, 10, 11, 12 or 13).(1 to 32).(1 or 2):INTEGER:(0,1,2 or 3) 

For example, if the Kaleido reports the presence of subtitling in the third extracted page of 
Teletext on Video input 7, then you should receive this trap: 

1.3.6.1.4.1.3872.9.4.1.4.12.7.2:INTEGER:1 

14.6 System Power Supply MIB (Trap type = 5) 

The Kaleido System Power Supply Status Oid starts with the SystemOidPrefix: 

SystemOidPrefix = KaleidoK2MIB.SystemStatusTable.SystemStatusEntry 

= 1.3.6.1.4.1.3872.9.5.1 

The System Power Supply Status Oid is a concatenation of SystemOidPrefix and Value. 

Value (Integer): 

Ok 1 

Error 3 

So the system Power Supply Status Oid will have the following form: 

1.3.6.1.4.1.3872.9.5.1:INTEGER:(1 or 3) 

For example, if the Kaleido reports that its Power Supply has a problem, then you should receive 
this trap: 

1.3.6.1.4.1.3872.9.5.1:INTEGER:3 



15 TSL, Andromeda, Encoda and Kalypso 

TSL, Andromeda, Encoda and Kalypso are third-party devices that supply Kaleido with tally 
information and dynamic text for UMDs, Text Labels and Tallies. 

The interface between Kaleido and third-party devices is managed using Miranda’s iControl 
system. Each such device is addressed by Kaleido using its MirandaLongID, which is an address 
within the iControl protocol. This address must be installed manually on the Kaleido by the user. 

The address can be found using the iNavigator application, which is part of iControl, once the 
device is installed on the network. 

All components in a Kaleido layout that obtain information from a third-party device require the 
Service ID of that device to be entered at their configuration panel. The Service ID is either the 
Miranda LongID, or an alias that points to the LongID. An alias is a user-selected term that is 
easier to remember and enter than the LongID. 

To install a device’s LongID (and preferably an alias) on the Kaleido-K2, proceed as follows: 

1. First, get the service’s Long ID: 

• From your Kaleido-K2’s desktop, double click on the icon “My Computer”. 

• Navigate to “C:\iControl\Startup\” and open the file “Kaleido.log” using the Notepad (right 
click on the “Kaleido.log” file and select “Notepad” from the “Open With” menu).  

• Within Notepad, press “Ctrl-F” or select “Find…” from the Edit menu and in the “Find 
What” section enter “serviceAdded called for ID:”. 

Each entry found will give you the Miranda Long ID of an iControl service found on the 
network. Continue looking through the file until you find the Long ID of your TSL,  Andromeda 
or Encoda. 

The Long ID of a TSL should have the following form:  

10.9.8.7_COM1_TSL 

The Long ID of an Andromeda should have the following form:  

10.9.8.7_COM1_UMD_00_SLOTXX_MODULEIDXXXX 

The Long ID of an Encoda should have the following form: 

10.9.8.7_COM1_ENCODA 

The Long ID of a Kalypso should have the following form: 

10.9.8.7_COM1_KALYPSO 

 



2. Find the file C:\Icontrol\Startup\KG2Config.xml on the Kaleido frame and open it in Notepad. 
The service for the third-party device will be added in the section <OtherServices>, which will 
look like this: 

<OtherServices> 

<!-- Use the same syntax as above to find services other than Kaleido Services --> 

<!-- AlphaNumeric Label is permitted here, example below:--> 

<Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> --> 

</OtherServices>  

3. Supported third-party devices will then be added into this section as per the indicated format. 
See the Installation Guide for more detailed instructions on installing and connecting to third-
party devices. 

TSL (supplies dynamic text for UMDs and Text Labels , and Tally statuses) 

<Service ServiceLabel="TSL" id="192.168.1.2_COMX_TSL" />  

Where: 

• TSL (within the quotes) is the alias (and could be any user-selected name); 

• 192.168.1.2 is the IP address of the TSL (as found using iNavigator);  

• X in COMX_TSL is the COM port number assigned to the TSL service during the 
installation. 

Andromeda (Phillips) (supplies dynamic text for UMD s and Text Labels, and Tally 
statuses). 

<Service ServiceLabel="PHIL" id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX" 
/>  

Where: 

• PHIL (within the quotes) is the alias (and could be any user-selected name); 

• 10.3.4.9 is the IP address of the Kaleido (use the actual IP address of your Kaleido),  

• COM1 must be replaced by COM2 if you have configured the system to use the COM2 
port, 

• The remainder of the text is exactly as shown 

Encoda (supplies dynamic text for UMDs and Text Lab els)  

<Service ServiceLabel="ENC" id="192.145.10.2_COMX_ENCODA" />  

Where: 



• ENC (within the quotes) is the alias (and could be any user-selected name); 

• 192.145.10.2 is the IP address of the Encoda (as found using iNavigator);  

• X in COMX_ENCODA is the COM port number assigned to the Encoda service during 
the installation. 

Kalypso (supplies dynamic text for UMDs and Text La bels, and Tally statuses). 

<Service ServiceLabel="KAL" id="10.5.4.8_COM1_KALYPSO" />  

Where: 

• KAL  (within the quotes) is the alias (and could be any user-selected name); 

• 10.5.4.8 is the IP address of the Kalypso (as found using iNavigator);  

• COM1 must be replaced by COM2 if you have configured the system to use the COM2 
port, 

• The remainder of the text is exactly as shown 

 

If all four of these services are installed (as an example), the “Other Services” section 
becomes: 

<OtherServices> 

<!-- Use the same syntax as above to find services other than Kaleido Services --> 

<!-- AlphaNumeric Label is permitted here, example below:--> 

<Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> -->  

<Service ServiceLabel="TSL" id="192.168.1.2_COM4_TSL " /> 

<Service ServiceLabel="PHIL" 
id="10.3.4.9_COM1_UMD_00_SLOTXX_MODULEIDXXXX"  />  

<Service ServiceLabel="ENC" id="192.145.10.2_COMX_ENC ODA"  /> 

<Service ServiceLabel="KAL" id="10.5.4.8_COM1_KALYPSO"  /> 

</OtherServices>  

Now, you may enter the alias TSL, PHIL, ENC  or KAL  as the ServiceID in configuration panels 
for UMDs and Text Labels to identify one of these third-party devices as the source of their 
dynamic text.  

You may choose any convenient name for the alias; for example, the Phillips alias could be Dyn :  

<Service ServiceLabel="Dyn" id="10.3.4.9_COM1_UMD_00_S LOTXX_MODULEIDXXXX"  />   



16 Kalypso 

Kalypso is a service that conveys information about a production switcher’s configuration to other 
devices via an IP connection. Kaleido can use the Kalypso service to provide this information to 
the user via the UMD, Text Label and Tally components in a layout. The switcher must conform to 
the Kalypso protocol. 

16.1 Kalypso configuration 

The following figure shows a typical production switcher environment, with Kaleido connected to 
the production switcher inputs and outputs. Kaleido reads the Kalypso data from the PC running 
the Kalypso service, and presents the information to the user. 

 

 

Kaleido with Kalypso - configuration 

16.2 Setting up Kaleido to use Kalypso 

There must reside on Kaleido a Kalypso.properties file that defines two aspects of the service: 

• The port specification for communication with the switcher 



• The identification of the production switcher outputs carrying the Program and Preview feeds.  

Here is an example: 

#Com port definition for the service. 
ComPort=COM1 
BaudRate=38400 
DataBits=7 
StopBits=1 
Parity=EVEN 
 
#Program-Preview feed output information 
ProgramFeed=4 
PreviewFeed=5 

16.3 Using a UMD to indicate the Production Switche r 
configuration 

The Kalypso data includes a text component that describes the switcher configuration in terms of 
the source that appears at the output. Kaleido can decode this text component and display it on a 
UMD. 

Here is a sample configuration, showing the mix/effects busses, that can be used to illustrate the 
type of information available, and the options available to the user. 

 

Figure 2 - M/E configuration  

The user has four display options available: 

Option 1 

Show the number of the router input that is used as the background to the output. 

In the above example, Kaleido K2 UMD associated with Output 4 of the switcher will display:  

 Input 7 

Option 2 

Show the direct background input source for the signal seen on output 4 

In the above example, Kaleido K2 UMD associated with Output 4 of the switcher will display:   



 M/E3 

Option 3 

Show the combined data of options 1 and 2: 

In the above example, Kaleido K2 UMD associated with Output 4 of the switcher will display::  

 M/E3 > Input 7 

Option 4 

Show the Source ID of the current background feed.: 

16.3.1 Configuring the UMD to show Kalypso data 

In the UMD configuration panel, select the radio button for UMD Dynamic Text. 

In the ServiceID text box, enter the LongID or the alias for the computer running the Kalypso 
service. 

In the Text Address text box, enter the number of the routing switcher physical output (value from 
1 to 48) for options 1-3, or enter the address of the switcher (range 1-128) for option 4. 

In the Level text box, enter the number of the option you wish to use for text display (value from 1 
to 4)  

16.4 Using Tallies to identify Preview/Program sour ces 

The Tallies in a Monitor within a Kaleido layout displaying a video source can be used to show 
whether that source is included in the video signal appearing at the Preview and Program outputs 
of the production switcher. The necessary information is found in the Kalypso data. 

To use the Kalypso data for this purpose, it is necessary to create a Tally Alarm in the Alarm 
Browser, and then associate that alarm with the Tallies in the Monitor. When creating the Alarm, 
use the following settings: 



In the ServiceID  text box, enter the LongID or the 
alias of the computer running the Kalypso 
service. 

In the Text Address  text box, enter the number 
of the Production switcher input whose presence 
at the Preview or Production output will be 
signaled by the tallies (value from 1 to 128) 

Leave the Level  text box empty. 

 

 

 

16.4.1 Information display  

The Tallies in the monitor will display the information in the following manner: 
 

• Both Tallies OFF represent a source which is not used inside either the Preview output or the 
Program output 

• Both Tallies ON represent a source which is used inside both the Preview output and the 
Program output 

• Left Tally ON represent a source which is used only inside the Program output 

• Right Tally ON represent a source which is used only inside the Preview output 

 



17 PixelMetrix MPEG Analyzer 
 

 NOTE: The PixelMetrix DV Station MPEG Analyser is not supported in the current 
release of this software. The following material is  included in this manual for 
historical reference only. 

PixelMetrix is an MPEG analyzer which provides data stream identification and bandwidth usage 
analysis. 

The interface between Kaleido and third-party devices is managed using Miranda’s iControl 
system. Each such device is addressed by Kaleido using its MirandaLongID, which is an address 
within the iControl protocol. This address must be installed manually on the Kaleido by the user. 

The address can be found using the iNavigator application, which is part of iControl, once the 
device is installed on the network. 

All visual elements in a Kaleido Layout that obtain information from a third-party device require 
the Service ID of that device to be entered at their configuration panel. The Service ID is either 
the Miranda LongID, or an alias that points to the LongID. An alias is a user-selected term that is 
easier to remember and enter than the LongID. 

To install a device’s LongID (and preferably an alias) on the Kaleido, proceed as follows: 

1. Use iNavigator to locate the device on the network, and note its address (see the iNavigator 
manual for more details). 

2. Find the file C:\Icontrol\Startup\KG2Config.xml on the Kaleido frame and open it in Notepad. 
The service for the third-party device will be added in the section <OtherServices>, which will 
look like this: 

<OtherServices> 

<!-- Use the same syntax as above to find services other than Kaleido Services --> 

<!-- AlphaNumeric Label is permitted here, example below:--> 

    <Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> --> 

</OtherServices>  

3. Supported third-party devices will then be added into this section as per the indicated format. 
See the Quick Start Guide for more detailed instructions on installing and connecting to third-
party devices. 

PixelMetrix MPEG Analyzer (identification and bandw idth usage analysis) 

<Service ServiceLabel="PXL" id="10.3.4.10__DVStation_10.3.1.249_slot_4_TSP" />  

Where: 

• PXL (within the quotes) is the alias (and could be any user-selected name); 



• 10.3.4.10 is the IP address of the service (as found using iNavigator); 

• _DVStation_  identifies this as a PixelMetrix analyzer; 

• 10.3.1.249 is the IP address of the PixelMetrix frame  

• _SLOT4 identifies the slot in the PixelMetrix frame where the analyzer is installed; 

• The remainder is always _TSP 

If this service is installed (as an example), the “Other Services” section becomes: 

<OtherServices> 

<!-- Use the same syntax as above to find services other than Kaleido Services --> 

<!-- AlphaNumeric Label is permitted here, example below:--> 

<Service ServiceLabel="service1" id="xxx.xxx.xxx.xxx" /> -->  

<Service ServiceLabel="PXL" id="10.3.4.10__DVStation_1 0.3.1.249_slot_4_TSP"  /> 

</OtherServices>  

Now, you may enter the PXL in MPEG Monitor and MPEG Service Info configuration panels that 
receive their information from this PixelMetrix analyzer. 

You may choose any convenient name for the alias; for example, the PixelMetrix alias could be 
MPG:  

<Service ServiceLabel="MPG" id="10.3.4.10__DVStation_ 10.3.1.249_slot_4_TSP" />   



18 Control of an External Router by Kaleido-K2 

Kaleido-K2 can remotely control a router connected to its inputs, allowing access to many more 
sources for its Layouts than could be provided on-chassis. The router must be installed as a 
service accessible though IP for control purposes. It will have a Miranda LongID, and preferably 
an Alias, which can be used to identify it when configuring its operation. 

There are three basic aspects to the user interface to the router: 

• The user creates a Router Reference Table which identifies which output of which router is 
connected to a specific Kaleido-K2 input, and the level of that router in Miranda’s virtual 
router hierarchy. 

• In a component control panel, the user who specifies a Kaleido-K2 input that is connected to 
a Router must also identify the Router input that is to be routed through to the Kaleido-K2. 

• On the Kaleido-K2 output display, the user can right-click on a component that has an 
assigned Router input, and directly select which router input to display. 

All of these are explained in more detail in the following sections. 

18.1 Router Reference Table 

The Router Reference Table identifies the relationship between the Kaleido-K2 inputs and the 
Router. For each Kaleido-K2 input that is connected to a Router, it gives the name of the router 
(Miranda LongID or alias), the router output number, and the level of the router in Miranda’s 
virtual router hierarchy. The router input will be selected either from the Video Component 
Configuration panel or from the on-screen Kaleido-K2 output (see Router Input Selection) 

The Router Reference Table is accessible via KEdit from the view menu or using F4. This table is 
available only in online mode. 

 



To create a new reference, click on the new button. To modify an existing router reference, select 
it and click on the Edit button. In either case, the following panel will appear: It will be empty if 
New was selected. It will contain the existing data if Edit was selected. 

• Router ID is the Miranda LongID or the 
alias of the Router 

• Router level is the level of the router output 
that is connected to the Kaleido-K2 input. 
Level number starts at 0. Note that you can 
put several levels here separating them by 
a comma. Doing this will enable you to 
switch the same cross point on more than 
one level. 

• Router Output is the output of the router 
that is connected to the Kaleido-K2 Input. 
[enter a number between 1 and the number 
of the outputs on the router]. 

• Kaleido Input is the input of the Kaleido-K2 
you want to configure [enter a number 
between 1 and 32]. 

Click OK to accept the changes and return to 
the Router Reference Table. 

Click Cancel to exit this dialog and revert to the 
previous settings. 

 

18.2 Router input selection through a video compone nt 

The video input to a Monitor is selected on the Video Screen component Assignment tab of its 
Configuration Panel in KEdit. If the selected input is connected to a Router, then it is also 
necessary to specify the router input. This is done on the same panel tab, as shown in the 
following figure: 



Router Control:  

This section is active only if the selected 
Kaleido-K2 input (as specified in the 
Assign Video Input portion of this panel) is 
connected to a router output (as defined in 
the Router Reference Table). 

Working offline:  

Router Control is not available. 

Working online: 

The Router Input data entry box will 
dynamically display the current input 
assigned at the corresponding router 
output. The user can change the input 
selection from the box by typing in a new 
Router Input number (a numeral, 1 or 
higher). 

The router input selection is not part of the 
Channel information, as it is external to the 
Kaleido-K2. It will be saved as part of the 
Layout. Therefore, when a Layout is 
loaded, all the information identifying 
Monitor containing router inputs will be 
sent to the router. 

 



19 Configuring the Interface to iControl GSM 

Kaleido supports the Generic Status Message (GSM) protocol of Miranda’s iControl system. The 
protocol allows status messages to be sent and received by devices connected to an iControl 
network through an iControl application server running the GSM service. 

You must identify the GSM server that will be used to send and receive status messages in two 
different places: 

• Kaleido reports errors to a specified GSM server using SNMP traps. You must specify the IP 
address of the GSM server in the SNMP servers portion of the Kaleido properties file in order 
to activate this functionality. 

• You must specify the GSM server from which status messages will be received. This can be 
done from KEdit in the online mode only.  

From the View menu, select GSM Configuration, or use the shortcut Shift+F9 . The GSM 
Configuration panel opens  

GSM Serve IP: 

Use the pull-down list to select a GSM 
server from those available on the 
Kaleido’s network. 

Alias : 

Enter an Alias by which this server 
will be known to Kaleido. 

NOTE: it is obligatory to enter an 
alias. 

 

Set up an iControl GSM Device Alarm to use the incoming status messages in the Kaleido 
layout. 



20 Data Explorer 

The Data Explorer is a window that can be opened in KEdit from the View Menu: 

 

or by using the shortcut Shift+F5 . 

The Data Explorer gives the user access to information about certain categories of information 
created and stored in KEdit. In some cases the data can be modified via the Data Explorer, rather 
than by going back to the creation point in KEdit. 

The Data Explorer window is divided into two sections, as shown in the figure: 



Tree portion

Properties portion

 

The Tree portion  of the window shows the categories of data that can be accessed through the 
Data Explorer, and allows the user to expand the tree to find specific instances of those data 
types. 

The Properties portion  of the window shows the details of the data instance selected in the Tree 
portion, in a format appropriate to the data type. 

20.1 Channels in the Data Explorer 

Expand the Channels item in the Tree to find a channel of interest. The Data Explorer shows all 
Channels defined in the Kaleido, independent of whether they are associated with the current 
layout. Click on the Channel to display its details in the Properties portion. Note that you can drag 
the Data Explorer window boundaries to change its size, and drag the column headers to change 
column width, in order to see all the details in the properties portion.  

 



The channel properties are shown just as they would appear in the Monitor Configuration panel 
for a monitor to which this channel is assigned. 

20.2 Alarms in the Data Explorer 

The Tree portion of the Data explorer lists all existing Alarm groups (e.g. Montreal group). Within 
each Alarm group are listed all related alarms. Alarms not part of any group are listed at the same 
level in the tree hierarchy as Alarm groups. 

Expand the Alarms item in the Tree to find an Alarm of interest. The Data Explorer shows all 
Alarms defined in the Kaleido, independent of whether they are associated with the current 
layout. Click on the Alarm to display its details in the Properties portion of the Data Explorer. Note 
that you can drag the Data Explorer window boundaries to change its size, and drag the column 
headers to change column width, in order to see all the details in the properties portion.  

 

The Alarm properties are shown just as they would appear in the Alarm Browser.  

 

20.3 Actions in the Data Explorer 

Expand the Actions item in the Tree to find an Action of interest. The Data Explorer shows all 
Actions defined in the Kaleido, independent of whether they are associated with the current 
layout. Click on the Action to display its details in the Properties portion. Note that you can drag 
the Data Explorer window boundaries to change its size, and drag the column headers to change 
column width, in order to see all the details in the properties portion.  



 

The Action properties are shown just as they would appear in the Action Configuration panel. 

20.4 Key and Mouse Operations in the Data Explorer 

 

KEY, MOUSE ACTION AND 
COMBINATIONS 

ACTION 

Click on a specific item Put the focus on that specific item and displays its 
details in the lower part of the Data explorer window. 

Click on a specific item + ↑ or ↓ 
keys 

Put the focus on the specific item, then move up or 
down through the list while changing the focus item. 

Click on the ‘+’ sign beside an item Expands the list of related items 

Click on the ‘-’ sign beside an item Collapse the list of related items 

Click on a specific channel + 
Delete key 

Only supported for Channels: Delete the selected 
channels from the existing channel list. A popup 
window will ask for confirmation. 

Click on a specific channel + 
CTRL-D 

Same as  Click on Channel + Press Delete key 

Press CTRL while clicking on 
multiple items 

Select all the clicked items. The operations available 
for a single item (i.e. Delete key, right-clicking, CTRL-
D) are valid for a multiple selections. 

Press SHIFT while clicking on 
multiple items 

Select the clicked items, plus all items between the 
clicked items 

 



21 MultiData Browser 

The MultiData Browser is a window that can be opened in KEdit from the View Menu:  

 

or by using the shortcut Shift+F8 : 

MultiData in Kaleido refers to combinations of different sources whose data can be displayed in a 
single text window. MultiData is one of the options for selecting the source of text for a Text Label 
in a Kaleido layout. 

In the MultiData Browser window, 

• Click New to open a blank MultiData Configuration panel 

• Click Edit to open the MultiData Configuration panel for the previously-defined MultiData 
source selected in the window 

• Click Remove to delete the previously-defined MultiData source selected in the window 

21.1 MultiData Configuration panel 

The MultiData Configuration Panel appears as shown here. 



Set the MultiData Source Name 

Enter a name for the MultiData Source that will 
be defined in this configuration panel. 

MultiData Element List 

This window includes a line for each element 
that makes up this MultiData source. The two 
columns show:  

MultiData Type : Click on the entry in this 
column to see a pulldown list of all available 
types. The choices are: 

• <none MD> 

• Dolby E Data  

• Video Data 

• XDS  

Assignment :  This entry shows the source of 
the data to be reported for this MultiData 
element. The assignment is made in the 
Display Information selection panels described 
below, and cannot be changed directly from 
this panel. 

Element List management controls 

Five pushbuttons are located below the 
MultiData element list window: 

 

Up:  move the selected element towards the top of the list 

Down:  move the selected element towards the bottom of the list 

New…:  adds a new blank element to the list. This element will have the <no type> attribute. 

Edit…:  opens the Display Information selection panel for this element (if the type is not <no 
type>) 

Remove:  delete this element from the list 

 

21.2 Display Information panels 

The Display Information panel is used to assign an input to a MultiData element, and to define the 
specific information that will be displayed when the MultiData source is selected as the source of 
text in a text label. 

The Display Information panels can be opened in two ways: 



• When a new type is assigned using the pulldown list in the MultiData Element List window of 
the MultiData Configuration panel 

• When the Edit button on the MultiData Configuration panel is pushed with an element of 
type Video Data, XDS Data or Dolby E Data  selected 

VideoData Display Information 

Assign Video Input:  enter the number of the 
Kaleido video input that this element will report. 

Display Legend:   click this checkbox to show 
text identifying the data as well as the data 
itself. 

Select Video Info to Display:   click the 
checkboxes to select the information that will 
be displayed for this element: 

o Video input format  

o WSS  

o SCANSYS (Video Index) 

o AFD (4 bits) (Video Index)  

o AFD (3 bits) (Video Index)  

o AFD (HD ANC)  

o SID  

  

 

 

XDS Data Display Information 

Assign Video Input:   enter the number of the 
Kaleido video input that this element will report. 
Click the Display Legend checkbox to show 
text identifying the data as well as the data 
itself 

Select XDS Data to Display :  click the 
checkboxes to select the information that will 
be displayed for this element: 

o Network Name  

o Channel Number  

o Program Name  

o VChip Rating  

o Program Length  

o Program ID  

o Time Zone  

o Station ID 

o TSID 

 



o Program Type 

o Program Description  

o Elapsed Time  

o Time of Day 

 

Dolby Display Information 

Assign Video Input: 

Specify the input that is to be used. Note that 
this must be an HD input to an HDX card.  

Display Legend:  click this checkbox to show 
text identifying the data as well as the data 
itself  

Select Dolby-E Info to Display: 

Use the checkboxes to select whether to 
display: 

Program Configuration – a short-form 
description of the channel configuration 

Program1 Dialogue Loudness Normalization 
level – reported in dB. 

 

 

 



22 Timer Browser 

A Timer is an entity within the Kaleido system that counts time. The most useful feature of a 
Timer is its ability to respond to Gateway commands sent from an automation system, and to 
synchronize to Kaleido’s external LTC time code in order to create precise count-up and count-
down sequences. The information generated by the Timer is presented in the Kaleido display by 
a Count Down Timer component. The Timer can fire an action at the End of Count. 

The Timer Browser provides the access point for creating and configuring Timers. It can be 
opened in KEdit from the View Menu: 

   

or by using the shortcut Shift+F7  

22.1 Creating a Timer 

In the Timer Browser window: 

• click New to create a new timer 

• click an existing timer in the list to select it and then: 

• click Edit to modify its configuration 

• click Remove to delete it from the list.  

If you have clicked New or Edit, the Timer Configuration window will open.  



Timer Information:   

If this is a new Timer, enter a name or number 
in the Timer Name or ID box. 

• NB: if you expect to export a layout using 
this timer to Kaleido Alto or Kaleido-Quad, 
use a number in the Name or ID box, as 
Alto/Quad does not accept text strings for 
names. 

The information reported below the Timer 
Name or ID box shows the current status. The 
information is entered via the Gateway, and 
cannot be modified using this panel. 

End Count Action: 

From the pull-down list of available actions, 
select one to be fired when the timer count 
ends. 

Select Sync Source: 

Click the checkbox to synchronize this timer 
with the LTC external source identified in the 
adjacent text box. 

• Kaleido-K2 is always identified as A 
 

Timer information 

The following information describes the current 
status of a Timer: 

 

Timer Preset:  This is the count duration for 
Count Up and Count Down modes, and the 
End time for the Remaining Time mode 

Format:  HH:MM:SS 

Start Time:  This is the time at which the Timer 
is to start counting There are three options: 

Time in HH:MM:SS:  start counting when the 
LTC input equals this time. If no time is 
entered, the count will start immediately upon 
receipt of the command.  

Note that the HH field allows the distinction to 
be made between previous and next day. If HH 
is 00, the time is presumed to be the previous 
midnight, while if it is 24, the next midnight is 
assumed. As an example, if you enter a start 
time of 00:12:00, and the current time is 
00:12:15 when you trigger a Timer with a 
Preset Time of 00:01:00, the timer will begin to 
run immediately, and will adjust it’s count to 
end at 00:13:00. On the other hand, if the start 



time is 24:12:00, the timer will not start until the 
next day. 

NOW:  start counting immediately 

WAIT:   start counting when a Gateway 
<setKTimerTrigger> command is received with 
START as the trigger action. 

Count Mode:  There are three options: UP:  Count Up from zero (or an intermediate 
time if it can be calculated) to the Preset Time 

DOWN:  Count Down from the preset time (or 
an intermediate time if it can be calculated) to 
zero. 

REMAINING:    Calculates the time difference 
between the Preset time and NOW, and then 
counts down to reach zero at the preset time. 
In this case, the Preset Time is treated as a 
time of day, and not a duration. 

 

End Mode:  what happens when the timer 
reaches its end of count. There are three 
options: 

 

LOOP:  restart the timer and repeat it’s cycle 
(N/A for the Remaining Time mode) 

STOP: stop the timer 

OVERRUN: count through the end point, and 
continue to count away from the end point. 
Note that the Count Down Timer display at the 
Kaleido output will change to show that the 
Timer is in the Overrun mode (a + appears 
along with the arrow icon), and it will display 
the elapsed time since the end of count was 
reached. 

 

 

22.2 Exporting a Timer  

If a Timer is created in KEdit in the offline mode, it’s details must be sent to the destination 
Kaleido-K2 when the Layout is applied online in order for it to function properly. 

• In the File - Apply Layout Online  panel, check the Timer checkbox to send details of the 
timer to the destination Kaleido-K2 when the layout is applied online. 



Timers are included in the data when a layout is exported to a Kaleido Alto/Quad, but be aware 
that timers must have numeric names to be recognized by an Alto or Quad. 

22.3 Using Gateway Commands to operate a Timer 

The most effective way to use a timer for precise timing applications is to configure and trigger it 
via the Gateway. An automation system can send the requisite commands, thereby integrating 
the Kaleido’s on-screen timers into the system. 

A single gateway command is used to control timers: 

<setKTimer2>set TimerName="timername1" StartTime="HH:MM:SS:FF" 
PresetTime="HH:MM:SS:FF" TimerMode="MODE" EndMode="ENDMODE" </setKTimer2> 

Where: 

• NAME is the name assigned to the Timer in the Timer Configuration panel accessed 
from the Timer Browser. 

• StartTime may be one of the following: 

• HH:MM:SS:FF – time in hours:minutes:seconds:frames at which this Timer will 
start its count, depending on its configuration and presence of triggers. Note that 
if the HOURS is 00, the start time is deemed to be the previous midnight, 
whereas if HOURS is 24, it is considered to be the next midnight. This allows the 
timer to decide whether it should be counting or waiting to start when it 
compares the start time to the current time. (Note: the present implementation 
allows the user to send “Frames” information, but it is not used by the timer, 
which will start on the exact second) 

• NOW – the Timer will start counting immediately upon receiving the command 

• WAIT – the Timer will not start until it receives a setKTimerTrigger gateway 
command with the argument START 

• PresetTime  may be one of the following: 

• Count duration (hours:minutes:seconds:frames) for Count Up and Count Down 
modes,  

• End time (hours:minutes:seconds:frames) for the Remaining Time mode. 

• Note: the present implementation allows the user to send “Frames” information, 
but it is not used by the timer, which will use count durations or end times based 
on seconds. 

• Time Mode is the operating mode of the timer. Possible values are: UP, DOWN, 
REMAINING 

• EndMode defines what is to happen when the Timer reaches the end of its count. 
Possible vales are: LOOP, STOP, OVERRUN 

  



23 Using CSV Files to Import and Export Channels 

There may be circumstances where it is convenient to create Channels offline and import them 
into Kaleido, or export Channels from Kaleido for offline storage or transfer. 

To support this functionality, Kaleido Edit can import and export channel definition files in .csv 
format. This allows the use of programs such as Microsoft Excel to create and edit channel files. 

23.1 Definition of the file format 

The format of the .csv files that are used to import and export files from Kaleido is shown in a 
table for simplicity. If you are creating the file in a spreadsheet program such as Excel, then it will 
have this appearance. Save it using the type “CSV (comma delimited)” 

NOTE: only COMMA [ , ] or SEMICOLON [ ; ] are accepted by Kaleido as delimiters in a CSV file. 
Kaleido cannot interpret CSV files using other delimiters such as period [ . [, slash [ / ] or 
backslash [ \ ]. Be sure the program that generates the CSV file uses one of the acceptable 
delimiters. 

Note that a line starting with a blank cell is interpreted as a COMMENT line, and will be ignored.  

 

 Line that  Starts with  A blank  Cell is a comment Line, and so  Will be ignored  

 The  Following  Lines  Describe the  Channel  definition   

 Channel Type Link Order Address fields     

Channel Input 01 Video 1 A1     

Channel Input 01 Audio 1 EMBEDDED 1 1 1 Stereo 

Channel Input 01 Audio 2 EMBEDDED 1 1 2 Stereo 

Channel Input 01 Audio 3 EMBEDDED 1 2 1 Stereo 

Channel Input 01 Audio 4 EMBEDDED 1 2 2 Stereo 

Channel Input 01 Audio 5 EMBEDDED 1 3 1 Stereo 

Channel Input 01 Audio 6 EMBEDDED 1 3 2 Stereo 

Channel Input 01 Audio 7 EMBEDDED 1 4 1 Stereo 

Channel Input 01 Audio 8 EMBEDDED 1 4 2 Stereo 

Channel Input 01 Audio 9 AUDIOCARD 15 Stereo   

Channel Input 01 Audio 10 STREAMING 10.6.7.8 c1 Monitoring Stereo 

Channel Input 01 Text 1 Static VTR Room 1    

Channel Input 01 Text 2 Dynamic TSL 1 1  

Channel Input 01 Alarm 1 Freeze - Video 01     

Channel Input 01 Tally 1 GPI_01     

Channel Input 01 Timecode 1 1     

Channel Input 01 VBI 1 A 1    

The table contains 9 columns. The contents of columns 1 to 4 are strictly defined: 

Column 1: data type 



• If blank, the following eight cells in the row contain comments 
• If CHANNEL, the remainder of the row is formatted according to the following description 

Column 2: the name of the channel 

Column 3: the type of address that will be defined in this row 

Column 4: the Link Order of the address defined in this row 

Columns 5 to 9 contain the details of the address of this component within the channel. The 
contents vary with type (as given in column 3), as outlined in the following description. 

• Video – column 5: the Input Number (including the system name if needed). 

• Audio – column 5: EMBEDDED, AUDIOCARD or STREAMING 

In case of EMBEDDED, we have: 
• column 6: the video input (from 1 to 32). 
• column 7: the group index (from 1 to 4) 
• column 8: The AES (1 or 2) 
• column 9: one of STEREO, LEFT or RIGHT 

In case of AUDIOCARD, we have: 
• column 6: the audio input. 
• column 7: one of STEREO, LEFT or RIGHT 

In case of STREAMING, we have: 
• column 6: the IP Address 
• column 7: the Feed Id 
• column 8: the Usage – either MONITORING or METERING 
• column 9: one of STEREO, LEFT or RIGHT 

• Text – column 5: Static or Dynamic 

In case of Static, we have: 
• column 6: the Text 

In case of Dynamic, we have: 
• column 6: the Service ID 
• column 7: the Text Address 
• column 8: the Level. 

• Alarm – column 5: the name of the alarm. 

• Tally – column 5: the name of the tally alarm. 

• Timecode – column 5: the Video Input (between 1 and 32) 

• VBI – column 5: the Service ID (or its alias) 
• column 6: the Input Number. 

The actual csv file corresponding to the above table will have the following appearance. Note that 
all data entries must be present on a line, so each table cell that is blank must be represented by a delimiter 



(comma or semicolon) in the .csv formatted file.  In this example the fields are separated using semi-
colons, but using commas is equally valid. No other delimiters are accepted. 
 

;Line that;Starts with;A blank;Cell is a comment;Line, and so;Will be;ignored; 
;The;Following;Lines;Describe the;Channel;definition;; 
;Channel;Type;Link Order;Address fields;;;; 
Channel;Input 01;Video;1;A1;;;; 
Channel;Input 01;Audio;1;EMBEDDED;1;1;1;Stereo 
Channel;Input 01;Audio;2;EMBEDDED;1;1;2;Stereo 
Channel;Input 01;Audio;3;EMBEDDED;1;2;1;Stereo 
Channel;Input 01;Audio;4;EMBEDDED;1;2;2;Stereo 
Channel;Input 01;Audio;5;EMBEDDED;1;3;1;Stereo 
Channel;Input 01;Audio;6;EMBEDDED;1;3;2;Stereo 
Channel;Input 01;Audio;7;EMBEDDED;1;4;1;Stereo 
Channel;Input 01;Audio;8;EMBEDDED;1;4;2;Stereo 
Channel;Input 01;Audio;9;AUDIOCARD;15;Stereo;; 
Channel;Input 01;Audio;10;STREAMING;10.6.7.8;c1;Monitoring;Stereo 
Channel;Input 01;Text;1;Static;VTR Room 1;;; 
Channel;Input 01;Text;2;Dynamic;TSL;1;1; 
Channel;Input 01;Alarm;1;Freeze - Video 01;;;; 
Channel;Input 01;Tally;1;GPI_01;;;; 
Channel;Input 01;Timecode;1;1;;;; 
Channel;Input 01;VBI;1;A;1;;; 

Note: 

- The content of the file is not case sensitive. 

- Any line containing an error will be ignored, but the file won’t be ignored. 

23.2 Importing csv files to and exporting csv files  from KEdit 

The Data Explorer provides the access point to .csv file import and export functions. 

• Open the Data Explorer from the View menu via View����Data Explorer, or use the shortcut 
Shift+F5  

• Right-click on a Kaleido in the Tree portion of the Data Explorer to open its contextual menu, 
then click to select either the import or the export option, and follow the on-screen 
instructions. 

Please see the How To  for complete and detailed instructions on importing and exporting 
channel definition files in .csv format. 



24 Using the Kaleido Layout Editor software 

Kaleido Layout Editor (KEdit) is used to create layouts and configure the Kaleido-K2. When the 
computer running KEdit is connected to the Kaleido-K2 through a TCP/IP network, KEdit can 
export the Layouts to the Kaleido-K2. It can also open the Kaleido-K2’s current layout, and 
manipulate it in real time, so that changes made to the layout in KEdit appear immediately at the 
Kaleido-K2 monitor wall output. The modified Layout can then be saved in the Kaleido-K2’s 
database. 

The menu and toolbar area of the KEdit screen appears as follows: 

1 
2 
3 
4 
5 

6 
 

7 
 

 

1 The Kaleido Layout Editor window header  

2 Pull-down menus. 

3 The Edit Toolbar. 

4 The Component toolbar, with tools used to insert components into the on-screen layout. 

5 The title bar for the active window identifies the layout being displayed. 

6 The active layout area 

7 The Data Display Window, showing data and status for certain items. 

Each of these is discussed and described in detail in the following sections. 

In addition to the icons in the toolbars, many of the menu commands have keyboard shortcuts. 
These are indicated in the menus themselves, and are all either CRTL+(letter) commands, 
ALT+(letter), or Function keys (F#, where # is an integer between 1 and 12) corresponding to the 
12 function keys at the top of the keyboard. Thus in many cases there are three different ways to 
access a specific command or control panel. 

24.1 Pull-Down Menus 

The six pull-down menus operate as standard Windows menus 



24.1.1 File Menu 

 



File–New (Ctrl+N) : Opens the New Layout Format 
dialog box. 

Five items must be specified: 

Display Ratio:  Select one of three 
standard ratios (4:3, 16:9 and 5:4) from a 
pull-down box, or specify a non-standard 
ratio. The selected value should match the 
ratio of the display that will be connected to 
the output of the Kaleido. 

Configuration:  Select single-head or dual-
head. The Dual-head option permits the 
Kaleido-K2 layout to occupy two displays. 
At present, only side-by-side positioning of 
the two displays (horizontal tiling) is 
supported. Note that you need to have the 
Dual-Head option installed for this to work. 

Expected Display Resolution:   Enter the 
vertical and horizontal resolution (in pixels) 
of the monitor wall display that will be used 
to display this layout 

Expected Display Size:   Enter either the 
vertical, horizontal or diagonal size of the 
monitor wall display that will be used to 
display this layout. Select the units from the 
pulldown (cm or inches) 

Toolbar unit:   Click the radio button to 
select the units that will be used to display 
component size and position in the Data 
Display Window at the bottom of the layout 
window.  

The default values for Expected Display Resolution 
and Expected Display Size are 0. If new values are 
not entered, the only unit enabled in the Toolbar 
Unit section of this panel, and on the pulldowns in 
Size/Position tab of the Monitor Configuration panel 
will be %  

• If Expected Display Resolution is set to 
something other than 0x0, then the "pixels" unit 
will be available in both the Size/Position tab 
and the Toolbar Unit selection area. 

• If Expected Display Size is set to something 
other than 0, then "cm" and "inches" units will 
be available in both the Size/Position tab and 
the Toolbar Unit selection area. 

 

 



File–Open : Presents a subsidiary menu with two elements: 

File–Open–File (Ctrl+F) : presents a standard Windows Open File dialog box, where the 
user can search the computer for files of type .kg2, which are Kaleido layouts. Once a file 
is selected, it can be opened by clicking the open box, or by double clicking it in the list. 
The window associated with that file will be displayed on the screen in the offline mode. 

File–Open–Online (Ctrl+O):  opens a 
dialog box with a scrollable list, titled 
“Select the source Kaleido”, of all online 
Kaleido-K2s. Selecting one of these and 
clicking Open, or double-clicking one of 
these in the list, will open the Layout 
currently loaded in that Kaleido-K2 on the 
local screen, in the on-line mode. In this 
mode, changes made to the screen in 
KEdit will immediately be reflected in the 
output of the selected Kaleido-K2. The 
revised layout can be saved in one of the 
Kaleido-K2’s presets using the local 
keyboard or Kaleido-RCP. The window 
also shows the selected Kaleido-K2’s IP 
address and ID number. 

 

File-Close:  Closes the current Layout 

File–Save (Ctrl+S):  Saves the current layout under its existing name 

File–Save As… : Opens the Save File dialog box, allowing the current layout to be saved on the 
local computer. The layout must be given a name, and may be saved in any desired location. The 
Files of Type pulldown offers the user two options: 
  

Select this option…  to do this…  

Kaleido and Alto Layout (.kg2, xml) Save two copies of the layout file: 

- one in .kg2 format for use on the Kaleido-K2, 
- one in .xml format for use on the Kaleido Alto or Quad 

Kaleido KG2 Layout (.kg2) Save the layout in .kg2 format, for use on the Kaleido-K2 

. 



File–Apply Layout Online... (Alt+A): Calls up a 
subsidiary box containing a scrollable window titled 
“Select the destination Kaleido” in which are listed 
all the Kaleido-K2s currently on-line on the network, 
identified by name. Selecting one shows its IP 
address and Kaleido ID in the More Information 
box. 

You should also select additional data to be 
exported, including Channels, Alarm Monitors, 
images, Actions, Audio Scales, Sounds, MultiData 
source definitions and Timer definitions. 

There are two buttons at the bottom of the box - 
Load and Cancel.  

• Clicking LOAD sends the current layout and 
selected data to the selected Kaleido-K2 and 
updates its output. The layout can be saved in 
one of the Kaleido-K2’s presets using the local 
keyboard or Kaleido-RCP. 

• Clicking CANCEL closes the box without 
applying changes. 

 

File–Layout properties… : Opens a dialog for 
setting the properties of the current layout. This 
panel duplicates the lower part of the New Layout 
Format dialog box. 

The following parameters can be set: 

Expected Display Resolution:   Enter the 
vertical and horizontal resolution (in pixels) 
of the monitor wall display that will be used 
to display this layout 

Expected Display Size:   Enter either the 
vertical, horizontal or diagonal size of the 
monitor wall display that will be used to 
display this layout. Select the units from the 
pulldown (cm or inches) 

Toolbar unit:   Click the radio button to 
select the units that will be used to display 
component size and position in the Data 
Display Window at the bottom of the layout 
window.  

 



The default values for Expected Display Resolution 
and Expected Display Size are 0. If new values are 
not entered, the only unit enabled in the Toolbar 
Unit section of this panel, and on the pulldowns in 
Size/Position tab of the Monitor Configuration panel 
will be %  

• If Expected Display Resolution is set to 
something other than 0x0, then the "pixels" unit 
will be available in both the Size/Position tab 
and the Toolbar Unit selection area. 

• If Expected Display Size is set to something 
other than 0, then "cm" and "inches" units will 
be available in both the Size/Position tab and 
the Toolbar Unit selection area. 

 

File–Export Layout: Opens a dialog for 
exporting the current Layout to a Kaleido 
Alto or Quad.  

Enter the IP address of the Alto frame in 
the Alto Frame Ip Address combo-box. 
Note that clicking on the arrow will show 
the most recent IP addresses used. 

Enter the name the layout will have on the 
destination Kaleido Alto. 

Select the data types you want to export 
with the Layout, using the checkboxes:  

 

• Alarms – all alarms associated with the current 
layout 

• Channels – the channels associated with the 
current layout 

• Actions – the actions associated with the 
current layout 

• Images – background images and logos 
associated with the current layout 

• Audio scales – audio meter scales associated 
with the current layout 

• Timers are automatically included in the 
exported data, but Alto and Quad will not 
correctly identify these timers unless they have 
been given a numeric name using the Timer 
Browser. 

 



Note that data files with the same name that 
already exist on the Alto or Quad will be overwritten 
by the new data. 

Click Export to export the layout and the selected 
data to the destination Kaleido Alto 

• An error message will appear if the data files 
cannot be found 

Click Cancel to close the dialog without exporting 
the layout. 

File–System Preferences… (Alt+Enter): Opens 
the Preferences dialog for setting these functions:  

Kaleido Discovery Mode: 

• Unicast (KEdit will ask the Lookup at the 
specific IP address to find Kaleido-K2s) 

• Multicast (KEdit will ask the first lookup found 
on the network to find Kaleidos) 

Saving Channels: 

• Prompt to save channels when exiting monitor 
edit mode 

• Save channels without prompting when exiting 
monitor edit mode 

Saving default boot up layout 

• Auto Save boot up default layout will 
automatically save the new layout as the 
default layout for boot up anytime the layout is 
changed 

• Manual Save boot up default layout disables 
the auto-save feature. The current layout can 
be saved as the default boot up layout at any 
time from the View menu by selecting View–
Setting–Save this layout as default boot up 
layout  

 
 
 



File–Exit  Quits the Kaleido Layout Editor application 

24.1.2 Edit Menu 

This is a standard Windows format Edit menu, allowing the user to modify the contents of the 
current window. The menu has eight elements: 

 

Undo (Ctrl+Z) Undo the previous action 

Redo (Ctrl+Y) Redo the last undone action. 

Cut (Ctrl+X) Removes the selected object(s) from the display and saves them to 
the clipboard. 

Copy (Ctrl+C) Makes a copy of the selected object(s) in the display and saves them 
to the clipboard. 

Paste (Ctrl+V) Inserts the contents of the clipboard into the on-screen layout. 

Select All (Ctrl+A) Select all objects in the layout. 

Duplicate (Ctrl+D) Makes a copy of the current selection and inserts it into the screen to 
the right and below, and in front of the original. 

Delete  Deletes the selected object from the layout. 

24.1.3 Draw Menu 

This menu allows the user to organize the presentation of objects in the Layout. There are four 
elements in this menu: 



 

Draw–Snap to grid : Limits the movement objects to an invisible grid structure underlying the 
Layout, facilitating the visual alignment of objects in the display. Turn this on and off by selecting 
the menu item. When Snap to Grid is on, a tick mark appears next to it in the menu. See also the 
Shortcut toolbar – the icon shows whether Snap-to-Grid is on or off. 

Draw–Align or Distribute : presents a subsidiary menu with eight elements: 

• Align Lefts aligns the left sides of all selected objects with the left side of the 
first-selected object. 

• Align Centers aligns the centers of all selected objects with the center of the first-
selected object. 

• Align Rights aligns the right sides of all selected objects with the right side of the 
first-selected object. 

• Align Tops aligns the tops of all selected objects with the top of the first-
selected object. 

• Align Middles aligns the middles of all selected objects with the middle of the first-
selected object. 

• Align Bottoms aligns the bottoms of all selected objects with the bottom of the 
first-selected object. 

• Distribute Horizontally spaces the selected objects evenly between the left-most and right-
most objects. 

• Distribute vertically spaces the selected objects evenly between the top and bottom 
objects. 

Draw–Order  presents a subsidiary menu with two elements: 

• Send to Back sends the selected object(s) to the rear of the Layout 

• Bring to Front brings the selected object(s) to the front of the Layout 

These terms refer to the appearance of the Layout. Objects in front mask objects behind them 
from view. 

Draw–Lock selected layout    locks or unlocks the current layout. The menu shows a checkmark 
beside the item when the layout is locked, and no checkmark when it is unlocked. The function is 
also available from an Edit Toolbar button, whose icon shows the current status.. 



• When the layout is LOCKED, the position and size of components and Monitors within the 
Layout is frozen 

• The components and Monitors can still be CONFIGURED within a LOCKED layout. 

• Monitors within the layout can be Locked or Unlocked independently of the Layout’s lock 
status. 

24.1.4 View menu 

This menu allows the user to call up dialog boxes that relate to on-screen objects and system 
parameters. 

 

The menu has fifteen elements: 

View–Data Explorer:  Opens the Data Explorer window. 

View–Edit Toolbar:  Shows and Hides the Edit toolbar. The menu item has a checkmark when 
the Edit Toolbar is shown. 

View–Router Reference Table (F4):  Opens the Router Reference Table. 

View–Configuration Panel (F5):  Opens the Configuration Panel for the selected component. 
The Configuration Panel provides access to all available set-ups and adjustments for that 
component. For example, if the selected object is a Video Screen, the Configuration Panel will 
allow the selection of the video source that will appear in that Video Screen, provide proc. amp. 
functions for the input, allow Alarms to be set to monitor that source, etc.  

View–Monitor Browser (F6):  Opens the Monitor Browser, which lists all the available Monitors. 
The Monitor Browser panel provides an interface at which the user can place Monitors in the 
Layout, and save copies of Monitors for future use. 



• To create a Monitor in a Layout, drag the preview from the Monitor Browser onto the Layout. 

• To save a Monitor you have created in a Layout, press the Ctrl key and drag the Monitor from 
the Layout to the list of Monitors. 

View–Alarms Browser (F7):  Opens the Alarms Browser, a panel listing all currently-defined 
Alarm Monitors and providing the access point for Alarm creation and management. 

View–Timer Browser (Shift+F7):  Opens the Timer Browser, a panel listing all currently-defined 
Timers and providing the access point for Timer configuration. 

View–System Status (F8):  Presents a window summarizing the current status of the Kaleido-K2 
system connected to KEdit through the File→Open→Online menu. 

View–Actions Browser (F9):  Opens the Actions Browser, a panel listing all currently-defined 
Actions and providing the access point for Action creation and management 

View–MultiData Browser (Shift+F8):  Opens the MultiData Browser, a panel listing all currently-
defined MultiData sources, and providing the access point for creating and editing MultiData 
sources. 

View–GSM Configuration (Shift+F9):   Opens the Generic Status Message Configuration Panel, 
where the user can enter the IP address and alias of the iControl Application Server running the 
GSM service with which the Kaleido can receive and publish GSM status messages. This is only 
available in online mode. 

View–GPI Input Configuration (F12):  Opens the GPI Input Configuration, a panel that helps 
you configure Actions triggered by GPI Input events. 

View–Schedule:  Opens the Schedule Editor, a panel listing all currently-defined Schedule 
Elements and providing the access point for Schedule Element creation and management 

View–Setting   This opens a sub-menu with four choices: 

View–Setting–Output Configuration (F11): If you are in the Online mode, selecting this 
opens a window titled “Video Output Calibration”, allowing output parameters such as 
screen resolution, output level and equalization to be configured. 

View–Setting–VBI/ANC Standard: If you are in the Online mode, selecting this opens a 
window titled “VBI/ANC Data Standard Selection”, allowing configuration of the decoding 
capability of the system. 

 



View–Setting–Stop Action Processing:  Select this to stop all Actions from executing 
on an online Kaleido-K2. A checkmark will appear beside this item when it is selected. No 
Action can be executed until this option is deselected. Deselect by accessing it again 
from the menu and clicking. The checkmark will disappear. 

View–Setting–Save this layout as default boot up la yout: Select and click this item to 
save the current layout of an online Kaleido-K2 as its default boot up layout. The Kaleido-
K2 will display this Layout during the boot-up of the system. Note that if you have 
selected Auto Save default boot up layout on the System Preferences panel accessible 
from the File Menu (File – System Preferences), then every time a new layout is loaded it 
will be saved as the default boot up layout. 

View–Grid: This presents a subsidiary menu with two items, which control an on-screen grid 
displayed on the KEdit screen. This is useful for creating uniform Layouts. The grid does not 
appear on the Kaleido Monitor wall output when the Layout is displayed. The first menu item 
toggles between Show and Hide when the item is selected in the menu or F2 is pushed. The 
second menu item, Setting… opens a formatting box where the number of rows and columns in 
the displayed grid can be chosen.  

• Note that this is not the same grid used in the Draw-Snap to Grid function  

View–Zoom: The pull-down list of available zoom levels affects the appearance of the KEdit 
display only, allowing the layout to be refined more easily. 

24.1.5 Window Menu 

 

Tile:  fill the edit space with all open layouts, scaled to fit the available space. 

Cascade:  position the open layouts in the edit window so all their title bars are displayed. 

Minimize:  minimize the current layout 

Minimize All:  minimize all opened layouts 

(list of open layouts):  a list all currently-open layouts, by name. Move the cursor over a 
contracted name to see the full name. Select one from the list by clicking on the name; the 
selected layout will move to the front of the edit window. 



24.1.6 Help Menu 

 

Help–Help (F1):  Opens the on-line User Manual. 

Help–About: Displays information about the version of KEdit in use. 

24.2 Edit Toolbar 

The Edit toolbar on the Kaleido Layout Editor screen contains shortcuts to various commands. All 
but two of these are accessible through the menus, and some are also available through 
keyboard shortcuts. The following figure illustrates these icons: 

 
 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 

# Keybd 
Equiv. Menu Access Description of Function 

1 CTRL+N File–New… Opens the New Layout Format dialog to create a 
new layout. 

2 CTRL+F File–Open–File Opens a saved offline Layout. 

3 CTRL+S File–Save (Save as…) Saves the current Layout (opens the Save file 
dialog box for a new file). 

4 CTRL+X Edit–Cut Remove the selected element from the Layout 
and store it in the clipboard. 

5 CTRL+C Edit–Copy Make a copy of the selected element and store it 
in the clipboard. 

6 CTRL+V Edit–Paste Paste the copy of the clipboard contents into the 
layout. 

7 CTRL-Z Edit–Undo Undo last action. 

8 CTRL-Y Edit–Redo Redo an undone action. 

9  Draw–Snap to Grid Toggles the Snap-to-Grid feature. The 
appearance of the icon indicates the current 
status: 

       ON                    OFF    

10  Draw–Align or Distribute–
Lefts 

Align the left sides of all selected elements to the 
left side of the first-selected element. 

11  Draw–Align or Distribute–
Centers 

Align the centers of all selected elements to the 
center of the first-selected element. 



12  Draw–Align or Distribute–
Rights 

Align the right sides of all selected elements to 
the right side of the first-selected element. 

13  Draw–Align or Distribute–
Tops 

Align the tops of all selected elements to the top 
of the first-selected element. 

14  Draw–Align or Distribute–
Middles 

Align the middles of all selected elements to the 
middle of the first-selected element. 

15  Draw–Align or Distribute–
Bottoms 

Align the bottoms of all selected elements to the 
bottom of the first-selected element. 

16  Draw–Align or Distribute–
Distribute Horizontally 

Distribute the selected items horizontally. 

17  Draw–Align or Distribute–
Distribute Vertically 

Distribute the selected items vertically. 

18  Draw–Order–Send to Back Move the selected element to the back of the 
layout. It will be hidden by any other element. 

19  Draw–Order–Bring to Front Move the selected element to the front of the 
layout. It will hide any other element. 

20   Change the fill color of the current object to the 
fill color shown beneath the icon. Click on the 
down-arrow beside the icon to open a window to 
select other colors. Applies only to Text Labels 
and Background. 

21   Change the text color of the current component 
to the text color shown beneath the icon. Click 
on the down-arrow beside the icon to open a 
window to select other colors. Applies only to 
Text Labels, UMD text and Alarm Group Inhibit 
buttons. 

22   Change the font of the current component for on-
screen text displays, digital clocks and count-
down timers. The selected font can include 
Unicode characters for support of Japanese, 
Chinese and other international languages. 

23   Set the font size for a selected element 

24  View–Zoom Select the view magnification for the Kaleido 
Layout. Applies only to the layout as viewed on 
KEdit. 

25  Draw–Lock selected layout Lock or unlock the current layout (Monitors and 
Components cannot be moved or resized in a 
locked Layout). The appearance of the icon 
indicates the current status: 

LOCKED       UNLOCKED  



24.3 Component Toolbar 

The Component toolbar shows a series of icons representing tools with which the user can insert 
visual elements into the Layout, and change their size and position. 

 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 

1. Selection tool:  use this tool to select items, to drag them around the Layout, and to grab 
edge and corner points to resize objects 

2. Opens the Monitor Browser control panel, allowing Monitors to be added to the Layout.  

The remaining tools are all used to insert components into the Layout. The tool name and 
icon indicate the component type. The cursor changes to a cross (+) when any of these tools 
are selected. The tool name is displayed in a pane at the bottom of the Layout. Click in the 
Layout and drag to insert a component of the desired size. 

3. Audio meter group (see below) 

4. Horizontal UMD 

5. Vertical UMD 

6. Tally group (see below) 

7. Text label 

8. Group box 

9. Clock group (see below) 

10. Video Timecode viewer 

11. Logo 

12. General Status indicator 

13. Alarm Group Inhibit button 

14. MPEG monitor (see below) 

15. Service ID indicator 

16. Streaming viewer 

17. Closed-caption status indicator 

18. Closed-captioning text 

19. V-Chip status indicator 



Note : This version of the software does not provide a tool to insert a video screen into the 
layout. All of the Monitors available in the Monitor Browser include a video screen, and 
provide the convenience of source assignment using Channels, and the use of the full 
screen mode for video. A custom Monitor containing only a video screen could be 
created if it is needed, by editing an existing Monitor.  

Where there are similar or related tools, they are grouped together to prevent tool bar clutter. 
Such a group can be identified by the arrow icon to the right of the tool icon. Clicking the tool icon 
selects that tool directly. Clicking the arrow opens the group and shows all the available options. 
Clicking on one selects it. When the tool is used, or if the group is closed by selecting another tool 
or clicking elsewhere in the window, the selected tool becomes the default tool for that group. 

 

 Audio Meter Group Tally Group Clock Group MPEG Group  

24.4 Title Bar 

The title bar identifies the current layout, with this format: 

Location \ name – (changed) | aspect ratio  (note) 

Location:  identifies the path to the current layout. Implicit in this is the identification of the layout 
as: 

• Offline:  located on the local hard drive – the path will show as C:\MyLayouts\ etc. 

• Online:  located on the Kaleido – the path will show as KaleidoApplication 
(XXX.XXX.XXX.XXX) where the bracketed value is the IP address of the Kaleido. 

Name:  the name given to this layout when it was saved. The type is always .kg2 

(changed):  The presence of an asterisk (*) following the name of the layout indicates that the 
current layout has been modified and is not the same as the named layout that was loaded. 

Aspect ratio:  the aspect ratio of the current layout, either 4x3 or 16x9 

Note:   additional information. For example, if the layout is intended to be used with the dual head 
feature, the note may read: “(horizontal dual head)” 

Examples: 

• An offline layout in 16x9 format: 



 C:\My_Layouts\layout 2.kg2 | 16x9 

• An online layout in 16x9 format, changed from the loaded value, and intended for a horizontal 
dual head configuration: 

KaleidoApplication (10.6.5.8) – layout1.kg2 * | 16x9 (Horizontal Dual Head) 

24.5 Data Display Window 

At the very bottom of the Layout display in KEdit is the Data Display Window. This is a single-line 
text window in which are shown various messages related to the current functionality of KEdit. 
The following message types are displayed: 

Position and Size:   the window shows the position in the display of the top left corner of the 
currently-selected component, and it’s size (Horizontal, Vertical and Diagonal), all expressed in 
the units selected in the File-Layout Properties dialog (cm, inches, pixels or %) 

 

Note: if the component is a Monitor, its position and size can be set directly through the 
Size/Position tab in its configurration panel. 

Current tool selected:   the window shows the current tool, useful when placing components in a 
layout, as the cursor is generic. The window also shows the name of the tool over which the 
selection tool is placed on the component toolbar. 

 

 

24.6 Summary of Mouse-Key Actions in a Layout 

Here is a summary of all combinations of Key-Mouse operations that can be used in a layout. 
 

KEY, MOUSE ACTION AND 
COMBINATIONS 

ACTION 

Single click on a Component Component gets the focus. If the Configuration Panel is 
opened, it is modified to display the Component’s 
properties. If the component is part of a monitor, this only 
works if the monitor is in unlocked mode. 

Double click on a Component Configuration Panel is opened with the corresponding 
component’s properties. The focus is on the 
Configuration panel. If the component is part of a monitor, 



this only works if the monitor is in unlocked mode. 

Single click on a Monitor Monitor gets the focus. If the Configuration Panel is 
opened, it is modified to display the Monitor’s properties. 
This only works if the monitor is in locked mode. 

Single click outside a Monitor It the corresponding monitor was in unlocked mode, then 
it goes back to its default locked mode.  

Double click on a Monitor Configuration Panel is opened with the corresponding 
monitor’s properties. The focus is on the Configuration 
panel. This only works if the monitor is in locked mode. 

Right click on a Component A contextual menu is displayed (see section 24.8.2). If 
the component is part of a monitor, this only works if the 
monitor is in unlocked mode. 

Right click on a Monitor A contextual menu is displayed (see section 24.8.1). This 
only works if the monitor is in locked mode. 

Alt-click on a Component part of a 
Monitor 

Same as Single click on a Component except it also 
unlock the corresponding Monitor if it is locked. 

Alt-click on a Component not part 
of a Monitor  

Same as Single-click on a Component. 

Ctrl-click on a Component or a 
Monitor 

Same as Single-click on a Component. 

Shift-click on a Component or a 
Monitor 

Includes - or excludes if already included – the Monitor or 
the Component inside the multiple selection. 

Ctrl-click + drag on a Component 
or a Monitor 

Duplicates the selected object(s). 

24.7 Using Keys to Navigate in a Layout 

Use the keyboard of your KEdit workstation to navigate through the layout as follows: 
 

KEY OR COMBINATION OF 
KEYS 

NAVIGATION 

Tab In a dialog, will navigate from one field to the next using a 
predictive order. 

If all Monitors are locked then the focus will go from one 
item to the next using the ‘Z’ order of the items. By item, we 
mean either Monitors or Components not part of a Monitor.  

If one Monitor is unlocked then the focus will go from one 
component to the next using the ‘Z’ order of the 
components. By component, we mean only those parts of 



the unlocked Monitor. 

Shift + Tab Same as Tab except the order is reversed. 

←, ↑, →, ↓ Moves the selected Monitor or Component of 1 pixel in the 
selected direction.  

Moving a Monitor or a Component not part of a Monitor is 
only possible if the Layout is in unlocked mode. Moving 
Components inside a Monitor is only possible if the 
corresponding Monitor is in unlocked mode. 

Shift+←, Shift+↑, Shift+→, Shift+↓ Same as ←, ↑, →, ↓, except movement is 5 pixels. 

Shift + mouse drag Moves the selected Monitor or Component only horizontally 
or vertically. 

Moving a Monitor or a Component not part of a Monitor is 
only possible if the Layout is in unlocked mode. Moving 
Components inside a Monitor is only possible if the 
corresponding Monitor is in unlocked mode. 

 

24.8 Contextual (Right-click) Menus in a Layout 

Contextual Menus appear when a component or monitor is right-clicked in a layout. The items in 
the menu can then be clicked (right or left) to open or execute them, just as in a regular pull-down 
menu. The menu is called “contextual” because the contents of the menu are determined by the 
component that was right-clicked; i.e. by the context of the right-click. 

Here is a summary of the contextual menus that appear in a Kaleido layout when various items 
are right-clicked. 

24.8.1 Monitor Contextual menu ( Right-click ) 

The contextual menu for a Monitor shows the following options, in order: 

 

OPTION DESCRIPTION 

Cut The Monitor is removed from the Layout and kept in memory to be 
pasted. 

Copy The Monitor is copied and kept in memory to be pasted. 

Paste The Monitor saved in memory is displayed at the selected position of the 
Layout. 

Duplicate A copy of the Monitor is made and shown on the Layout positioned just 
over the selected Monitor. It is possible to use “Ctrl-D” to add more 



copies of the same Monitor as many times as desired, the new copies 
will be positioned relatively one from the others. It is possible to create a 
first duplicated object and position it so the subsequent duplicated 
objects will be positioned relatively using the desired positioning. See 
“Microsoft Power Point” help under the “Make multiple duplicates that are 
evenly spaced” topic. 

Unlock Monitor The selected Monitor is unlocked. 

Configuration 
Panel 

Configuration Panel is displayed with the Monitor’s properties. Focus is 
transferred to the Configuration Panel. It’s in this menu that a Channel 
can be assigned to the Monitor. 

24.8.2 Component Contextual menu ( Right-click ) 

The contextual menu for a Component shows the following options, in order: 
 

OPTION DESCRIPTION 

Cut The Component is removed from the Layout and kept in memory to be 
pasted. 

Copy A copy of the Component is kept in memory to be used when “Paste” 
will be selected. 

Paste Displays the Component saved in memory at the selected position of the 
Layout. 

Duplicate A copy of the Component is made and showed positioned just over the 
duplicated Component. It is possible to use “Ctrl-D” to add copies of the 
Component as many times as desired, the new copies will be positioned 
relatively one from the others. It is possible to create a first duplicated 
object and position it so the subsequent duplicated objects added will be 
positioned relatively using the desired positioning. See the “Microsoft 
Power Point” help at the “Make multiple duplicates that are evenly 
spaced” topic. 

Lock Monitor The corresponding Monitor is locked. This item is only available for 
components inside unlocked monitors, and is grayed out for 
components outside Monitors. 

Configuration Panel The Configuration Panel is displayed with the Component’s properties. 
Focus is transferred to the Configuration Panel. If the Component is a 
UMD or a Text Label the text contained in the “Text” field is already 
selected. 

24.8.3 Multiple Selection Contextual menu 

A selection represents a group of several monitors and/or components that are not part of a 
monitor. Right clicking on a selection will open a contextual menu listing operations that can be 
done on the group. This contextual menu will show the following options, in order: 
 



OPTION DESCRIPTION 

Cut The Selection is removed from the Layout and kept in memory to be 
pasted. 

Copy The Selection is copied and kept in memory to be pasted. 

Paste The Selection saved in memory is displayed at the selected position of 
the Layout. 

Duplicate A copy of the Selection is made and shown on the Layout positioned 
just over the selected Selection. It is possible to use “Ctrl-D” to add 
more copies of the same Selection as many times as desired, the new 
copies will be positioned relatively one from the others. It is possible to 
create a first duplicated object and position it so the subsequent 
duplicated objects will be positioned relatively using the desired 
positioning. See “Microsoft Power Point” help under the “Make multiple 
duplicates that are evenly spaced” topic. 

 

 


